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Preface

The GeoExpress User Manual is written for geographic information system (GIS) professionals that want to
compress and manipulate geospatial data with GeoExpress. This guide assumes that you have basic knowledge
of GIS, including mosaics, coordinate reference systems, multispectral imagery, and LiDAR point clouds. This
guide describes how to install and operate the graphical version of GeoExpress. To install GeoExpress on Linux,
you must install the command line version of GeoExpress. For installation instructions and other information about
the command line version of GeoExpress, see the GeoExpress Command Line User Manual.
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GeoExpress is a software solution for compressing and manipulating geospatial data. GeoExpress supports a
broad range of file formats, including the industry standard MrSID format and the ISO standard JPEG 2000 format.

Here are some of the tasks that you can perform with GeoExpress:

Compress raster and LiDAR data.

Create seamless mosaics.

Specify separate compression ratios for individual bands in a multispectral image.
Reproject raster images to another coordinate reference system.

Perform color balancing.

Crop and demosaick rasterimages.

Despeckle rasterimages.

Edit image metadata.

Save the images that you create with GeoExpress to your computer or a LizardTech Express Server. Then, view
the images in the geographic information system (GIS) software of your choice, including Esri®, Bentley®,
Autodesk®, and more.

NOTE: To see alist of fixes and other information for the current version of GeoExpress, see the
GeoExpress Read Me.pdffile included in the installation.

GeoExpress no longer limits the number of concurrent jobs and threads to 8; instead, it will use as many as
needed up to the number of processor cores on your system. See on page 113.
GeoExpress uses the nodata value of the input image as the transparency for the alpha band when
converting to MG4 format. Previously, this value (if present) was ignored by default.

The option to apply RPC metadata to an image is now enabled by default.

You can change this on the Input tab of the Advanced Job Options dialog.

GeoExpress now optionally collects anonymous usage statistics to help us improve the user experience.
You can enable or disable this during installation; to change this option within the application, choose

Help > Anonymous Application Usage.

Seamlines shapefile: We added an option to generate a shapefile representing the tiles included ina
raster mosaic. You can use this in another program, like GeoViewer, to identify tiles and overlap in the
output image.

Command line tools: We improved the method used to create MrSID mosaics from the command line.



Chapter 1: Before You Begin

« Fixed a bug where mosaicking multispectral images could yield an incorrect alpha band in output.

« Fixed a bug where the Express Cartridge Server installer was not installing some required libraries.

« Fixed a bug where the GeoExpress installer could not install a required library if an older version was
already installed.

« Fixed a bug where mosaicking a low-res image could result in the low-res tile being shifted by 1 pixel.

« Fixed a bug where setting advanced alpha options for a multi-file job could result in a crash.

« Fixed a bug where resampling an image could shift its corner points slightly.

« BPF support: GeoExpress supports input and output of Binary Point Files often used in Geiger Mode
LiDAR imagery.

« NADS83 2011 support: GeoExpress now supports EPSG Coordinate Reference Systems and Coordinate
Transformations related to NOAA’s National Adjustment of 2011.

« Better color balancing: We added an option for color balancing mosaics that allows you to apply the
correction to each band in the image, rather than just to the intensity (the previous built-in behavior). The
new option is the default behavior, but you can switch back to the previous method if necessary.

« Custom Watermarks: The size limitation for custom watermark files has been removed. Previously, the
maximum size for a watermark was 128 pixels x 128 pixels.

« RGB Color Transform enabled by default: For multispectral source images, the option to compress the
first 3 bands as RGB bands is enabled by default. This results in truer colors in the compressed output
image.

« Simpler licensing: To license GeoExpress on a stand-alone system, you can import a license file. The
License Server Utility makes it a snap to add floating licenses.

« Both Reprojection and Color Balancing now respect the operating system’s setting for number format.
Specifically, if your region’s standard number format uses a comma (,) to separate integral from decimal
portions of a number, these values are now stored correctly.

« Abug where NITF files larger than 4GB were not read correctly has been fixed.

GeoExpress 9.5.2 is a patch release to enable users with a floating license to access the software via Remote
Desktop. Previously, users were forced to use a special Remote Edition license.

« Afloating license now allows access via Remote Desktop
« Documentation updates (including Area of Interest changes)

« Fixed batch silent install
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Faster default workflows: New option to use the same output format as the input format, and
compression optimization.

PIX support: GeoExpress supports PCIDSK (P1X) files as input files.

Windows 10 support

For more information on the default output format setting, see on page 111.

For more information on compression optimization, including a full list of optimizable operations, see
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on page 18.

LiDAR Compression: GeoExpress supports compressing LIDAR point clouds in plain-text or LAS or LAZ
formats.

Multipolygon Shapefile Cropping: Define the area that you want to crop with a shapefile that can
contain multiple polygons.

Batch Color Balancing

Floating Point Support for MrSID Generation 4: GeoExpress uses quantization to create 32-bit floating
point images in the MrSID Generation 4 format.

Dynamic Range Metadata Generation: Use GeoExpress to write dynamic range metadata forimages.
Improved Metadata for Auxiliary Files

Improved Multi-Core Processing: Each job that you run in GeoExpress uses less processing power and
finishes faster.

Command Line Image Statistics

Simple Job List: Any images that you add to the GeoExpress graphical user interface appear in a single
simplified job list.

Intelligent Encoding: GeoExpress automatically performs a subset of image compression and
manipulation operations without re-encoding images.

Graphical User Interface Enhancements

Concurrent Processing: GeoExpress creates multiple threads to process jobs more quickly.

Image Rotation: Forimages that include rotation metadata, GeoExpress creates rotated output images.
Custom Watermarks: GeoExpress supports watermark images in BMP, PNG, and JPEG formats.
Mosaic Enhancements for the Command Line: Create mosaics using multiple coordinate reference
systems from the command line.

PNG Support

NITF RPC Support: GeoExpress can now interpret NITF files with RPC metadata.
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System Requirements

Before you install GeoExpress, verify that your system meets the minimum system requirements.

Hardware Requirements
For optimal performance, verify that your system meets the following recommended hardware requirements:
o 2.5GHz quad core processor
« 4GB RAM
« 200MB of disk space for installation and additional space forimages
o SATA drive or better

However, it is still possible to run GeoExpress on systems with the following minimum hardware requirements:
o 1.5GHz processor
« 1GBRAM
« 200MB of disk space for installation and additional space forimages

Operating System Requirements
You can install GeoExpress on the following operating systems:

Windows
o Windows 10 (32-bit and 64-bit)
« Windows 8 (32-bit and 64-bit)
o Windows 7 (32-bit and 64-bit)
o Windows Server 2012 R2 Update
o Windows Server 2012
o Windows Server 2008 R2 SP1

Software Requirements
On Windows, GeoExpress requires the following software to run:
o Microsoft .NET Framework 4.6.1
« Visual Studio C++ 2015 Redistributable
o SlimDX Runtime .NET 4.0 (used to display LiDAR point clouds in 3D)

If this software is not already on your computer, the GeoExpress installer will install it for you.

Getting the Software

When you purchase GeoExpress, you can choose to download the Windows GeoExpress application or an ISO
including all versions of GeoExpress as well as other applications, utilities, and sample images.

Download the software from the LizardTech website (https://www.lizardtech.com/support/geoexpress/installers).
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To set up GeoExpress, complete the following steps:

Run the GeoExpress installer to install the GeoExpress application.
Enter a license code or connect to a License Server.
If you have a copy of GeoExpress Standard Edition, install a data cartridge.

The GeoExpress installer includes the following products:

GeoExpress. The graphical version of GeoExpress. This version includes the command line interface.
GeoExpress Command Line. The command line version only. For more information on the command line
version of GeoExpress, see the GeoExpress Command Line User Manual.

License Server. A server that hosts floating licenses for networked computers. For more information on
floating licenses and instructions for configuring a license server, see on page 144.
Express Cartridge Manager Server. A server that hosts a shared data cartridge for networked
computers.

GeoViewer. A free geospatial data viewer with support for rasterimagery, LIDAR point clouds, shapefiles,
WMS sources, and JPIP sources.

To upgrade from a version of GeoExpress older than version 9.5, you need to uninstall the older version of
GeoExpress before you run the installer.

NOTE: If you are attempting to upgrade from GeoExpress 9.1 or earlier, you will need to uninstall the older
version of GeoExpress first. See Instructions for GeoExpress 9.1 and earlier on the GeoExpress
Installers (https://www.lizardtech.com/support/geoexpress/installers) page.

1.

—-12—

Log on to the computer where you want to install GeoExpress.
You don’t need to log on as an administrator but you do need to be able to perform admin overrides.
Navigate to the directory containing the GeoExpress installer and double-click SETUP . EXE to start the
GeoExpress Installation Wizard.
The installation wizard prompts you to complete the following tasks:
m [Install the Microsoft .NET Framework, Visual Studio C++ Redistributable, and any other required
libraries.
m Accept the License Agreement.
m Decide whether to share anonymous usage information.
To change this option within the application, choose Help > Anonymous Application Usage.
m Enter your serial number or choose to run GeoExpress in Trial mode.
Serial numbers are specific to a version of GeoExpress, and determine the functionality available to
you. For example, there are different serial numbers for GeoExpress Standard and GeoExpress
Unlimited.
m Select the directory where you want to install GeoExpress.
m Follow the steps to complete the installation.
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The first time that you run GeoExpress, you must enter a serial number (if you did not enter one during installation)
and a license code, or connect to a license server. Otherwise, GeoExpress will run in Trial mode, which expires
after 30 days.

License codes are specific to your machine. You can request a permanent license code from LizardTech
Customer Support. If you activate a temporary license code, you can switch to a permanent license code by
editing the GeoExpress license options.

Alternatively, if you connect to a license server, you use a floating license that can be shared by multiple
computers.

1.

Run GeoExpress by double-clicking the desktop icon or:
m  On Windows 7, choose Start > Programs > LizardTech > GeoExpress > GeoExpress 9.5.

= On Windows 8, 8.1, or 10, go to the Apps screen; under LizardTech, click GeoExpress 9.5.
Choose Options > Licensing.
This opens the License and Cartridge Management dialog.
If your temporary license code has expired, the License and Cartridge Management dialog opens when
you start GeoExpress.
In the Licensing panel, click Copy to copy the locking code.
Click Send Activation Request. This will open your default web browser and at the LizardTech Product
Activation (https://www.lizardtech.com/support/product-activation/) page.
Fill out the form and paste your locking code in the Locking Code field.
LizardTech Customer Support will send you a license code within one business day.

NOTE: If you use GeoExpress with a license server, you do not need to submit your computer’s locking
code.

Run GeoExpress.

2. Choose Options > Licensing.

3. Inthe Serial Number panel, enter the serial number that you received from LizardTech Customer Support
if you have not done so previously.
The Serial Number panel displays whether the serial number is valid.

4. Inthe Licensing panel, enter the license that you received from LizardTech Customer Support.
You can also import the license file that you received from LizardTech; click Importin the Licensing
section and select the . 1ic file.

5. Optionally, if you purchased a NITF license, select NITF.

6. Click OK.
The title bar of the main GeoExpress window displays the type of license in use.

1. Run GeoExpress.

2. Inthe Licensing pane, enter the name of the License Server.

3. Click OK.

For more information on floating licenses and the LizardTech License Server, see on page 144.
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The standard edition of GeoExpress requires a data cartridge to create new compressed images. The data

cartridge represents a specific purchased amount of data that you can use to create these images. Data cartridges

are generated by LizardTech and emailed to you as an attached file. You add data cartridges in the License and
Cartridge Management dialog. You can either install a data cartridge on your computer or you can use a data
cartridge from an Express Cartridge Manager Server.

For more information on configuring the Express Cartridge Manager and how to calculate data usage, see

3.

If LizardTech Sales or Customer Support needs additional information to process your order, they will contact you

on page 143.

Visit https://www.lizardtech.com/sales/ and contact the sales representative for your region or industry.
Your sales rep will work with you to generate a quote for your data cartridge needs, then will place your
order.

LizardTech Customer Support will send your data cartridge file via email.

via email.

o gk w
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Save the email attachment that you received from LizardTech Customer Support on your local drive.
Double-click the saved data cartridge file.
This installs the data cartridge.

Save the data cartridge that you received in an email from LizardTech Customer Support to your computer.

Run GeoExpress by double-clicking the desktop icon or:
= On Windows 7, choose Start > Programs > LizardTech > GeoExpress > GeoExpress 9.5.

= On Windows 8, 8.1, or 10, go to the Apps screen; under LizardTech, click GeoExpress 9.5.
Choose Options > Licensing.
In the Cartridges panel, click Import.
Navigate to the directory where you saved the email attachment.
Select the email attachment and click Open.
GeoExpress installs the data cartridge. The bottom of the panel shows how much data remains on your
cartridge.

Run GeoExpress by double-clicking the desktop icon or:
= On Windows 7, choose Start > Programs > LizardTech > GeoExpress > GeoExpress 9.5.

= On Windows 8, 8.1, or 10, go to the Apps screen; under LizardTech, click GeoExpress 9.5.
Choose Options > Licensing.
In the Cartridges panel, enter the name or IP address of the computer hosting the Express Cartridge
Manager Server, followed by the port number, then click OK. (The default port number is 9002.)
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You can use the GeoExpress graphical user interface to complete all compression and manipulation tasks. To
access the graphical user interface, double-click the desktop icon; on Windows 7, choose Start > All
Programs > LizardTech > GeoExpress > GeoExpress 9.5; on Windows 8 through 10, go to the Apps screen
and click GeoExpress 9.5 under LizardTech.

The following figure shows the GeoExpress graphical user interface:

£ Standard [Untitled®]

File Jobs Options Tools Help '*_1

3P wesumes

© M| e © ~a—2

I Run Selected Jobs E I
|

Coordinate Reference System:

4 @ Raster Files Properties  Qutput  Preview
() King_County sid Output
P LiDAR Filas Format: MrSID Generation 4 v
) MiStHelens_0062 las sid Destination: | C:\Output files\King_County.sid
Compression: () Lossless ) |20 1 Job Options | Advanced
Cutput file size: 1.3 GB Estimated memory usage: 446 5 MB
Image Properties
4 Input File Size: 1.8GE 5 File Type: Mr510 Generation 3
Nominal Size: 26.5GB Bands: 3{RGB)
Image Width: 113420 pinels Data Type: & bits, unsigned
Image Height: 84870 pixels Color Transform:  True

MNADE3 / UTM zone 10N {26310)

Image Exderts

Left: 532640 X Resolution: 1
Top: 5297550 Y Resolution: -1
Right: 46060

Bottom: 52720

—  T1

Menu Bar

Toolbar

Data Cartridge Gauge

Job List

Properties, Output, and Preview Tabs
Run Button

Status Bar

NOo o wN =

—15—




GeoExpress 9.5 User Manual

Menu Bar

The menu bar is a central place where you can view most of the tasks that you can perform in GeoExpress and the
options that you can set.

The following table describes some of the options unique to the menu bar:
OPTION DESCRIPTION

File > Save project Saves changes to the current project. If it has not been saved, you’ll be prompted for a
filename.
A project consists of the current contents of the Job List and global settings.

Options > Preferences Set or restore default preferences for output files, including output directory, compression
ratio, and more.

For raster images, you can set the default output directory and file format, set a default
compression ration for each file format, and more. See Raster Preferences on page 109.
For LiDAR images, you can set the default compression ratio, specify the default number
of points to display in the point cloud preview, and more. See LiDAR Preferences on
page 119.

Options > Licensing Enter or import license information or a data cartridge license, connect to a License
Server, or utilize an NITF-enabled license if one is available.

For a full description of all menu options, see Appendix C - Summary of Menu Options on page 151.

Toolbar

Access the GeoExpress toolbar to add images and mosaics to the Job List and to perform image manipulation
tasks. The tools that you can access in the toolbar vary depending on the image that you select in the Job List.

The toolbar contains the following tools:

ICON NAME DESCRIPTION
Add Image Add one or more images to the Job List.
Create New Mosaic Adds an empty mosaic to the Job List. You'll be prompted to identify the

mosaic type (raster or LiDAR), output file and file type, and other details
about the mosaic.

Edit Metadata Edit the metadata of an image. For raster and LiDAR files, you can change
the projection information stored in the metadata. For raster images, you can
also include custom information in the image.

fE © HO

Despeckle Remove speckling from MrSID and JPEG 2000 raster images.
Image Crop Crop a raster image.

EEE Area of Interest Specify part of a raster image as an “Area of Interest,” and change the
compression ratio of that area to preserve more detail or blur that part of the
image.

H Color Balance Change the brightness, contrast, and gamma values for a raster image, or for
individual bands in the image.

&h Reproject Change the projection used by a raster image. You can select a standard
coordinate reference system (CRS) or specify a custom well known text
(WKT) string.
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The data cartridge gauge is a small graphic display in the upper right corner of the main screen that indicates the
percent of the data cartridge remaining. Hold the mouse pointer over the data cartridge gauge to display the exact
amount of data remaining in the data cartridge.

For information on how usage is calculated, see

cartridges, see

on page 143. For information on activating
on page 13. For general information about data cartridges, see

on page 149.

To order additional cartridges, contact your LizardTech sales representative
(https://www.lizardtech.com/sales#retail-sales).

NOTE: GeoExpress Unlimited Edition does not require a data cartridge.

The Job List is the pane on the left side of the GeoExpress user interface that displays the raster and LIDAR files
with which you want to work. The Job List enables you to add or remove images for compression and
manipulation operations, work with project files, select images to view information about them, and run your jobs.

The job list is divided into a section for raster files and a section for LIDAR files. GeoExpress treats each image,
point cloud, and mosaic in the Job List as a discrete job. The name displayed in the Job Listis a user-specified
job name that has no effect on the resulting output file.

To add images and point clouds to the Job List, click the Add Image button in the toolbar. You can also drag
images into the job list from another application. To create a mosaic, click the Create New Mosaic button. The
Job List displays the tiles that you add to a mosaic in an indented list.

Select animage in the Job List to view information about the image in the Properties, Output, and Preview tabs.

GeoExpress provides a shortcut menu when you right-click on a selected job in the Job List.

MENU ITEM FUNCTION
Edit> Cut Removes the selected elements from the list. You can then paste the elements at another
location in the Job List.
Edit > Copy Copies the selected elements. You can then use Paste to duplicate the items in the list.
Edit > Paste Places copied or cut elements at the selected position in the Job List.
Edit > Select All Selects all the items in the Job List.
Run Run selected jobs.
Cancel Stop one or more running jobs.
Remove Remove selected jobs from the Job List.
Job Options Set format, compression, dimensions, resolution, and tiling options for the selected job.

Advanced Options

Set advanced input, output, and other options for the selected job.

Metadata Options

View and editimage metadata.

Tile Options

Add, remove, crop, change order, and set a coordinate reference system for tiles. This
option is only available if the selection is a mosaic job.

NITF Image Segments

Displays the image segments in the selected file and allows you to select the segments
that you want to include in the output file.

Export Job Settings

Export a text file containing information about the selected job and the version of
GeoExpress. Use this to remember job settings or when contacting LizardTech support.
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The Properties tab displays information about the selected job. The contents of the panels on the Properties tab
depend on whether the selected job is a raster job or a LIDAR job. The contents also change if you select multiple
jobs, if you select a mosaic, and more.

Use the Output panel to specify an output file format, destination, and compression ratio. Click Job Options to
display additional options. You can set options for multiple selected jobs, in which case options that do not apply
to the entire selection are not available. For raster jobs, the panel also displays the output file size and estimated
memory usage.

NOTE: For raster jobs, the estimated memory usage only displays when you select MG2, MG3, and MG4
as the Format. For more information on how the memory usage is calculated, see
on page 132.

If the input file is in MrSID raster or JPEG 2000 format, the option No additional compression appears and is
enabled by default. If you retain the same format for the output file, certain operations can be performed without re-
encoding the image. These are:

« Crop by Rectangle

« Crop by Shapefile (with Crop to exact bounds turned off)

« Edit metadata

« Despeckle

o Area of interest (with Weight compression)

« Tiling

NOTE: By default, the output format will be the same as the input format for MrSID and JPEG 2000 files,
so the above optimizations will be available automatically. To change the default output format behavior,
see onpage 111.

The Image Properties panel, or the Mosaic Properties panel if you select a mosaic, displays information about
the input file or files selected in the job list. If you select multiple files, the panel displays the information that the
files have in common.
The Image Properties panel displays the following information for raster files:
« Input File Size: The size of the selected image file. If the file contains header information, the file size can
be more than the nominal size.
« Nominal Size: The calculated size of the image based on the image size and resolution. The nominal size
measures the size of the image independent of whether the image is compressed.
« Image Width: The image width (in pixels).
« Image Height: The image height (in pixels).
« Coordinate Reference System: The coordinate reference system of the image.
« File Type: The file type of the image.
« Bands: The number of bands in the image and its color space.
- Data Type: The image data type. For example, 8 bits, unsigned.
« Color Transform: True if the image’s color space is either RGB or multispectral with the first 3 bands
positioned as RGB; False for any other color space or multispectral mapping. (MG4 only)
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The Image Properties panel displays the following information for LIDAR files:

« File Name: The name of the file.

« X:The range of X values in the point cloud.

« Y:Therange of Y values in the point cloud.

o Z:Therange of Z values in the point cloud.

« Coordinate Reference System: The coordinate reference system of the point cloud.

« File Type: The file type of the image.

« Points: The number of points in the point cloud.

« Input File Size: The size of the selected point cloud file. If the file contains header information, the file size
can be more than the nominal size.

« Nominal Size: The calculated size of the file based on the number of points and the number of fields for
each point. The nominal size measures the size of the point cloud file independent of whether the file is
compressed.

The Mosaic Properties panel displays the following information for raster files:
« Mosaic Width: The total width of the mosaic.
« Mosaic Height: The total height of the mosaic.
« Mosaic Image Size: The calculated size of the mosaic.
. Coordinate Reference System: The coordinate reference system of the mosaic.
« File Type: The file type of the image.
« Bands: The number of bands in the mosaic and its color space.
. Data Type: The image data type. For example, 8 bits, unsigned.

For LiDAR files, the Mosaic Properties panel displays the same information as the Image Properties panel
above except for all the files in the mosaic. To view information about a single file in the mosaic, select the file in
the job list to display the Tile Properties panel.

For raster images, the Extents panel indicates where the image resides in geographic space and the pixel
resolution of the image.

For raster mosaics, the Extents panel includes mosaic extents and tile extents. Mosaic extents indicate the
boundaries and resolution of the entire selected mosaic, while tile extents indicate the extents of a single mosaic
tile.

Click Job Options in the Properties tab to open the Job Options dialog. This dialog displays the most common
options for a job. The contents of the Job Options dialog vary depending on whether the selected job is a raster
jobor LIDAR job.
For raster jobs, the Job Options dialog displays the following panels:

« Destination

« Format and Compression

« Dimensions and Resolution

« Tiling
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For LIDAR jobs where you select MrSID Generation 4 (MG4) as the output format, the Job Options dialog
displays the following tabs:

o Compression

« Text Parsing

NOTE: If you select an output format other than MG4, the Job Options link is disabled.

Preview Tab

You can preview rasterimages and LiDAR point clouds. For rasterimages, you can preview images to see the
expected output of a compression or manipulation operation. To cancel the rendering of a preview image, click on
the Properties or Output tab.

The following figure shows the Preview tab:

= — O .
File Jobs Options Tools Help
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A @RastﬂrFiles Properties  Output  Preview
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Preview output image with target encoding options at 1.1 resalution
) MiStHelens_0062 las.sid
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() Defautt View
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Red:
Band 1

Green:
Band 2

Blue:
Band 2

() Grayscale

Band 1

Fiun Sddected Johs ¥ Coord: Y Coord:

XandY coordinates for the position of the cursor are given below the image pane.

For more information on how to preview an image or mosaic, see Previewing an Image on page 29 and Previewing
a Mosaic on page 104.
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The Preview tab includes a toolbar that you can use to navigate the preview image. For rasterimages, you can
move the slider in the toolbar to change the scale of the preview image. If you set the scale to 1:1, you can select
the option to Preview output image with target encoding options at 1:1. When you select this option,
GeoExpress runs the image compression or manipulation operations on the visible portion of the image.

For multispectral imagery, click the Band selector button @ in the toolbar of the Preview tab to manually select

the bands that you want to preview. You can select Default View, RGB, or Grayscale. The Default View uses
the first three bands of the multispectral image as the RGB bands. To manually select the RGB bands that you
want to use, select the RGB option. Click Grayscale to view a single band of the source image as a grayscale
image.

NOTE: The Band Selector only affects the image preview. To change the RGB bands used in the
encoding process, click Advanced in the Properties tab. Then, select the RGB bands that you want to
use in the Bands tab.

LiDAR point clouds are displayed in 3-D. Click the Orbit focal point button 4’3 to rotate the image. Click the

Refresh points button to clear the preview pane and render the points in the current view again. To render

your points quickly, GeoExpress draws a representative sample of your points rather than drawing every single
point. If you pan or zoom in, you may want to refresh points to draw more points in the area that you are viewing.
To increase or decrease the default number of points that GeoExpress draws, see on page 120.

NOTE: To preview a LiDAR point cloud stored as a text file, ensure that you select the option to Read the
whole file when the Text Parsing dialog appears.

Click Viewer options @ to adjust several options that can affect the LIDAR preview. These settings only affect

the preview, and not the output file. With the Viewer options dialog open, click Apply to apply changes to the
preview and keep the dialog open, click OK to accept all changes and apply them to the preview, or click Cancel
to revert the preview and close the dialog.

Select Use RGB colors in file to display the preview with the RGB color information saved with the LIDAR file.
(This option will only be present if the file contains RGB metadata. If so, the setting will be enabled by default.)

If you deselect Use RGB colors,or if the option is not available, the preview will display with a color gradient that
indicates elevation, with blue representing the lowest points and red the highest.

If the color gradient for the LIDAR point cloud does not display properly, you may want to adjust the gradient range
for the point cloud. Select Use custom gradient range to specify the elevation range for the color gradient. (If the
Use RGB colors option is available, you must deselect it in order for this to take effect.)

For a custom gradient, you can enter the minimum and maximum elevation to color; GeoExpress will recolor the
preview using the new range. Elevation units are defined by the vertical projection; for example, the elevation
range in NAVD 88-based projections is expressed in meters.

For example, if the point cloud displays as a single color rather than a gradient range of multiple colors, it’s likely
that one or more points in the point cloud has an incorrect Z value. In this case, you may want to adjust the
minimum or maximum Z value used for the gradient.

NOTE: The initial gradient range displayed is the elevation range of points in the image.
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You can exaggerate or reduce the effect of elevation differences by changing the Z Exaggeration value. 1 is the
true scale, a value of 2 will stretch the height to twice normal, while a value of 0.1 will flatten the image to one-
tenth the actual elevation. This value must be greater than 0.

You can specify the Number of points to use for the point cloud preview. Reducing the point count speeds up the
preview process at the cost of detail; increaing the point count improves detail at the expense of processing
speed.

The Point size indicates the number of screen pixels used to display a single point in the point cloud. You may
want to increase this if you dramatically reduce the Number of points used in the preview; using more pixels per
point will smooth out a preview that has a low point count.

You can specify what property of the point cloud is represented in the Alpha channel of the preview. The Alpha
channel is rendered as transparency.

Use the Keep points where feature to identify a threshold for what points in the point cloud to display. Choose a
property from the first pop-up menu (such as Intensity), a relationship from the second (such as ! for NOT), and a
enter arelevant value in the text field. For example, specify Z > 1000 to restrict the preview to points whose
elevation is over 1000.

The Output tab shows the session log and the progress of running jobs. Use the Output tab to monitor the
progress of running jobs, cancel running jobs, and export the session log.

For more information about log files and for a sample log file entry, see on
page 120.

Click the Run button to run one or more jobs. The jobs that you run depend on which jobs you have selected in the
Job List. If no jobs are selected, then the Run button runs all jobs.

For more information on running jobs, see on page 30.

The status bar in the lower-left corner displays a message when GeoExpress renders an image preview. Use the
status bar to check that your image preview is being generated.
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This chapter describes the process for most compression and manipulation operations in GeoExpress.

To perform compression and manipulation operations, complete the following tasks:

1.

GRS

10.

Add images, LIiDAR point clouds, or mosaics to the Job List. The images, point clouds, and mosaics that
you want to compress or manipulate in GeoExpress are called jobs.

Select the jobs that you want to manipulate or compress.

Select an output format.

Select an output destination.

Specify how much you want to compress the job.

Optionally, forimages and mosaics, perform image manipulation operations. For example, you might
despeckle or reproject an image.

Optionally, specify additional job options. For example, for raster images, you might change the resolution
or create image tiles.

Optionally, preview the image or point cloud before running the job.

Optionally, for raster images, create a test image.

Run the job.

Before you can compress or manipulate images and point clouds, you must add them to the Job List. When you
add a raster or LIDAR mosaic to the Job List, you can show or hide the tiles that make up the mosaic. To show or
hide the tiles in a mosaic, click the arrow next to the name of a mosaic.

1.
2.

3.

Click the Add Image button O or the Create New Mosaic button in the toolbar.

Browse files and select one or more images or point clouds that you want to add to the Job List. To select
multiple images, hold down the Ctrl key and click on each image or point cloud that you want to add.
Click Open.

NOTE: If you add a LIDAR text file to the Job List you must set text parsing options so that GeoExpress
can match the columns in the text file to standard fields. For more information, see

on page 69.

TIP: You can drag images and point clouds into the Job List from your system’s file manager, or choose
File > Add image(s).

To add an image that you opened recently, choose File > Recent files.
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Supported Input Formats

This table describes the file formats of the images that you can add to the Job List.

SUPPORTS
FILE FORMAT FILE EXTENSION SUPPORTED DATA TYPES MULTISPECTRAL? NOTES
BIPF .bpf N/A Binary Point File, commonly used for Geiger Mode LiDAR
images.
CADRG The most common | 8-bit unsigned No
extension is . toc
DTED .dto, .dt1, .dt2 16-bit signed, 32-bit floating No (limited to one
point band)
ECW .ecw 8-bit unsigned Yes Earth Resoure Mapping’s Enhanced Compression Wavelet
format.
ERDAS IMAGINE .img 8-bit and 16-bit signed and Yes GeoExpress supports color lookup tables (CLUTs) with 8-
unsigned, 32-bit floating point bit per sample RGB color values.
ERDAS LAN .lan 8-bit unsigned Yes In 4-band LAN images, bands 2, 3, and 4 are interpreted as
Red, Green, and Blue, respectively.
JPEG .jpg, -jpeg 8-bit unsigned No, limited to 3 bands Requires a world file for georeferencing.
JPEG 2000 .jp2, .jpc 8-bit and 16-bit signed and Yes Multiple bands supported or all color spaces.
unsigned
LAS .las N/A This is a binary, uncompressed LiDAR point cloud format.
GeoExpress supports LAS versions 1.0-1.3, with
experimental support for LAS 1.4.
LAZ .laz N/A This is a binary, compressed LiDAR point cloud format.
MrSID Generation .sid 8-bitand 16-bit unsigned, 32-bit |[No 4 bands are supported for CMYK input only.
2 (MG2) floating point
MrSID Gen 3 .sid 8-bitand 16-bit unsigned No 4 bands are supported for CMYK input only.
(MG3)
MrSID Gen 4 .sid N/A This is a binary, uncompressed LiDAR point cloud format.
(MG4) LiDAR
MrSID Gen 4 .sid 8-bit and 16-bit signed and Yes, up to 255 bands Multiple bands supported for all color spaces.
(MG4) Raster unsigned, 32-bit floating point
NITF 2.0, 2.1. .ntf 8- and 16-bit signed and Yes Only supports uncompressed, JPEG compressed, and JP2
unsigned compressed data.
PCIDSK .pix 8-bitand 16-bit signed and Yes Does not support mixed data type, RPC segments, GCP
unsigned, 32-bit floating point segments, or Color Lookup Tables.
PNG .png 8-bit and 16-bit unsigned No Requires a world file for georeferencing.
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SUPPORTS

FILE FORMAT FILE EXTENSION SUPPORTED DATA TYPES MULTISPECTRAL? NOTES
Raw .bil, .bip, .bsq 8-bit and 16-bit signed and Yes
(uncompressed) unsigned, 32-bit floating point
BBB files (BIL, BIP,
and BSQ)
Sun Raster .ras, .rast 8-bit unsigned No
Text The most common N/A Also known as ASClII files. These are plain-text files with
extension is . txt. delimiters for point clouds.
TIFF/GeoTIFF .tif, .tiff, .tfw |8-bitand 16-bitsigned and Yes For more information on supported TIFF compression
unsigned, 32-bit floating point formats, see Supported TIFF Compression Types on
page 139.
USGS DOQ .nes, .ses, .nws, |8-bitunsigned No Both the old and new USGS DOQ formats are supported
.sws, .doq and can be combined in mosaics.
Windows BMP .bmp 8-bit unsigned No Requires a world file for georeferencing. Only supported on

Windows.
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« Password-protected MrSID files cannot be used as input files.

« While GeoExpress encodes indexed color images, it is strongly recommended that you scan data into 8-bit
grayscale or 24-bit color before encoding. In this case, 24-bit color refers to the number of bits for a pixel
value in a three-band image.

« Worldfiles are supported for all image formats.

o The LAS, LAZ, MG4 LIiDAR, and Text file formats are for LIDAR point clouds only.

« GeoExpress does not support LIDAR waveform data.

« GeoExpress has improved support for LAS 1.4 files. GeoExpress will read ELVRSs that are under 64K bytes
long, otherwise it will drop the ELVR.

When you compress floating point images, GeoExpress uses the quantization compression method. For more
information on floating point images, see on page 35.

IMPORTANT: An option is available to allow world files to override native georeferencing. Note that this
will override any coordinate reference system (CRS) metadata—including well-known text strings
(WKTs)—that may have been embedded in the file. In this situation you can manually edit the image’s
CRS on the Reprojection Manager accessible by choosing Reproject from the Tools menu. For more
information, see on page 123.

To remove a job from the Job List, right-click on the job name and choose Remove, or select the job and press
the Delete key.

When you remove a mosaic job from the Job List, you also remove all the tiles associated with the mosaic.

NOTE: You do not need to remove an image or mosaic from the Job List to keep it from being encoded.
Only the files that you select in the Job List are encoded when the Run button is clicked.

Select a job in the Job List to view information about the job, set job options, and run the job.

To select a job, click on the name of the job. To select multiple jobs, hold the Ctrl key while you click on the
names of the jobs that you want to select. To select multiple consecutive jobs, hold the Shift key and click on the
names of the first and last images that you want to select. For example, you have six jobs in the Job List and you
want to select the second, third, and fourth jobs. Hold the Shift key, then click on the second job and the fourth
job. The three jobs are selected.

To select all the jobs in the Job List, right-click anywhere in the Job List and choose Edit > Select All, or press
Ctrl+A.

When you compress an image or point cloud, the default output format is MrSID Generation 4. You can change the
output format in the Properties tab.

1. Select one or more jobs in the Job List.

2. Click Properties to view the Properties tab.

3. Inthe Output panel, select an output format from the Output Format drop-down.
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NOTE: Some output formats may not be available depending on certain properties of your input image,
such as the data type and number of bands.

Many of the options available to you in GeoExpress vary depending on the output format that you select.
Additionally, the options available depend on whether the file is a raster file or a LIDAR point cloud file.
GeoExpress supports the following output formats:

o MrSID Generation 4 (MG4), MrSID Generation 3 (MG3), MrSID Generation 2 (MG2)

« JPEG 2000 (Part 1), JPEG 2000 (GMLJP2)

o NITF 2.1 (Raw), NITF 2.1 (JPEG 2000)

o GeoTIFF

« LAS

« LAZ

« BPF

NOTE: Support for encoding NITF images is available for GeoExpress. Contact your LizardTech
representative (https://www.lizardtech.com/sales) to purchase the NITF Extension for GeoExpress.

The MrSID format is a proprietary format developed by LizardTech that supports lossy and lossless compression.
There are several generations of the MrSID file format. Additionally, for the latest generation, MrSID Generation 4
(MG4), there is a version that supports raster and a version that supports LIDAR.

The raster version of MG4 supports multispectral data, per-band compression, custom metadata, and advanced
image manipulation features. The format is widely supported across GIS software packages. The LiDAR version
of MG4 stores compressed point clouds in an accessible format meant to address some of the problems with
storing and accessing large LIDAR point clouds.

For both raster and LiDAR data, if you're not sure which file format to select, you may want to select
MrSID Generation 4.

The JPEG 2000 format is an open standard that provides superior compression compared to the original

JPEG format.The JPEG 2000 (Part I) format uses the original JPEG 2000 specification which is more widely
supported. The JPEG 2000 (GMLJP2) format includes support for geographic markup language (GML). Use the
JPEG 2000 (GMLJP2) format when you need to create JPEG 2000 files that contain coordinate reference
systems (CRS), topology, and other geographic features.

For a comparison of MrSID and JPEG 2000 files, see on page 32.

The NITF format is a container that can include an image, image metadata, and other graphics. GeoExpress
supports creating NITF files that contain raw or JPEG 2000 images.The NITF format is the standard for various
departments of the United States government. Use the NITF format when your organization requires

NITF metadata.

The GeoTIFF format embeds georeferencing metadata into TIFF images. In GeoExpress, you can only create
GeoTIFF files from MrSID input files, and you can only create uncompressed GeoTIFF files. Use the

27 —


https://www.lizardtech.com/sales
https://www.lizardtech.com/sales

GeoExpress 9.5 User Manual

GeoTIFF format when you might need to view your image in an image viewer that does not support GIS. Any
image viewer that can read TIFF files will display GeoTIFF images. If the viewer does not support the
georeferencing metadata, the metadata is ignored. GeoTIFF is generally an uncompressed file format.

The LAS format is one of the most commonly used LiDAR file formats, and can be read in virtually any application
that support LIiDAR point clouds. LAS is a public, uncompressed file format maintained by the American Society
for Photogrammetry and Remote Sensing (ASPRS). GeoExpress can write LAS 1.0 through 1.4 files.

When you create a LAS file from another LAS file, GeoExpress uses the same version of LAS. For example, if the
input file is a LAS 1.1 file, GeoExpress creates another LAS 1.1 file. If you write a LAS file from MrSID or from
another format, the version of LAS that GeoExpress uses depends on the contents of the file. If the file contains
features unique to a specific version of LAS, GeoExpress uses that particular version.

The LAZ format is a compressed format for LIDAR point clouds. LAZ is an open-source file format developed by
Martin Isenberg at RapidLasso.

GeoExpress does not support LAZ output from a LAS 1.4 file that includes records 6—10.

Binary Point File (BPF) serves as a lightweight, quick, binary file format for the storage of unorganized point cloud
data. It is commonly used in Geiger Mode LiDAR imagery.

Select an output destination to specify where you want to save the output file. By default, the output destination is
the same directory where the input image is stored.

For more information about the output destination, and to select an Express Server as the output destination, see
on page 67.

The images and point clouds that you create with GeoExpress are compressed by default. To specify how much
you want to compress each rasterimage, you can specify a compression ratio, specify a target file size, use
lossless compression, set per-band compression ratios, or use quantization. For LIDAR point clouds, you can
specify a compression ratio or select lossless compression.

Use lossless compression for an image or point cloud to compress the data as much as possible without changing
the image or point cloud. To use lossless compression, click the Properties tab and select Lossless.

Specify a compression ratio for an image or point cloud to specify how much smaller you want the output to be
than the input. For example, if you have an uncompressed 100 megabyte image and you specify a compression
ratio of 20:1, the file size of the output image is 5 megabytes. To set a compression ratio for a selected image,
click the Properties tab and select the compression ratio field. Enter the compression ratio that you want to use.

When you compress floating point images, GeoExpress uses the quantization compression method. For more

information, see on page 35.
For more information on compression, see on page 32. For more information on setting
default compression preferences, see on page 109.

—28—



Chapter 4: Getting Started

For raster images and mosaics, you can use the tools in the Toolbar to perform the following image manipulation
operations:

« Edit metadata for an image.

« Despeckle animage.

« Cropanimage.

» Select an area of interest.

« Set color balancing for an image.

« Reproject animage.

NOTE: You can also edit the coordinate reference system metadata of LiDAR point clouds.

For more information on each image manipulation operation, see on page 36.

To set job options, click Job Options in the Properties tab. The job options that you see depend on whether the
jobis for araster file or a LIDAR file and on the output format that you select.

For raster images, you can use job options to select tiling options, enter a custom resolution or set of dimensions,
and more. For LIDAR point clouds, you can use job options to remove LAS variable length record (VLR) metadata,
set column mapping options for text files, and more.

For more information, see on page 67.

NOTE: For rasterimages, you can also click Advanced to set additional options. You can use the
advanced options to select a color space, edit transparency values, and more. For more information, see
on page 71.

You can preview raster images and LiDAR point clouds.Preview images to see the expected output of a
compression or manipulation operation. When you preview an image, you do not use data from the data cartridge.
1. Select the job in the Job List.
2. Click the Preview tab.
The preview renders in the Preview tab.
3. Optionally, for rasterimages, move the slider above the preview image to change the scale of the image or
click the Band Selector button @ to manually select the bands that you want to view.

For more information on the Preview tab and the Band Selector, see on page 20.
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Creating a Test Image

For raster images, you can create test images to test an image manipulation or compression operation without
using data from the data cartridge. Test images are output images that have a visible watermark. You can create
images and mosaics as test images, but not LiIDAR point clouds.

1. Select one or more jobs in the Job List.

2. Click Advanced in the Properties tab.

This opens the Advanced Job Options dialog.

3. Click the Output tab.

4. Select Encode As Test Image and click OK.

5. Click the Run button to run the job.

The following figure shows a test image:

Running Jobs

When you run a job, GeoExpress performs the compression and manipulation operations that you selected. To run
one or more jobs, select the jobs that you want to run and click the Run Selected Jobs button. To run all jobs,
click a blank space in the Job List to ensure that no jobs are selected and click the Run All Jobs button.

When you run one or more jobs, GeoExpress displays the Output tab. Use the Output tab to monitor the progress
of the operation. To cancel one or more running jobs, click the Cancel job button or the Cancel all button in the
Output tab.

If you click away from the Output tab, GeoExpress continues running the jobs in the background.

TIP: GeoExpress adds information about each job that you run to the GeoExpress log file. For more
information on logs, see Viewing and Using Log Information on page 120.

Exporting Job Settings
Export job settings when you want to save information about a particular job. The job settings are saved to a text
file and include the following information:

o GeoExpress version number.

« Job properties from the Properties tab.

« Job options.

To export job settings, right-click on the name of a job in the Job List and click Export Job Settings.
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Working with Project Files

To save the state of the Job List, create a project file. The project file is a text file that saves each job in the Job
List and any options that you have applied to each job.

The project file saves the file path of each image, mosaic tile, and LIDAR point cloud in the Job List. If you move
any files to another directory, you can edit the project file in a text editor.

Opening a Project
To open an existing project, choose File > Open project. Saving an edited project overwrites the original.

NOTE: Project files from GeoExpress version 9.5.2 and older cannot be opened using GeoExpress 9.5.3
and newer.

Creating a New Project

To create a new project, choose File > New project. \When you create the new project, you clear the Job List. If
there are items in the Job List that have not been saved, GeoExpress prompts you to save the jobs in a project
file.

Saving a Project
To save a project, choose File > Save project.
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Compression Overview

Compress your images and point clouds to decrease the size of the files. GeoExpress compresses your images
and point clouds by default.

When you compress raster images with GeoExpress, you can specify a compression ratio, specify a target file
size, use lossless compression, or use quantization for floating point images. If you decide to specify a
compression ratio for a raster image, you can specify a separate compression ratio for each band in an image.
When you compress LIiDAR point clouds with GeoExpress, you can specify a compression ratio or use lossless
compression.

If you specify a compression ratio or a target file size, GeoExpress uses lossy compression. When you use lossy
compression, you compress an image to a much smaller file size by discarding some image data or removing
points from a point cloud. Additionally, when you compress a floating point image, GeoExpress uses a lossy
compression method called quantization to compress the image.

When you use lossless compression, you compress an image as much as possible without discarding any image
data.

Comparison of Compressed Output Formats

For raster images, GeoExpress can create compressed images in the MrSID and JPEG 2000 formats. Because
the NITF format can contain JPEG 2000 files, you can also create compressed NITF files. For LIDAR data,
GeoExpress can create compressed files in the MrSID and LAZ formats. For LIDAR data, LAZ files can only be
created using lossless compression. MrSID files are lossless by default, but you can also specify a compression
ratio to create lossy files.

TIP: Select animage in the job list to view the file format, output file size, and more in the Properties tab.

Compressed Raster Formats
The following table compares some of the features supported by the raster output formats:

OUTPUT FORMAT
JPEG

FEATURE MG2 MG3 MG4 2000
Lossy output with a maximum of 3 bands, cropping, no advanced encoding, ] ] ] ]
output file smaller than 2GB
Advanced encoding (such as reprojection, color balancing, despeckling, and ] ] ]
Area of Interest encoding)
Output file size larger than 2GB n n ]
Lossless output L] L] [ ]
Mosaic that uses MrSID files as input u u [ ]
Multispectral output L] [ ]
Arbitrary band mapping L]
Per-band compression L
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The following table compares some of the features supported by the LIDAR output formats:

OUTPUT FORMAT
FEATURE LAZ LAS BPF MG4
Lossless compression [ [ [ [
Using a specified compression ratio [
Creating mosaics [
For more information on output formats, see on page 27.

Specify a compression ratio for an image to specify how much smaller you want an image to be than the input
image. For example, if you have a 100 megabyte image and you specify a compression ratio of 20:1, the file size
of the output image is 5 megabytes.

NOTE: For previously-compressed data, the compression ratio is relative to the nominal size, notthe input
file size. Specifying a 10:1 compression ratio for a file that was already compressed 20:1 will likely yield a
much larger file.

1. Click the Add Image icon Oto add an image to the Job List.

2. Select the image in the Job List.

3. Inthe Properties tab, click in the Compression Ratio field and enter the compression ratio that you want
to use.

4. Enterthe ratio that you want to use in the text field.

As a rule of thumb, you can compress raster images to a ratio of 20:1 without introducing noticeable compression
artifacts. Compression artifacts include blurring and speckling. By default, the compression ratio for RGB images
is 20:1 and the compression ratio for grayscale images is 10:1. For multispectral images and LiDAR point clouds,
GeoExpress uses lossless compression by default.

You can set individual compression ratios for each band in a multispectral image. Use per-band compression
when you want to compress certain bands in an image more than others. For example, if you want to preserve the
visual quality of a multispectral image, you can compress the RGB bands of the image less than the other bands.
You can only set per-band compression ratios for MrSID Generation 4 output images.

1. Click the Add Image icon Oto add an image to the Job List.

Select the image in the Job List.

In the Properties tab, select MrSID Generation 4 from the Output Format drop-down.

In the Properties tab, click Job Options.

On the Compression tab, select the Per Band option.

Click Select Bands.

Select one or more bands from the list and enter a compression ratio (or select Lossless).
Click Apply to Selected to set the compression ratio for the selected bands, then click OK.

©® N ORMLODN
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For multispectral images, GeoExpress enables the RGB Color Transform option by default. With this option
enabled, GeoExpress will optimize the compression of the first three bands of the image rather than compressing
each band individually.

If the first three bands of the image are not the RGB bands, change the order of the bands before you apply the
RGB color transform.

If you select the Lossless option, GeoExpress does not optimize the compression ratio of the RGB bands.

By default, GeoExpress matches the color space of the output image to the color space of the input image. When

you change the compression method of an image to per-band compression, GeoExpress does not apply the
RGB color transform by default.

Specify atarget file size for a raster image to create an output image whose file size equals the target file size.
You can specify a target file size for MrSID Generation 3 and Generation 4 images.

1. Click the Add Image icon Oto add an image to the Job List.

2. Select the image in the Job List.
3. Inthe Properties tab, select Target File Size in the Compression Method drop-down.
4. Enterthe target file size in megabytes in the text field.

Use lossless compression to compress an image or point cloud as much as possible without discarding any data.
You can use lossless compression to create MrSID Generation 4, MrSID Generation 3, JPEG 2000, LAS, LAZ,
and BPF images.

Lossless compression typically yields a 2:1 compression ratio which yields a 50% reduction in the file size. Use
lossless compression when you need the compressed file to be identical to the original file.

1. Click the Add Image icon Q to add an image or point cloud to the Job List.

2. Select the image or point cloud in the Job List.
3. Inthe Properties tab, select the Lossless option.

NOTE: If you compress an image that has already been compressed, you can select Lossless to ensure
that GeoExpress does not discard any additional data.
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When you compress a floating point image, GeoExpress uses quantization to compress the image. You can
create 32-bit floating point images in the MrSID Generation 4 format.
Quantization is a lossy compression method that reduces the number of pixel values in the image. Quantization is
necessary for floating point images for two reasons:
« Performing arithmetic on floating point values results in rounding discrepancies.
« Compressing floating point values results in unnecessarily large images. This is because some of the
digits in each pixel value contain data that is not significant and cannot be compressed.

As aresult, GeoExpress uses alossy compression method for floating point images, but guarantees the accuracy
of the image data to an optimized precision value.
To compress a floating point image with the quantization compression method, complete the following steps:

1. Click the Add Image icon O to add a floating point image to the Job List.

2. Select the image in the Job List.

3. Inthe Properties tab, click More Options.

4. Select MrSID Generation 4 as the output format.
GeoExpress selects the Quantization compression method automatically for floating point images.

5. Optionally, click the Set Quantization button to configure quantization precision and other quantization
options.

For more information, see on page 82.
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All manipulation operations are for raster images only with the exception of editing metadata. Use the toolbar to
perform image manipulation operations. You can perform the following image manipulation operations:

. Edit metadata for an image. Edit the metadata of a raster image to include custom information in the
image. Edit the metadata of a LIDAR point cloud to edit the coordinate reference system information. You
can edit the metadata of MrSID and JPEG 2000 files.

« Despeckle an image. Remove speckling from MrSID and JPEG 2000 images.

« Crop an image. Select the area of an image that you want to keep and discard the other areas.

« Select an area of interest for an image. Specify part of an image as an area of interest. You can change
the compression ratio of the area of interest to preserve more image detail in that part of the image or to blur
that part of the image.

« Adjust the color balance for an image. Edit the brightness, contrast, and gamma values for an image.
You can also change the values for each band in an image.

« Reproject an image. Change the projection used by the image. You can specify a custom well known text
(WKT) string or select a standard coordinate reference system.

Image manipulation operations only take effect after you run the job for the image.

Use the Edit Metadata tool to edit the metadata of images and LiDAR point clouds. You can also use the tool to
view the existing metadata of raster images.
For raster images, the following list describes the types of metadata that you can edit in GeoExpress:
« User. Custom metadata fields that you can use to store comments, information about your organization,
and any other information that you find useful. You can edit user metadata for any image.
« Image. Metadata fields that describe the image, including the image location, resolution, and other
metadata. You can edit image metadata for images with the MrSID and JPEG 2000 output formats.
« NITF. Metadata fields that describe the image file header, subheader, and security fields. You can edit
NITF metadata for images with the NITF output format.

For LIDAR point clouds, you can only edit coordinate reference system metadata.
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The types of metadata that you can edit depend on the output format that you select for an image.

1. Select one or more jobs in the Job List.
2. Click the Edit Metadata button in the toolbar.

The Metadata Manager appears.
3. To edit user metadata, click the User tab of the Metadata Manager.
m Toadd anew tag, click Add User Tag, then enter a name and value for the tag.
m To edit the value of an existing tag, select it from the drop-down and enter another value.

NOTE: Tag names cannot contain spaces, and tag values cannot be empty. Existing tags can be
deleted but cannot be renamed.

4. To editimage metadata, click the Image tab of the Metadata Manager.
m Save the image’s coordinate reference system in the metadata by clicking Select a Coordinate
Reference System or entering a custom well known text (WKT) string in the WKT text field.
For more information on selecting a coordinate reference system, see
on page 64.
m Edit the image origin, image resolution, and dynamic range.

NOTE: Selecting a coordinate reference system in the Metadata Manager does not reproject the
image.

5. Toedit NITF metadata, click the NITF Options tab of the Metadata Manager.
m Edit the file header and file security fields in the File Header subtab.

m Edit the image subheader, image comments, and image security fields in the Image Subheader
subtab.

6. Click OK.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain decoders may fail to
display them if you edit their metadata. To accommodate these images, GeoExpress handles several
JPEG 2000 parameters in a special way. If you are editing the metadata of existing images and wish to
change parameters for tile length markers, packet length markers, or tile parts, you must change them on
the JPEG 2000 tab of the Preferences dialog. (For more information see on
page 117 and on page 92.)

For LIDAR point clouds, you can edit the coordinate reference system (CRS) stored in the file metadata.

1. Select one or more jobs in the Job List.
2. Click the Edit Metadata button in the toolbar.

The LiDAR Metadata dialog appears.

3. Begin typing the name of a CRS or an EPSG code in the Coordinate Reference System field.
A list of matching coordinate reference systems appears.

4. Select the CRS from the list.

You can also select Use custom WKT and paste a well known text (WKT) string into the text box.
5. Click OK.
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For raster images you can view existing metadata.

1. Select ajobinthe Job List.
2. Click the Edit Metadata button @ in the toolbar.

The Metadata Manager appears.

3. Click the Viewer tab.
The image metadata appears.

4. If animage has geographic markup language (GML) embedded in the metadata, select the GML option to
view the GML.

5. Click OK.

NOTE: To view sample metadata, see on page 140.

LizardTech user metadata is merely descriptive and has nothing to do with the image pixel data. There are 12
default user metadata tags. They can be thought of as addenda or footnotes and include such data as geographic
location, company name, and scan info. You can include data for any or all or none of the tags, and you can add
your own custom user metadata tags for other information you would like to include. All of LizardTech’s user
metadata tags can be edited.

LizardTech image metadata is information about the pixel values that tells viewing software how to interpret or
treat each pixel. There are many image metadata tags, and a small subset of these are available for editing.
Editing the image tags does not affect the pixel values themselves. For example, changing WKT metadata does
not reproject an image from one CRS to another. However, changing metadata may affect how an image is
displayed in a viewer.

You can assign a WKT to the image that identifies its coordinate reference system. This is useful when you know
the CRS of an image but that data isn’'t captured anywhere in the file. It's also useful if the WKT is incorrect and
you need to correct it.

IMPORTANT: Setting the WKT in the metadata of an image does NOT reproject the image. It only
identifies where the image already is. To reproject an image to a new CRS, use the reprojection tools.
Additionally, carelessly changing the WKT of an image may make the image inaccurate or unusable in any
GIS applications that rely on this information.

These X and Y fields can be used to set the x, y location of the image.

These X and Y fields can be used to set the x and y resolutions of the image.
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To improve the appearance of MrSID images in other GIS programs, you can use GeoExpress to write dynamic
range metadata forimages.

NOTE: If you select MrSID Generation 4 as the image output format, dynamic range values are calculated
automatically for all images except for 8-bit images. If you want to enter the dynamic range values
manually for those images, change the method for generating the dynamic range to None in the Format-
Specific tab of the Advanced Job Options dialog. For more information on calculating the dynamic
range, see on page 87.

The dynamic range metadata is particularly useful forimages that only use a small portion of their datatype
bandwidth. For example, 11-bit images are often stored as 16-bit images, where the upper five bits are left empty.
The only bits that are meaningful are the first eleven. The full dynamic range of pixel values in an unsigned 16-bit
image runs from 0 to 65535. The first eleven bits fall between 0 and 2047, which is only 3% of the full range! When
you look at the histogram of this image (for information on histograms see on page 58), all
of the values will be gathered into the far left side, causing the image to appear black whenit's scaled to display on
a computer monitor. For an 11-bit image, the minimum value would be 0 and the maximum value would be 2047
@1 -1).

An alternate way to think of dynamic range is “window and level.” The window is the width of data that’s important
and the level is where the midpoint of the window lies within the entire range. For our 11-bit image, the window, or
width, is 2048 (211), and the level, or midpoint, is 1023.5 ((211- 1)/ 2). The window and level are displayed next to
the Min and Max fields to aid you in setting the dynamic range.

To set the dynamic range of the image, type the minimum pixel value in the Min field and the maximum pixel value
in the Max field.

IMPORTANT: Setting the dynamic range does not change the pixel data of the image. It only gives clues
as to how the image should be displayed. Some applications may honor this value and some may ignore it,
depending on how the pixels need to be represented for a given workflow. Additionally, setting the dynamic
range is not the same as color balancing. Color balancing changes the actual pixel values, which changes
the nature of the image. (For more information see on page 103.)

In addition to the image metadata that you can edit, GeoExpress embeds encoded MrSID and JPEG 2000 images
with a header to preserve metadata from source images. This header is able to carry information on image
location, projection, date produced, and RGB color lookup tables (CLUT) for indexed color images. Each tag is
accompanied by a short description of the method used to write out the data, either ASCII, signed or unsigned 8-
bit, signed or unsigned 16- or 32-bit integers, or single or double-precision floating point.

Certain input image types such as NITF, GeoTIFF, ERDAS IMAGINE and USGS DOQ may have additional
metadata tags. Such tags are carried over from the source image as-is to the output file in addition to the standard
LizardTech metadata tags. If the image being encoded is a mosaic, GeoExpress preserves the metadata values
from the first image in the mosaic. If no information is available for a specific tag, the tag is left out of the header.
Some tags apply to any MrSID or JPEG 2000 image, with or without georeferencing information; other tags apply
specifically to georeferenced images.

NOTE: When encoding GeoTIFF imagery, all the native GeoTIFF metadata tags are prepended with the
string GEOTIFF_CHAR: :.
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In addition there are special tags that contain statistical information about the pixel intensities in an encoded
image. These tags contain the minimum, maximum, mean, and standard deviation of the pixel values in the
image. For a grayscale image, single values are output. For an RGB image, values are output in an array where
the first value represents the red band, the second band represents the green band, and the third band represents
the blue band.

The mrsidgeoinfo command line tool can display metadata tags. It is included in the GeoExpress installation.

General

Tags

The tags written into MrSID and JPEG 2000 metadata are listed in the following table. If an image or mosaic is
cropped while being encoded, the values apply to the cropped output image unless noted otherwise. There is no

predetermined order for the tags.

TAG DESCRIPTION NOTES

IMAGE: :BITS_PER_SAMPLE Number of bits per

sample (unit16)

IMAGE: : COLOR_SCHEME Color space of the Possible values: @ for RGB, 2 for CMYK, 3 for

image (unit32) grayscale, or 10 for multispectral

IMAGE: :DATA_TYPE Datatype of samplesin |Possible values: @ for unsigned 8-bitint, 1 for 32-bit

image (unit32) float, or 2 for unsigned 16-bit int

IMAGE: :DEFAULT_DATA_VALUE |Sample values for Stored as an array of values, one for each band, in

background pixel order. The values are stored in the datatype of the
samples. Note: With older images containing unit8
data, the tag IMAGE : : NO_DATA_VALUE may be used

IMAGE : : DYNAMIC_RANGE_ Custom contrast setting |Represents the size of the range of the data

WINDOW (double)

IMAGE : : DYNAMIC_RANGE_ Custom brightness represents the midpoint of the range of the data

LEVEL setting (double)

IMAGE: :EOM End of metadata

IMAGE: :HEIGHT Height of the image in

pixels (unit32)

IMAGE: : INPUT_FILE_SIZE Size of the inputimage

or mosaic, in bytes
(double)

IMAGE: : INPUT_FORMAT Name of the input

image type (string)

IMAGE: : INPUT_LUT Color lookup table Stored as an array of 758 values (3 x 256), one value
for each band (R, G, B) for each of the 256 entries in
the table.

IMAGE: : INPUT_NAME Filename of the input

image (string)

IMAGE: :NO_DATA_VALUE Sample values for Used only for older MrSID images; see

background pixel IMAGE: : DEFAULT_DATA_VALUE

IMAGE: : SOM Start of metadata

IMAGE : : TRANSPARENT_DATA_ sample values for the Stored as an array of values, one for each band, in

VALUE nodata pixel order. Values are stored in the datatype of the
samples.
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TAG DESCRIPTION NOTES
IMAGE: :WIDTH Width of the image, in
pixels (unit32)

IMAGE: :X_RESOLUTION

Georeferencing pixel

resolution in the x-
direction (double)

resolution in the y-
direction (double)

IMAGE: : XY_ORIGIN Georeferencing Stored as an array of two doubles.
location (x, y) for the
center of the top left
pixel.

IMAGE: :Y_RESOLUTION Georeferencing pixel

Area of Interest (AOI) Tags
The tags in the table below apply only to images encoded with areas of interest:

TAG

DESCRIPTION

NOTES

IMAGE: :AOI: :N::REGION::VECTOROVERLAY

Name of the vector overlay file, if
any (string)

region (string)

IMAGE: :AOI::N::REGION: :VECTOROVERLAY_ |Layer number from the vector
LAYER overlay file, if one is used
(integer)
IMAGE: :AOI::N::REGION::X Upper left x position of the region
(integer)
IMAGE: :AOI::N::REGION::Y Upper left y position of the region
(integer)
IMAGE: :AOI: :N: :METHOD The Area of Interest method used |Possible values: shift
(string) inner, shift outer,or
weight.
IMAGE: :AOI: :N::WEIGHT Weight value used (double)
IMAGE: :AOI::N::MAGNIFICATION Magnification at which the AOI
was applied (double)
IMAGE: :AOI: :N: :NAME Optional name of the AOI region
(string)
IMAGE: :AOI: :N::COMMENT Optional comment for the AQI
region (string)
IMAGE: :AOI::N::URL Optional URL referring to the AOI
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MG2-Only Tags
The tags in the table below apply to MG2 images only:

TAG DESCRIPTION NOTES

IMAGE : : COMPRESSION_BLOCK_ Block size used in MrSID

SIZE encoding (unit32)

IMAGE : : COMPRESSION_GAMMA G-weight value used in MrSID
encoding (float)

IMAGE: : COMPRESSION_VERSION |Version of the encoder used
(array of 3 sint32 values)

IMAGE: : COMPRESSION_WEIGHT Weight value used in MrSID
encoding (float)

IMAGE: : CREATION_DATE Date and time ofimage
encoding (string)

IMAGE : : COMPRESSION_NLEV Number of zoom (resolution)
levels in the image (unit32)

IMAGE: : STATISTICS :MAXIMUM Maximum sample values for The number and datatype of the values
each band in the inputimage correspond to the number of bands and
(array of values) sample type of the image.

IMAGE: :STATISTICS:MINIMUM Minimum sample values for The number and datatype of the values
each band in the inputimage correspond to the number of bands and
(array of values) sample type of the image.

IMAGE: :STATISTICS:MEAN Average value of all samples
for each band (array of
doubles)

IMAGE: :STATISTICS:STANDARD_ |Standard deviation of all

DEVIATION samples for each band

IMAGE: : TARGET_COMPRESSION_ |compression ratio used for For MrSID Generation 2 (MG2), this value

RATIO encoding (float) only approximates the actual compression

ratio achieved.

MG4-Only Tags
The tags in the table below apply to MG4 images only:

TAG DESCRIPTION NOTES
IMAGE: :QUANTIZATION_ |Precision values |Forfloating pointimages, GeoExpress uses the quantization
SCALE used for compression method. For more information on the precision value,
quantization see Quantization Precision on page 83.
Other Metadata Tags

When using GeoTIFF input images, the GeoTIFF metadata tags are copied directly into the MrSID or JPEG 2000
file. When using ERDAS IMAGINE and USGS DOQ metadata, certain other custom metadata tags are inserted
as well.
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NITF Metadata
You can edit the following metadata for images with the NITF output format:
« File header
« File security fields
« Image subheader
« Image security fields
« Image comments

For more information on NITF metadata, see the NITF 2.1 specification at
http://www.gwg.nga.mil/ntb/baseline/docs/2500¢/2500C. pdf.

Viewable NITF Metadata

In addition to the NITF metadata that you can edit, GeoExpress embeds metadata from NITF input files to
preserve the source metadata. When reading a NITF file, GeoExpress stores many NITF fields as metadata, for
example as tag/value pairs in MrSID imagery.

NOTE: The following discussion assumes familiarity with the NITF specification.

In general, the tag name is of the form
NITF::xxnnn::field
where xx is a two letter code representing the NITF segment (IM for image, FH for file header) and nnn is the

NITF segment number. TRE fields contain the prefix TRE_. Specifically, GeoExpress stores input fields in
metadata tags as described in the following tables.

File Header Fields
GeoExpress stores file header fields in the following tags:

NITF FIELD GEOEXPRESS TAG
FHDR NITF::FH000::FHDR
FVER NITF:FHOOO::FVER
STYPE NITF::FH000::STYPE
OSTAID NITF::FH000::OSTAID
FDT NITF::FHO00::FDT
FTITLE NITF::FHOOO::FTITLE
ONAME NITF:FHO00::ONAME
OPHONE NITF::FH000::OPHONE
NUMI NITF::FHOOO0::NUMI
NUMS NITF::FH000::NUMS
NUML NITF::FHO00::NUML
NUMT NITF:FHOO0O0:NUMT
NUMDES NITF::FHO00::NUMDES
NUMRES NITF:FHOOO0:NUMRES

Using GeoExpress, you can set the values for OSTAID, FDT, FTITLE, ONAME, and OPHONE when encoding
NITF images.
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Security-Related Fields
GeoExpress stores security-related fields from the file header (unless they are blanks) in the following tags:

NITF FIELD GEOEXPRESS TAG
SCLAS NITF::FHO000::SCLAS
SCLSY NITF:FH000::SCLSY
SCODE NITF::FH000::SCODE
SCTLH NITF::FHO000::SCTLH
SREL NITF::FHO00::SREL
SDCTP NITF::FH000::SDCTP
SDCDT NITF::FHO000::SDCDT
SDCXM NITF::FH000::SDCXM
SDG NITF::FH000::SDG
SDGDT NITF::FH000::SDGDT
SCLTX NITF::FH000::SCLTX
SCATP NITF::FHO00::SCATP
SCAUT NITF::FH000::SCAUT
SCRSN NITF::FHO000::SCRSN
SSRDT NITF::FH000::SSRDT
SCTLN NITF::FHO00::SCTLN

GeoExpress allows you to specify values for any of these fields.
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Image Segment Fields
GeoExpress stores image segment fields in the following tags:

NITF FIELD GEOEXPRESS TAG

D1 NITF::IM001::1ID1
IDATIM NITF::IMOO1::IDATIM
TGTID NITF::IM001::TGTID
D2 NITF::IM001::1ID2
ISORCE NITF::IM001::ISORCE
ICORDS NITF::IM001::ICORDS
IGEOLO NITF::IM001::IGEOLO
NICOM NITF::IM001::NICOM
ICOM1 NITF::IM001::ICOM1
ICOM2 NITF::IM001::ICOM2
ICOM3 NITF::IM001:1COM3
ICOM4 NITF::IM001::1ICOM4
ICOM5 NITF::IM001::ICOM5
ICOM6 NITF::IM001::1ICOM6
ICOM7 NITF::IM001::ICOM7
ICOM8 NITF::IM001::ICOM8
ICOM9 NITF::IM001::ICOM9

With GeoExpress, you can enter custom data for these image segment fields: IID1, IDATIM, TGTID, IID2,
ISORCE,NICOM, ICOM1 through ICOM9.

Additional Notes
In addition, GeoExpress does the following:
« handles the security fields in the Image Segment as they are handled in the file header
« stores all detected TREs in metadata as binary data. For example, USEOOA data would be stored as an
array of bytes using the following tag:
NITF::IMOO1::TRE_USEOGOA
« explicitly recognizes the following TREs when reading in a NITF file:
J2KLRA, USE@OA, STDIDC, PIAIMC, and RPCOOA/B
For these TREs, additional metadata entries are created corresponding to each of their constituent fields.
For example, PIAIMC data is represented as follows:
NITF::IM@O1::TRE_PIAIMC_CLOUDCVR
NITF::IMOO1::TRE_PIAIMC_SRP
NITF::IMOO1::TRE_PIAIMC_SENSMODE
NITF::IMOO1::TRE_PIAIMC_SENSNAME

Metadata Templates

To assist in editing the user metadata of multiple images, the Metadata Manager allows metadata templates to be
saved and applied to one or more images. A metadata template contains all of the tags and values that you wish to
apply to a given image orimages.

Metadata templates are created, edited, saved, retrieved and applied in the Metadata Template Editor.
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1. Select one or more jobs in the Job List.
2. Choose Options > Metadata.
This opens the Metadata Manager dialog.
3. Click Metadata Templates to open the Metadata Template Editor.

Select or deselect a value or set of values to enable or disable a given tag.

The image tags are the same as those in the Metadata Manager except that you can choose to save any or all of
these in the template.

1. Click in the Name field of the row that starts with an asterisk (*).
2. Type a name for the tag.
3. Click the Value field and enter a value.

Tag names cannot contain spaces and tag values cannot be empty.

1. Select the entire tag by clicking the gray cell at the far left of the row.
2. Press the Delete key.

1. Click the Save Template button.
2. Enter a name for the template and click OK.

1. Click the Load Template button.
2. Choose a template from the drop-down list and click OK.

1. Choose the template in the Load Metadata Template or Save Metadata Template dialog.
2. Right-click the template name and choose Delete this template.

1. Create atemplate or load a template in the Metadata Template Editor.
2. Click Apply Template.

If you need to make images with higher compression ratios, use the Despeckle tool to minimize compression
artifacts.

A side effect of lossy encoding schemes is that subtle compression artifacts are introduced which alter the pixel
values of the source image. While these changes are usually invisible to the human eye, they can damage the
integrity of any collar regions in the image, which makes it difficult to seamlessly mosaic images together. The
best way to avoid this “speckling” in the collar areas is to compress to MrSID Generation 4 (MG4), or to losslessly
encode source images to MrSID Generation 3 or JPEG 2000.

IMPORTANT: Despeckling is a computationally expensive operation that increases the time it takes to
encode an image. Also, despeckled JPEG 2000 files employ an alpha band to mask the transparent region;
most, but not all, applications can view JPEG 2000 files with alpha bands.
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Despeckling is only supported for MG3, MG4, and JPEG 2000 output. If you select JPEG 2000 as the format of
your despeckled output, that output will be a GMLJP2 file and thus a JPEG 2000 Part Il file, even if your input was
a JPEG 2000 Part | file. Source images with alpha bands cannot be despeckled when outputting to JPEG 2000.
Also, the area of valid image data must be contained within a single polygon (for example, an image of a series of
islands cannot be despeckled).

By default, images are not despeckled upon encoding. Further, despeckling is not recommended for images
without a collar. To despeckle images by default for the MrSID or JPEG 2000 formats, set the despeckling option
in the preferences. For more information on preferences, see on page 109.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain decoders may fail to
display them when despeckled with GeoExpress’ default settings. To accommodate these images,
GeoExpress handles several JPEG 2000 parameters in a special way. If you are despeckling images
using the Despeckling dialog and wish to change parameters for tile length markers, packet length
markers, ortile parts, you must change them on the JPEG 2000 tab of the Preferences dialog. (For more
information see on page 117 and on
page 92.)

When you select a single job for despeckling, the image is displayed in the preview area of the dialog. If you select
multiple jobs, the preview pane and navigation buttons are not displayed. You can despeckle images with the
MrSID Generation 4, MrSID Generation 3, or JPEG 2000 output format.

1. Add a source image or mosaic to the Job List.
2. Click the Despeckle button on the toolbar.

This opens the Despeckle Options dialog.

3. Select Despeckle Output.

4. Optionally, enter threshold and point spacing values by typing them in the edit fields or using the slider
controls (see below for information about these values). Note: The sliders only move within the
recommended range (1-127 for threshold and 612 for point spacing), but you may enter any integer greater
than zero in the fields.

5. Topreview the effects of the threshold at different settings select the View Threshold option and then
move the Threshold slider. Black areas are pixels whose values fall below the threshold and will be used
to determine the despeckling collar of the image.

6. Click OK.

All pixel values below the despeckling threshold will be used in the despeckling process. For example, with a
threshold value of 10, GeoExpress treats any border pixels with a value less than 10 as no-data pixels.

By default, the threshold value is 8.

In order to despeckle an image, GeoExpress must determine the mask or “outline” of the valid image data. This
outline is created as a polygon of connected points, similar to a “connect the dots” drawing. Image data that fall
outside the outline are treated as invalid and subject to despeckling.

Whether image pixels are incorporated into the mask or abandoned as “islands” of data is largely a function of the
point spacing value, which determines the distance between the points that make up the outline. The less
distance there is between points in the outline, the more points it takes to create the entire outline.
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Therefore, decreasing the point spacing value raises the number of points, which is generally desirable and is
particularly useful when the outline is complex, such as that of a coastline. However, higher numbers of points
may slow performance or cause the job to fail. Conversely, increasing the point spacing value reduces the total
number of points, which makes for better performance. When the outline is simple, such as a rectangle, the point
spacing value can safely be increased.

For any given dataset, some trial and adjustment may be required to arrive at the best balance between a more
accurate mask (lower point spacing value) and better encode performance (higher point spacing value).
Generally, even values between 6 and 12 work best. By default, the point spacing value is 6.

Use the Image Crop tool to crop a region from any rasterimage in the Job List whether it is a single image or an
image mosaic.
To define the area of an image that you want to crop, draw a rectangle on the preview image or select a shapefile
with one or more polygons. If the shapefile contains multiple polygons, you can either create a single output image
that contains all of the polygon crop areas, or you can create a separate output image for each crop area. Multiple
output images are saved according to the following naming convention:

<output file name>_<column label>_ <polygon ID>

For example, if you select Washington as the output file name, and the shapefile polygons have a column for
counties, one of the output files would have the following name:

Seattle_KingCounty_1.sid

NOTE: If you crop existing MrSID and JPEG 2000 images but do not compress the images again, you do
not use data from the data cartridge.

You can select a crop region by entering values for the image extents. You can also click Show Image to display
an image preview and draw a rectangle of the area that you want to crop.
To manually enter the cropping extents, complete the following steps:

1. Select animage or mosaic in the Job List.

2. Click the Image Crop button 'lZF on the toolbar.

3. Enter the cropping extents, then click OK.

To define the crop region by drawing a rectangle, complete the following steps:
1. Select animage or mosaic in the Job List.
Click the Image Crop button ﬁ on the toolbar.

Click the Show Image button at bottom right.
Use the zoom in, zoom out and other tools from the image crop toolbar to position the image.
Click the Crop button on the image crop toolbar.

o s w N
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6. Draw a rectangle on the image to define the crop region as shown below.

ER Image Crop [m| X

Crop method:
ﬁ’ & Q Q ‘ ﬁ Scale: 1:64
Rectangle o

Enter crapping extents or click Show Image to draw the
extents.

Top
52730135

Left Right
B077765 5192965
Botiom
52632215
-
Fill Color: |
oK Cancel X Y.

7. Optionally, adjust the rectangle using the corner or center handles.
8. Click OK.

The extents of the original image are displayed in the Image Extents panel on the Properties tab for easy
reference.

Cropping by Shapefile
GeoExpress allows you to crop images using a shapefile with one or more polygons. If the shapefile contains
more than one polygon, you must select the polygons that you want to use to crop the image.

1.

2
3.
4

Select animage or mosaic in the Job List.
Click the Image Crop button ﬁ on the toolbar.

In the Crop Method panel, select the Shapefile option.

Click Browse to select the shapefile that you want to use.

A list of the polygons in the shapefile appear in the table. By default, if the polygons have a name property,
the names are displayed as the label in the table.

Optionally, use the Label drop-down to select the shapefile property to display as the label.

For example, you might select a property named Voting District to identify polygons to select.
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6. Select the polygons that you want to use for cropping in the table.
You can also click the Select Features button to select polygons in the preview pane. For both the

table and the preview pane, you can press the Control key to select multiple polygons. Additionally, when
you use the select feature tool, you can right-click on a polygon in the preview pane to display its properties

9.

inatable.
ER Image Crop [m| X
Shapefile o

Crop method: R} Q Q\‘ E Scale: 1:64

Choose a shapefile and select the polygons that you
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Fill Calor: |
oK Cancel Hide Image X 5501125 Y: 52704535

If you selected multiple polygons, select whether you want to join the cropped regions for each polygon into
a single output image, or you want to create a separate output image for each polygon crop region.

Select Crop to exact bounds to output only the area within the selected polygon(s). Deselect this option
to output everything within the rectangle that encloses the selected polygon(s).

If you select Separate output for each polygon, this setting affects each output file separately.
Optionally, click Show Image to preview the crop area or areas on the source image.

NOTE: Cropping by shapefile is not supported when the output format is JPEG 2000 and the input image
has multiple bands.
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The Area of Interest Tool

The Area of Interest (AOI) encoding feature enables image customization through the preservation or obscuring of
detail. AOI enables you to define one or more areas within an image or mosaic and encode these areas at a higher
or lower compression ratio than the remainder of the image. Using AOI thus creates a visual contrast between the
area(s) of interest and the surrounding image, rendering either “sharper” (lower compression) areas or “blurred”
(higher compression) areas. In the image below we’ve drawn a rectangle around an area that has been defined as
an area of interest and compressed at a lower ratio than the rest of the image. Note that more detail is preserved
within that area.

GeoExpress offers three methods of encoding an area of interest: the weight, shift and mask methods.
GeoExpress enables you to encode an area of interest in MG3, MG4, or JPEG 2000 format. When the output
format selected is JPEG 2000, any method can be used. MrSID encoding requires the weight or mask method.
For more information about using these methods, see MG3 and MG4 Area of Interest Encoding on page 55 and
JPEG 2000 Area of Interest Encoding on page 55.
Although area of interest is a simple concept, there are many factors that come into play when generating both the
preview and the final encoded image in an area of interest operation. Some of these factors are:

« therelative size of the selected area in relation to the entire image

« the difference between the two compression ratios applied (inside and outside the selected area)

« the presence or addition of a crop operation in conjunction with an area of interest encode

« the desired output format (MG3, MG4, or JPEG 2000)

« the complexity of the imagery being manipulated

Some of the effects that a user may experience as aresult of these factors are:
« slight bleeding of the AQI resolution into the surrounding image
« “outside” area seems less compressed than expected given the specified compression ratios
« area of interest specified as lossless is not always numerically lossless for some encode scenarios (this
variation is greater in JPEG 2000 encoding than in MrSID encoding).
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You may define areas of interest in GeoExpress by vector overlay or by drawing a single rectangle. GeoExpress
enables you to define areas of interest in MG3, MG4 and JPEG 2000 encoding.

Vector overlay support enables you to include multiple areas of interest within a single image.

1. Select ajobinthe Job List
2. Click the Area of Interest button J on the toolbar.

This opens the Area of Interest dialog.
3. Toview the image while setting area of interest parameters, click the Show Image button.

A single rectangle can be used to express an area of interest either as the foreground or background (see
on the facing page).

You can define a single rectangle either by entering values for offsets or by drawing a rectangle across the image
with the Draw Area tool. The Draw Area tool is not accessible unless the image is shown.
To enter numerical values to define a single rectangular area of interest:

1. Access the Area of Interest dialog as described above.

2. Select the User Defined Rectangle option.

3. Entervalues for the Top, Right, Bottom, and Left offsets.

4. Select other desired parameters and click OK.

To use the Draw Area tool to define a single rectangular area of interest:

1. Access the Area of Interest dialog as described above and click Show Image.
Select the User Defined Rectangle option.
Click the Draw Areaicon 14 above the image window.

Click and drag on the image to define a rectangle.

Adjust the shape and size of the rectangle by clicking and dragging the “handles” at the sides and corners;
adjust its position using the middle handle. Offset or other positioning values are automatically filled in.

6. Select other desired parameters and click OK.

a s 0N
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GeoExpress supports vector overlays of Esri Shapefile (* . shp), MapInfo TAB (* . tab), and GML version 2
(*.gml) formats. Vector overlays must be in the same coordinate system as the input image file and must contain
closed polygons in order to be valid. GeoExpress uses all valid shapes within the active layer as the combined
area of interest; individual shapes within the active layer cannot be turned on or off.

Area of interest options set by the user apply to all shapes in the active layer.

Vector overlays are not editable within GeoExpress.

To use a vector overlay to define an area of interest:

1. Access the Area of Interest dialog as described above.

2. Select Vector Overlay File.
A panel of vector overlay options appears in the middle of the dialog.

3. Enter afile path in the Vector Overlay File field or click Browse to search your directories.

4. Select an active layer from the drop-down list if necessary. GeoExpress supports only a single layer of a
given vector overlay. By default the first layer is taken.

5. Select any other desired parameters and click OK.

To remove a currently listed vector overlay, click Remove Vector Overlay File.

If you use a vector overlay to define an area of interest and select the Show Image option, the shapes will be
drawn on top of the input image in the image window. Filling in the shapes may give you a better idea of the areas
they define by displaying the shapes as solid polygons.

Tofill in the areas of interest, select the Fill Shapes option below the image window.

To customize the outline color for the drawn shapes, click the Outline Color button. Set the line width for the
drawn shapes on the Appearance tab of the Preferences dialog. Changing the outline color and line width has no
affect on the resulting encoded image, and is only used for previewing purposes.

NOTE: The use of GML-formatted vector overlays can result in the creation of files with a . gfs extension
in the directory on your computer where the GML files are stored. These are not used again and may be
ignored or deleted.

All regions inside specified areas of interest are called “foreground”. All surrounding regions are called
“background”. The Inner and Outer options correspond respectively to foreground and background and enable you
to choose which part of an image the AOI processing will affect.

In MrSID encoding, “inner” and “outer” are not specifically referred to except when using the mask method, as
noted below. Either the foreground or background is given preference by the difference in weight between them as
specified by the compression ratio of the foreground and that of the area(s) of interest.

In JP2 encoding using the weight and shift methods, selecting either the Weight Inner or the Shift Inner option
preserves the quality of the foreground at the expense of the surrounding regions. Similarly, selecting Weight
Outer or Shift Outer preserves the quality of the background at the expense of the foreground.

The mask method renders either the foreground (by selecting the Mask Inner option) or background (by selecting
the Mask Outer option) as a solid color. Click Mask Color to select the mask color for either of these options.
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Using Area of Interest with Image Crop
GeoExpress is designed to accommodate a workflow that demands a number of image customizations at a single
encode. Accordingly, it is possible to crop an image and encode an area of interest at the same time. A useful
workflow would be to first define a crop region in an image and then define an area of interest.
To specify your area of interest in relation to an existing crop region:

1. Select Area of Interest from the Tools menu.

2. Click Show Image for an image on which you have already defined a crop region (see The Image Crop

Tool on page 48). The region you defined appears marked out in lines and labeled as the crop region.
3. Define your area of interest and encode.

You can specify an area of interest anywhere in the image, regardless of whether or not it is in the crop region.
Obviously, areas of interest defined outside a crop region will not appear in the results for the cropped version of
the image, but this may be a desired effect since a project can be used for multiple operations.

In this illustration, an area of interest is being drawn within an existing crop region.

B8 Area of Interest O *

Area of Interest Format
(® Userdefined Rectangle () Vector Overay File

Area of Interest
Top

52758455
Left Right
6222085 | [p2s7525

Bottom

52713335
Encoding Method
(® Weight

Compression Ratio: @ 1 [ Lossless
(O Mask Inner () Mask Outer

Add/Remove
Remove Cument ADI

Qutline Color: E

0K Cancel Hide Image * Y.
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GeoExpress offers two methods, the weight and mask methods, for encoding an area of interest with MG3 or MG4
as the output format.

TIP: Area of interest encoding of MG3 and MG4 images can be done more quickly if the images were
originally encoded as optimizable. For more information, see on
page 87.

NOTE: Area of interest encoding in MG3 format automatically uses the 2-Pass optimizer, even if it has not
been selected on the Format-Specific tab of the Advanced Job Options dialog. For more information,
see on page 90.

The weight method is the default for encoding areas of interest with GeoExpress. (This is not to be confused with
the Weight parameter in the Advanced Job Options.) The parameters for using the weight method differ
depending on the output format. MG3 and MG4 require the user to enter a compression ratio for the area of
interest.

GeoExpress calculates the resultant image filesize as part of the encoding process, taking into account the user-
defined compression ratios for inside and outside the area of interest. Selecting the Weight option enables you to
specify an encode ratio for the area of interest or select Lossless. The outside area will be encoded at the
compression ratio specified in the Job Options dialog. These ratios are used in a calculation of the overall image
compression.

The calculated filesize appears on the Properties tab for the image once you close the Area of Interest dialog.

The mask method renders either the foreground or the background as a solid color, completely removing the
underlying image data.

The mask method only applies to encode jobs and is not available for optimizations.
To mask an area inside the AOI polygon (foreground), select Mask Inner.
To mask aregion outside the AOI polygon, select Mask Outer.

To specify or change the mask color, select either Mask Inner or Mask Outer, then click Mask Color. This opens
the AOI Mask Color dialog.

By default the mask color is black. Black drives all pixel values to the minimum supported value (usually zero),
while white drives all pixel values to the maximum supported value (e.g. 255 for an 8-bit image). You can also
specify a custom 8-bit RGB color value.

To specify a custom 8-bit RGB color value, select the Custom option and fill in the red, green and blue values.

The compression ratios for the inside and outside of the area of interest are reported in the GeoExpress log file
after you run the area of interest job. For more information on log files, see on
page 120.

GeoExpress offers three methods, the weight, shift and mask methods, for encoding an area of interest (AOI) with
JPEG 2000 (JP2) as the output format. Also, the weight and shift methods can favor the “inner” or “outer” area (for
more information see on page 53).
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In JPEG 2000 encoding the weight value controls the image quality of the foreground relative to the background or
vice versa: larger values will result in a higher quality foreground and a lower quality background, and smaller
values will result in less of a marked difference. (Note: a value of 1.0 will have essentially no AOI weighting
effect.)

1. Click the Area of Interest button J on the toolbar (or select Area of Interest from the Tools menu) to

open the Area of Interest dialog.
2. Define an area of interest by one of the following methods (for more information see
on page 52):
m Uusing a vector overlay
m drawing or entering values for a single rectangle
3. Select Weight Inner or Weight Outer.
The Value field appears with the default value of 100.

4. Change the default value if desired.

5. If desired, choose a number of resolution levels to be included in the AOI process from the drop-down list.
The default is all levels, but you may choose any number equal to or less than the number of resolution
levels the image includes (see on page 77). For example, if the image is being encoded to
have five resolution levels, then you may choose five or less and the default would be all five levels.

6. Click OK.

When using the Weight method, the actual boundaries of the region are defined by the extents of the codeblocks
within each resolution level. Because the spatial extent of the codeblocks varies by level, the actual encoded
region may appear larger than the selected region, and a step-like fall-off in quality may be noticeable.

The shift method is an alternative way to express the encoding of an area of interest when you select JP2 as the
output format. Rather than affecting the amount of quality in a codeblock at encode time, the shift mode adjusts
the “importance” of individual pixels by the specified shift amount. In other words, this function promotes the
importance (or sharpness) of the data inside or outside the area of interest (see on page 53).
The shift value to be specified is the number of bit positions to “promote” the foreground region over and above the
background. For 8-bit samples, an appropriate scaling factor would be 12. Images to be encoded with large bit-
depths and/or a large number of levels may, under certain conditions, require a higher value.
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1. Click the Area of Interest button J on the toolbar (or select Area of Interest from the Tools menu) to

open the Area of Interest dialog.
2. Define an area of interest by one of the following methods (for more information see
on page 52):
m using a vector overlay
m drawing or entering values for a single rectangle
3. Select Shift Inner or Shift Outer.
The Value field appears.

4. Enter a shift value.

5. If desired, choose a number of resolution levels to be included in the AOI process from the drop-down list.
The default is all levels, but you may choose any number equal to or less than the number of resolution
levels the image includes (see on page 77). For example, if the image is being encoded to
have five resolution levels, then you may choose five or less and the default would be all five levels.

6. Click OK.

The differences between the two methods are subtle and technical; we recommend that the weight method be
used unless large quality differences are desired. While the shift method does not suffer the stepping effects of the
weight method, it affords less granularity of control between foreground and background. The weight method is
enabled by default.

Although with practice and experimentation the shift mode can be used to completely mask out a desired region,
its purpose is “obscuring” areas of an image rather than masking them out. It is recommended that you use the

Mask method if you wish to achieve a masking effect (for more information see on page 55).
The mask method in JPEG 2000 is the same as in MrSID area of interest encoding. See on
page 55.

This parameter controls the number of resolutions levels subject to the area of interest encoder process in the shift
and weight methods; this can be used to alleviate the “stepping” effect mentioned above. When “Number of AQI
Levels”is set to less than the total number of levels in the image, the lower-resolution levels will not undergo AQI
processing; in this way, only the N highest resolutions are affected, so the icon image (and potentially other lower-
resolutions) will appear as if no AOI had been selected.

For information on viewing the results of encoded areas of interest, see on page 55.

When using the Weight method for area of interest encoding with JPEG 2000, it is recommended that you use a
smaller codeblock size, such as width = 32, height = 32. This parameter can be set on the Format-Specific tab of
the Advanced Job Options dialog (see on page 92).

The overall compression ratio chosen for the encode job can be as important to the appearance of the region as the
actual weight or shift values chosen. The image quality at a given compression ratio may diverge dramatically
from expected results when AOI encoding is enabled. Getting the desired effect in JPEG 2000 area of interest
encoding may require a trial and revision process.
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A city government has an area that will be under construction with a new housing development. The contractor
needs access to high-quality imagery in the construction zone. The contractor will need the remainder of the
imagery at a lower quality in order to overlay existing roads, etc. The city has an existing composite MrSID
Generation 3 (MG3) mosaic of MrSID imagery created from 100 smaller MG3 images compressed at a ratio of
20:1. The city will import a vector overlay that outlines the area of construction and would like to specify a lossless
compression ratio in this area (i.e. no additional loss after original 20:1 compression) and an additional 20:1
compression for the remainder of the image in order to reduce the file size of the deliverable and still meet the
contractor’s needs.

The United States Department of Defense (DoD), as a measure against terrorism, requires that imagery over the
nation’s Capitol building and White House in Washington, DC, not be delivered in high resolution. In the past data
providers have downsampled those areas of the images and mosaicked them back together, which can be time
consuming. A data provider would like to load the mosaic of original TIFF files into GeoExpress, select a region,
apply a 100:1 compression ratio over the selected region and 20:1 compression for the remainder of the mosaic.

A Paris city employee working in the field with low bandwidth wants to view an extremely large image of Paris
online through a viewing application. She is only interested in the portion of the image that shows the Eiffel Tower.
If that portion of the image has been defined as an area of interest, it can be given display priority so that that area
appears sooner, becoming crisp and clear before the rest of the image.

Use GeoExpress to perform color balancing operations for raster images when you select MG3, MG4, or JPEG
2000 as the output format. You can color balance 8-bit and 16-bit unsigned grayscale and RGB images. You can
also color balance mosaics and multiple images at a time. There are three types of corrections that you can
apply: uniform corrections, non-uniform corrections, and automatic corrections.

For information about color balancing and mosaics, see on page 103. For
information about color balancing many images at a time, see on page 61.

You can apply uniform corrections to single images and mosaics. Uniform corrections affect the brightness and
contrast of all pixels in the same way, so light spots will still be light and dark spots will still be dark regardless of
the corrections that you apply.

In the Uniform Corrections tab, select the bands for which you want to perform corrections and use the sliders to
adjust gamma, brightness, and contrast values.

You can apply non-uniform corrections to mosaics only. Non-uniform corrections adjust the color values of
specific portions of each mosaic tile. Use non-uniform corrections when each tile in a mosaic has similar flaws.
For example, when one side of each tile is light and the other side is dark. When you combine multiple images with
similar imperfections, the flaws become very noticeable. To correct these patterns across a mosaic, use non-
uniform corrections.

— 58—



Chapter 6: Image Manipulation

The following list describes the three types of non-uniform corrections:

« Vignette correction. Corrects color inconsistencies caused by a camera lens. Use vignette correction
when your images display a lower light intensity around their edges. The correction automatically
normalizes the highlights and dark spots across tiles to create a mosaic that appears more unified. Vignette
correction affects all the tiles in the mosaic.

« Tilt correction. Corrects bidirectional reflectance. Bidirectional reflectance describes the effect of the
angle of the sun on an image. Use tilt correction when the images in a mosaic were all taken under similar
lighting conditions. For example, yourimages may be darker on one side than the other. When you apply tilt
correction to all the tiles in a mosaic, GeoExpress matches the color levels of each tile in the mosaic. Tilt
correction affects all the selected tiles in a mosaic.

« Seam line correction. Corrects discrepancies in the edges of tiles in a mosaic. Use seam line correction
to smooth the transitions between tiles. Depending on the geometry of a given mosaic, sometimes seam
lines cannot be generated. In that case, the Apply Seam Lines option is unavailable. Seam line correction
affects all the tiles in a mosaic.

NOTE: Tilt correction is computationally intensive. If there are many tiles in the mosaic, both the preview
and the mosaic job may take more time to process.

Automatic corrections adjust the color values of multiple images or mosaic tiles to match another image.

You can apply automatic corrections to single images and mosaics. If the corrections are going to be applied to
multiple images, all the images must have the same number of output bands and the same data type. If you select
Duplicate job parameters, this also applies to the image whose color corrections you want to match.

The following list describes the automatic correction methods that you can use:

« Match tiles to each other. Mosaics only. Sets the intensity of each tile in a mosaic to match the average
of all tiles.

« Match to a selected tile. Mosaics only. Sets the intensity of the tiles that you select to match the color
levels of a source tile that you specify. To specify a source tile, select a tile in the tile list and click Set
Selected Tile As Source Tile in the Automatic Corrections panel. Then, select the tiles in the tile list to
which you want to apply the corrections and click Apply Corrections.

« Duplicate job parameters. Matches the color balancing corrections applied to another image in the Job
List. If you have not applied color balancing corrections to another job yet, GeoExpress displays a blank
pane. Use this option to quickly apply color balancing corrections to many images at a time.

« Match to histogram. Matches the histogram values of another image that you select. GeoExpress
calculates histogram values for the image that you select, including brightness, contrast, gamma, and
more, then GeoExpress attempts to apply those values to the current image.
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Performing Color Balancing for a Single Image
1. Select a single job from the Job List.

2. Click the Color Balance button H on the toolbar.

This opens the Color Balance Manager.

Bl Color Balance Manager — ] pe
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Uniform Corrections

Band Intensity ~

Min Gamma: Max:
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Brightness:

Contrast

8

Enable Live Updating

Reset All Comections

A tomatic Comections
Comection Method: | w

OK Cancel

3. From the Band drop-down list select a band or Intensity.
For grayscale images, only one band is available. Select an individual band to modify it individually or
select intensity to modify all bands.

4. Make changes to histogram values by entering new values into the Min, Max and Gamma fields, or click
and drag the slider controls below the histogram.

5. Click OK.
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To perform color balancing for many images at a time, you must first set the color balancing corrections that you
want to apply to a single image. Then, you can apply those corrections to all the remaining images.

1. Add all the images that you want to color balance to the Job List.

2. Select one of the images from the Job List.

3. Click the Color Balance button on the toolbar.

The Color Balance Manager appears.

4. From the Band drop-down list select a band or Intensity.
For grayscale images, only one band is available. Select an individual band to modify it individually or
select intensity to modify all bands.

5. Make changes to histogram values by entering new values into the Min, Max and Gamma fields, or click
and drag the slider controls below the histogram.

6. Click OK.

7. Select the remaining images that you want to color balance from the Job List. You can hold the Shift key
to select a range of images.

8. Inthe Automatic Corrections panel, select Duplicate job parameters from the drop-down.
The first image to which you applied color balancing corrections appears in a list below the drop-down.

NOTE: The list only displays images to which you have applied color balancing corrections, and
which have the same number of bands and the same data type as the images that you selected in
the Job List. Additionally, the list does not display mosaics to which you have applied corrections,
only single images.

9. Click the first image to which you applied color balancing corrections.
10. Click Apply Corrections.
11. Click OK.
12. Click a blank section in the Job List to ensure that no jobs are selected.
13. Click Run All Jobs.

GeoExpress displays the histogram for an image on the left side of the Color Balance Manager. The histogram
control enables you to adjust the minimum, maximum, and gamma values for each band in the image.

The black slider represents the minimum pixel value, the white slider represents the maximum pixel value, and the
gray slider represents the gamma value. The range of values for the minimum and maximum controls is based on
the data type of the image. For example, for 8-bit images, the range of values is 0 through 255. The maximum
value cannot be less than or equal to the minimum value.

The gamma slider is restricted to a fractional position in between the minimum and maximum sliders. The range of
gamma values is 0.102-9.99. The default value of 1.0.

The histogram controls adjust dynamically as the brightness and contrast values are changed.
To revert back to an image’s original state, removing all color corrections, click Reset All Corrections.

Below the histogram control are two slider controls for modifying the brightness and contrast of the active band of
the image. They accept integer values from -100 to 100, -100 being low brightness/contrast and 100 being high
brightness/contrast. The histogram controls adjust dynamically as the brightness and contrast are changed.
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The Enable Live Updating option controls how the preview image is updated. If Enable Live Updating is
enabled, the image will update in real time as you manipulate the slider controls. If the update performance starts
to slow down, as it may for very large mosaics, you can disable the live updating feature so that the image only
updates after a dragging operation is complete (i.e. when the mouse button is released).

The Band Selector button allows you to rearrange the red, green, and blue bands for viewing in the Color
Balance Manager. You can select one band to represent the grayscale band.

1. Inthe Color Balance Manager, click Band Selector.

This opens the Band Selector dialog.
2. Select RGB to select RGB bands or select Grayscale to select a grayscale band.
3. Click OK.

NOTE: Selecting bands in the Band Selector dialog has no effect on the order of output bands.

The Reproject tool changes the projection of an image from one coordinate reference system (CRS) to another.

A coordinate reference system defines the location of a point on a planar or spherical surface. An example familiar
to many people is a graph with x and y axes. A geographic coordinate system is a three-dimensional reference
system that locates points on the Earth’s surface based on projections. Projections are the method used to
display a spherical surface onto a flat surface. In this manner, Cartesian coordinate systems can be overlaid.

Coordinate reference systems are prearranged projections used in specific countries either in modern times orin
historical maps. However, many states and counties within a country may employ a different coordinate reference
system. These reference systems differ in order to maintain the highest accuracy in a smaller defined region.
Because they are only approximations of the shape of the Earth—which is irregularly shaped—the larger an area a
given coordinate system covers, the less accurate it will be.

An agency working on a broad area of coverage, such as statewide, will typically work in the UTM (Universal
Transverse Mercator) system, since it can be used over larger geographic areas. Organizations whose area of
interest covers a smaller geography, such as county or city level management, will typically work in a State Plane
coordinate system. This presents problems when trying to employ data from different sources for use in a single
project.

The reprojection tools in GeoExpress enable you to take images that are georeferenced in one or more coordinate
reference systems, and reproject these images to a different coordinate reference system either individually or as
amosaic. CRSs are identified by regions of use, subregions and system names as defined by the European
Petroleum Survey Group (EPSG). You can also use well-known text strings (WKTSs).

You can repurpose and combine diverse data sets by using the GeoExpress reprojection tools when you create a
new image or by reprojecting your existing images. With support for over 2,500 WKT (well-known text) coordinate
systems such as State Plane Coordinate Systems and UTM—as well as hundreds of specific regional
projections—GeoExpress enables geospatial professionals to share imagery across boundaries previously
imposed by disparate coordinate reference systems.
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As an example, say you have a shapefile using a coordinate reference system of Latitude/Longitude, WGS84,
while the raw imagery you purchased from an image data provider is created in UTM, NAD83, Zone 18N. Using
the reprojection feature in GeoExpress, you are able to reproject the raw imagery to the Lat-Long coordinate
reference system while converting it to MG3, MG4 or JP2 format within your normal encoding workflow.

MAD B3TM Lat-Long WG Sa4
Zane 1 8M{26918)

NOTE: Reprojection necessarily involves encoding since pixel data cannot be altered in compressed
wavelet space.

Reprojecting an Image

To reproject animage, you must set a CRS for the source image and for the output image. You can reproject

images to the MrSID Generation 4 (MG4), MrSID Generation 3 (MG3), JPEG 2000, and NITF 2.1 output formats.
1. Click the Reproject button @ on the toolbar.

This opens the Reprojection Manager dialog.

2. Select the Reproject Image option.

3. Ifthe source image has a known CRS, then that CRS is displayed. Otherwise, click Select Coordinate
Reference System in the Source Image panel to select a source CRS.

4. To set the projection for the output image, click Select Coordinate Reference System in the Output
Image panel.

5. Optionally, click Advanced Options to set additional reprojection options.

6. Click OK.

NOTE: When you reproject an image, you affect the image’s pixel data. As a result, you should always

reproject an image before you perform other image manipulation operations, especially cropping or defining
an area of interest.

—63—



GeoExpress 9.5 User Manual

Select the coordinate reference system by typing any part of it in the System field, such as the name of the state
(“Utah”) or an EPSG number (“4326”) and then choose from the CRSs that appear as you type. You can also
select one of the CRSs you use most often by choosing it from the Recently Used Systems drop-down menu.

If a particular EPSG code is not available in the System field, select Use Custom WKT and select an option from
the Select WKT drop-down list. If you've already created and saved a custom well-known text string (WKT), you
can choose it from this list. Otherwise, select Add a new WKT to create a new custom WKT that describes the
CRS. You can paste a WKT string in the WKT field, or you can use a text file or Esri CRS file (* . prj) as input by
clicking Browse.

NOTE: For information on how to create a WKT, see the Open Geospatial Consortium (OGC) spec # 01-
009 at http://www.geoapi.org/3.0/javadoc/org/opengis/referencing/doc-files/WKT. html. For a listing of
common WKT strings, see http.//www.spatialreference.org/.

1. Access the Coordinate Reference System Selector as described above.

2. Select Use Custom WKT.

3. Select a WKT from the Select WKT drop-down list and click Edit WKT.
This opens the Edit User Defined WKT dialog.

4. Make changes to the text string and click OK.

1. Access the Coordinate Reference System Selector as described above.

2. Select Use Custom WKT.

3. Select the WKT from the Select WKT drop-down list and click Edit WKT.
The Edit User Defined WKT dialog opens.

4. Click Delete this WKT, then click OK.

To specify the output resolution of the reprojected image, select Set output resolution and enter the x and y
values in the edit fields. If this option is disabled, GeoExpress calculates the output resolution when it performs
the reprojection.

WARNING: This parameter has been made configurable in the event that experienced users require
adjustments. However, adjusting the output resolution can have far-reaching effects and it is
recommended that you allow GeoExpress to calculate it for you.

WARNING: If you set the resolution manually and notice that the image is offset, select Align pixels
with output resolution. This option aligns the output image to an integer multiple of the output resolution.

The error fraction is a value from 0.0 to 1.0 that indicates the level of accuracy of the reprojection. A value of 0.0 is
the highest level of accuracy—essentially a “lossless” reprojection. An error fraction of 0.125 means that each
reprojected pixel could be off by an eighth of a pixel, while a value of 0.25 indicates a quarter-pixel inaccuracy.
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Block values tell the encoder to reproject the pixels in blocks of dimensions the user may specify. (Note: These
blocks are different from both the MG2 and the MG3/MG4 encoding blocks.) Using block values improves disk
access and memory usage and can improve performance. Smaller block values use less memory but may be
slower. Block values do not affect the output image.

By default the block value is 2048.

The Resample Method drop-down list shows the available resampling methods for the reprojection operation.
Nearest Neighbor is the fastest method, while Bicubic gives more accurate results. Bilinear is a compromise—
faster than Bicubic and more accurate than Nearest Neighbor.

If you enable the Use Temp Files option, the encoder caches the reprojection processing blocks to disk in the
form of a temp file instead of keeping them in RAM.

This option is enabled by default.

NOTE: The process of rendering previews for very large images or mosaics can be time consuming,
especially when reprojecting mosaicked images in different resolutions and coordinate systems.
Previewing does not decrement the data cartridge.

A user has a set of 500 images in TIFF format with TIFF world files and wants to put each single image into a new
coordinate system and encode to MrSID at the same time. The user adds the images into the Job list.
GeoExpress knows where they are located (due to the world files) but knows nothing about the coordinate
reference system (CRS). The user assigns a coordinate system to the source images to be used as a source
CRS. The user can select multiple files and apply the CRS once to all of the source data. Then the user selects
the destination CRS that will apply to all images in the current selection. The user specifies other compression
parameters independent of the reprojection option, then encodes the images normally.

Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID Generation 2 images with
sdw files.

Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID files with embedded
GeoTIFF tags. GeoExpress automatically reads those GeoTIFF tags to determine the source coordinate system.

Same as “Reprojection of Single TIFF Images” above, except that the user has GeoTIFF files. GeoExpress

automatically reads the CRS and assigns it as a source CRS.

The user is a provider who has many GeoTIFF images in the same CRS (UTM). The user wants to mosaic these
together and reproject them to the State Plane system. In this instance GeoExpress reads the CRS from the
images and mosaic prior to reprojection to ensure a seamless mosaic.
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A city government has received images in UTM from the NAIP program, has existing imagery in state plane
coordinate system and has purchased satellite imagery in lat-long. The imagery from NAIP is a one-foot-pixel, the
city’s imagery is a half-foot pixel and the satellite imagery is a five-meter pixel. The NAIP imagery is in MrSI1D
format, the city’s data is in GeoTIFF and the satellite imagery is in TIFF with TIFF world files. This user can create
a single MrSID mosaic in State Plane coordinates from all three sources of imagery in one single encode
operation.
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Job Options Overview

Click Job Options on the Properties tab to access options for a job. The job options depend on whether the
selected job is a raster job or a mosaic job.

Raster Job Options

The following list describes some of the options that you can set for raster images and mosaics:
« Select an output destination.
« Select an output format and compression method.
« Select custom dimensions and resolution.
« Select tiling options.

NOTE: For rasterimages, you can also click Advanced on the Properties tab to set additional options.
Forexample, you can use the advanced options to select a color space, edit transparency values, and
more. For more information on advanced job options, see Advanced Job Options Overview on page 71.

Destination Options
Use the Destination tab to save output files to a file on your computer or to an Express Server. You can only save
MrSID and JPEG 2000 images to Express Server.
To select an output destination:
1. Select one or more jobs in the Job List.
2. Click Properties to view the Properties tab.
3. Enter afile path in the output destination field, or click Job Options and select Publish to Express
Server.

Selecting an Output File
By default, the output directory is the same as the input directory.

To change the default output directory, see Preferences on page 109.

Selecting an Express Server
GeoExpress 9.5 supports Express Server version 6.0 and later. You can save images in the following output
formats to an Express Server:

« MrSID Generation 4

o MrSID Generation 3

« MrSID Generation 2

« JPEG 2000 (Part 1)

« JPEG 2000 (GMLJP2)
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If you select Publish to Express Server on the Job Options dialog, you must still specify a file path on the
Destination tab. GeoExpress uses the directory that you specify as a temporary directory where it saves the
output file before publishing to Express Server.
When you select Express Server as the output destination, the Express Server Browser opens.
1. Inthe Express Server Browser, enter the URL of the Express Server where you want to save files. You
can also click the drop-down box to view the list of Express Servers to which you have recently connected.
2. Click Connect.

NOTE: The server is queried for a list of catalogs on the server. Catalogs that have a spatial index

appear with the world map icon 8l and the EPSG code of the spatial index. If there are no catalogs
on the Express Server, contact the server administrator.

3. If the Express Server requires authentication, it will prompt you to enter your user name and password.
Enter them, then click OK.
4. Select the catalog to which you want to save your files.

NOTE: The output images that you create must use the same spatial reference system as the
target catalog.

5. Optionally, select Replace existing files to overwrite files in the catalog that have the same name.
If files with the same name exist and this option is not selected, the upload fails and reports that the file
exists.

6. Click OK.

Use the Format and Compression tab to select an output format and compression method.

For more information about output formats, see on page 27. For more information about
compression, see on page 32.

Use the Dimensions and Resolution tab to change the dimensions of animage or select a custom resolution.
You can select from the following dimensions:

« Full resolution. Use the native resolution of the input image. This option is the default.

« Print. Scale the image so that the resolution matches that of a typical printer.

o Medium. Scale the image to either 2048 pixels wide or 2048 pixels high depending on the orientation.

« Web. Scale the image to either 512 pixels wide or 512 pixels high depending on the orientation.

« Custom. Enter a custom width and height, or enter a custom resolution.

Use the Tiling tab to break the output image into multiple tiles.
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The following list describes the tiling options that you can select:

« No tiling. Create a single output image. This option is the default.

« Number of tiles. Break an image into a number of columns and rows that you specify. For example, if you
select four columns and three rows, the job creates 12 images.

« Tile by units. Break an image into tiles based on the geospatial units of the image. For example, if the
image is in a UTM projection, the unit is meters and you can create tiles 1000 meters wide by 1000 meters
high.

« Tile by pixel area. Break an image into tiles such that each tile has the width and height that you specify.
For example, you may want to create square tiles that are 2048 by 2048 pixels.

Some of the options that you can set for LIDAR images and mosaics include:
« Enter a custom block size.
o Omit LAS variable length record (VLR) metadata.
« Column mapping options for text files.

Use the Compression tab to change the block size and remove variable length record (VLR) metadata from

LAS files.

The block size is the number of points that GeoExpress processes and stores at one time. Enter a large block size
to increase compression speed. Enter a small block size to decrease memory usage. Valid values are from 2048
to 16384. The default value is 4096.

If you select the Omit Custom LAS VLR metadata option, GeoExpress removes VLR metadata from LAS files.
VLR metadata can include vendor-specific data, user-specified data, and more.

Use the Text Parsing tab of the Job Options dialog to map text file columns to standard or custom fields and to
load the whole text file. GeoExpress prompts you to set these options automatically when you add a LIDAR text
file. At a minimum, you must map the X, Y, and Z columns of afile.

LAS files often contain header lines with the names of the columns and additional information. Enter the number of
header lines are in the file so that GeoExpress does not attempt to read those lines as valid values.

Use the drop-down boxes for each column to map values to standard fields like X, Y, Z, Intensity, and more.

Create, edit, and delete custom fields that you want to map to columns. For example, you may want to create
fields for a custom GPS time format or for sensor information.

When a job is run, each number in the data columns is represented by an offset and the default precision factor of
0.001. The Precision factor fields enable you to change the factor by which the data in any or all three axis
columns will be represented to account for the number of significant decimal places in those columns.

If you select this option, GeoExpress reads the whole text file to determine image properties like the extents. You
must select this option if you want to preview the LiDAR point cloud.
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Column Mapping Prompt
Select the Prompt me to map columns every time option to display these text parsing options every time that a

text file is added.
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Advanced Job Options Overview

For raster images, you can click the Advanced button on the Properties tab to select additional job options.

The following table describes some of the tasks that you can perform in each tab of the Advanced Job Options

dialog.
TAB TASKS

Input « Change the name of the selected job

« Use world file and aux.xml files to override the georeferencing information in the selected
image

« Apply image rotation from the image metadata
« Apply NITF RPC from the metadata

Output « Create a testoutputimage
« Convertimages to 8-bit
« Seta custom watermark for the selected image
« Create a shapefile representing the tiles used in a raster mosaic
« Crop a DOQ image with corner cross points
« Flatten a composite mosaic
« Enable multiresolution mosaics
« Enable mosaics with multiple coordinate reference systems
« Enable multiple image segments for NITF images

Bands « Selecta color space for the image
« Selectand map bands for the image

Zoom « Setthe number of zoom levels in the outputimage
« Specify a target thumbnail size
« Resample the image

Alpha « Specify transparency values for MrSID Generation 4 (MG4) files
« Create orregenerate an alpha band

Transparency « Specify transparency values for JPEG 2000, MrSID Generation 2 (MG2), and MrSID

Generation 3 (MG3) files

Quanitization « Enter quantization options for floating pointimages
Quantization is the compression method for floating pointimages.

Security « Setpassword protection for MG2 and MG3 images

Format-Specific « Configure image encoding performance by changing the block size or strip height
« Configure the display of an image by changing the weight values and sharpness
« Generate dynamic range metadata
« Selectand edit JPEG 2000 profiles
For more information, see Format-Specific Options Overview on page 85.

NOTE: The options available in the Advanced Job Options dialog depend on the output format that you

select.
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The Input tab contains four panels: Job Name, Override Georeferencing, Apply Metadata to Image, and
Input Image.

;ﬁ Advanced Job Options =

Input  Output Bands Zoom AMpha  Quantization Fommat-Specific

Job Name: ‘Mng_Coumy.sid ‘

(Ovemide Georsferencing Apply Metadata to Image
[ Use World Files [ NITF RPC
[ Use Aucsml Image Rotation

Input Image

Input Type: Single image

Input files:

X:MRaster'King County\King_Courty sid ‘

Carsl

Use the Job Name panel to change the name displayed in the Job List.

Use the Override Georeferencing panel to override a file’s native georeferencing information with information
from another file. The other file can be a world file or an aux . xm1 file included in the same directory as the image.
When georeferencing information for an image or mosaic tile is given in the form of a world file or aux . xm1 file,
GeoExpress can use that information to override the file’s native georeferencing. For more information on world
files, see on page 123.

Use the Apply Metadata to Image panel to change the output image based on information in the image metadata.
There are two types of metadata that you can apply: NITF RPC metadata and image rotation metadata. NITF
RPC metadata maps pixel data to location data for orthorectification. Image rotation metadata describes how to
rotate the output image.

The Input Image panel identifies whether the input image is a single image, a mosaic, or a color composite image,
and lists the input file or files. Note that the job name can be different from the input file name and the output file
name. Also the job name is different from the project name that is displayed in the blue bar at the top of the screen
in the work area.

Set options for the output image in the Output tab. The options that you see depend on the job type and the output
format.

Ef Advanced Job Optians ¥

Input  Output Bands Zoom Tramsparency Securty Format-Speciic
Output Options

[] Encode As Test Image Convert To Bbit Data
[] Watermaric Browse
Generate shapefile representing seamlines

Primary Comer Cross Disabled

Flatten Options
Create Flattened Mosaic

oK Cancel
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Test Image Option

For raster images, you can create test images to test an image manipulation or compression operation without
using data from the data cartridge. Test images are output images that have a visible watermark. You can create
images and mosaics as test images, but not LIDAR point clouds.

8-Bit Data Option

Converting unsigned 16-bit data to unsigned 8-bit data during encoding.

Watermark Option
You can add custom watermarks to your images. GeoExpress supports black and white watermark images in
BMP, PNG, and JPEG formats.

Click the Browse button to select the image that you want to use as a watermark. The following figure shows an
example of a watermarked image:

NiRR T

LT LT LT

LT LT

NOTE: In versions of GeoExpress before v9.5.3, watermark images were limited to 128 x 128 pixels in
size. Watermarks must be no wider and no taller than the output image.

Seamlines Shapefile

You can choose to generate a shapefile that shows the tiles that make up a raster mosaic output.

If you create a raster mosaic, select this option to include a shapefile in the output. When viewed with the
appropriate program (such as GeoViewer), the shapefile will overlay the output image to indicate where each tile in
the image is located.

USGS DOQ Cropping Option

If the job contains DOQ images, the USGS DOQ Cropping panel will be available. Cropping is either by corner
cross or disabled.
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To flatten a composite mosaic, select the Create Flattened Mosaic option. When you flatten a mosaic that
contains overlapping tiles, you discard the data from tiles that are not visible. For more information on composite
mosaics, see on page 98.

When you flatten a mosaic, the Flatten Tile Size field is available. GeoExpress divides mosaics that are to be
flattened into tiles for encoding. Acceptable values are integers between 1024 and 4096, and powers of two (1024,
2048 and 4096) are recommended though not required. The default tile size is 2048.

NOTE: You may encounter irregularities in the progress meter when flattening mosaics.

Use the Bands tab to select a color space for the output image and to select and map bands.

NOTE: For MG3 and MG4 files, the output color space is only supported for encoding single images and
flat image mosaics.

B8 Advanced Job Options >

Input  Output ;Bandsj Zoom  Alpha Quartization Format-Specific

Mumber of Mon-Alpha Input Bands: 3
Output Color Space

Color Space: Same as source

QK Cancel

The options available in this group depend on which color space you choose from the drop-down menu. For
grayscale or RGB output, another drop-down menu enables you to select a single band or three bands,
respectively. For multispectral output, the Select Bands button appears enabling you to access a dialog where
you can select bands from your input image and order them for your output image. The default color space is
Same as source. For more information on selecting bands, see on the facing page.

The MrSID Generation 4 (MG4) format supports multispectral color spaces, but to output a multispectral image to
MG2 or MG3 format, you need to select an output color space of grayscale, RGB, or CMYK, and map bands to the
selected space.

For multispectral images, select Apply RGB Color Transform to First Three Bands if the first three bands in
your output list are Red, Green, and Blue in that order. (This option is enabled by default.)

If the first three bands are not Red, Green, and Blue, click the Select Bands button to re-order the bands. For
more information on the RGB color transform, see on page 34.
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The following table shows supported output MrSID color spaces for various input and output formats:

COLOR SPACE OF SOURCE SUPPORTED JPEG 2000
IMAGE SUPPORTED MRSID OUTPUT OUTPUT
Grayscale Grayscale Grayscale
RGB RGB, Grayscale RGB, Grayscale
CMYK CMYK, Grayscale —
Multispectral RGB, Grayscale, CMYK, RGB, Grayscale, Multispectral
Multispectral

For multibanded output to MG4 and JPEG 2000, additional options on the Color Space drop-down are available,
most notably that a multispectral input image can use Same as source for the output color space.

NOTE: GeoExpress does not support the CMYK color space for JPEG 2000 images, either as input or
output. For source images that are CMYK, the only supported output color space for JPEG 2000 encoding
is grayscale. The preview input image color space controls remain the same.

With multispectral image support, it becomes necessary to provide color space control over the input and output
images so that they can be viewed by human eyes. The Output Color Space control shows a list of supported
output color spaces for the currently selected output format. The supported output color spaces for MrSID
Generation 3 (MG3) are grayscale, RGB, and CMYK. If the input image is already in one of the supported color
spaces, Same as source will also be an available option. By selecting an output color space other than Same as
source, a group of band selectors will become visible, allowing the user to choose which input bands map to the
output color space. If you chose RGB as your output color space, three controls would appear for choosing the
red, green, and blue component bands of the output image. Then you could choose which bands of the source
image were most interesting or important to you, for example bands 1, 3, and 5.

If you want to encode a six-banded image to MrSID format, you should select MG4 as your output format.

For raster multispectral images, you can select and map image bands from a source image to a MrSID or
JPEG 2000 output image. Not all workflows are available for all output formats.

The following table shows which workflows each format supports.

SUPPORTED BY OUTPUT
FORMAT
JPEG
WORKFLOW MG2 MG3 MG4 2000
Choose one band from an RGB or multispectral source to represent the single [ [ [ [
output (grayscale) band
Map any 3 bands from an RGB or multispectral source to the Red, Green, and L L L [
Blue output bands
Choose to carry over all source bands to your outputimage in their original L] [
order
Map an arbitrary subset of bands (more than 3) from a multispectral image to n
your outputimage, in any order

By default, GeoExpress retains all source bands in order.
The following procedures assume you have loaded one or more images into the Job List.
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You can select a single band for MrSID or JPEG 2000 output.

1. Select a MrSID or JPEG 2000 format from the Output Format drop-down menu.
2. Click the Advanced button in the Properties tab.
This opens the Advanced Job Options dialog.
3. Select the Bands tab.
4. Choose Grayscale from the Color Space drop-down menu.
A drop-down menu appears listing all the available bands in the source image.
5. Choose any single band from the drop-down menu.
6. Set other options on this tab, then click OK.

You can select and map bands for RGB output in MG3, MG4, or JPEG 2000 format.

1. Select a MrSID or JPEG 2000 format from the Output Format drop-down menu.

2. Click the Advanced button in the Properties tab.
This opens the Advanced Job Options dialog.

3. Select the Bands tab.

4. From the Color Space drop-down menu choose RGB. Several drop-down menus appear listing all the
available bands in the source image.

5. Choose any three bands from the drop-down menus.

6. Click OK.

You can carry over all source bands to MG4 or JPEG 2000 output formats in their original order.

1. Select MrSID Generation 4 or JPEG 2000 from the Output Format drop-down menu.
2. Click the Advanced button in the Properties tab.
This opens the Advanced Job Options dialog.
3. Select the Bands tab.
From the Color Space drop-down menu choose Same as source.
5. Set other options on this tab, then click OK.

>
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You can select and map more than three bands for MG4 output.

1. Select MrSID Generation 4 from the Output Format drop-down menu.

2. Click the Advanced button in the Properties tab.
This opens the Advanced Job Options dialog.

3. Select the Bands tab.

4. From the Color Space drop-down menu choose Multispectral, then click Select Bands.
This opens the Select Bands dialog. By default, all bands are carried over from the input list to the output
list.

NOTE: The Alpha band is encoded losslessly and is not displayed in the list of bands. For more

information on Alpha bands in MrSID images, see on page 79. For more information
about Alpha bands in JPEG 2000 imagery, see on
page 127.

5. If the image contains red, green, and blue (RGB) bands, re-order the bands with the up and down arrows so
that these bands are at the top of the bands list, then select the option to Apply RGB Color Transform to
First Three Bands.

IMPORTANT: When you set the first three bands of the image as the RGB bands and apply the
RGB Color Transform, GeoExpress optimizes the image compression ratio of each one of the RGB
bands to create a smaller image without sacrificing visual quality.

For more information on the RGB color transform, see on page 34.
This option is enabled by default for multispectral images.

6. Optionally, select the bands that you want to remove from the output image and click the left arrow to
remove them.

7. Click OK.

NOTE: For information on setting per-band compression ratios, see
on page 33.

Use the Zoom tab to select the number of zoom levels that you want in the output image or to specify a target
thumbnail size. For an MG3 or MG4 file you can also resample the image.

B8 Advanced Job Options X
Input  Output  Bands ZDDFH Apha  Quantization —Fomat-Specific

Zoom Levels

(O Number Of Zoom Levels

(® Target Thumbniail Size pixels

(O Use Maximum Zoom Levels For Image

Resample image

OK Cancel

77—



GeoExpress 9.5 User Manual

The number of zoom levels in an encoded image can be specified directly or it can be dependent on the image size
in relation to a specified target thumbnail size. The larger the image, the greater the number of zoom levels it can
contain.

By default, GeoExpress does not specify the number of zoom levels but uses a thumbnail size of 32 pixels
instead. You may specify a higher value here, resulting in fewer zoom levels, or a lower value, resulting in more.
You can also specify a number of zoom levels or instruct the program to use the maximum number of zoom levels
the image can contain.

To specify the number of zoom levels, select Number of Zoom Levels and drag the slider or enter the number of
levels in the Zoom Level field.

Picture the encoded image as a pyramid, with each zoom level being sliced from the pyramid. The base of the
pyramid is level 0, the maximum resolution. Level 1 is half the size of level 0 with a preview image that has one
quarter the resolution of level 0. Level 2 is half the size of level 1, and so on to the final level, whose smallest
dimension is 2 pixels.

Zoom level can be set to any value greater than zero for MG3 and MG4 and from 3 through 9 levels for MG2.

NOTE: The full resolution (or base) image is called the zeroth level (Oth level) and is not counted as one of
the zoom levels. For example, setting the zoom level at 3 will result in three additional resolutions besides
the base level. Setting the number of zoom levels to 0 will yield an output image with the maximum number
of zoom levels (the same as moving the Zoom Levels slider all the way to the right, or selecting the Use
Maximum Zoom Levels option.

To specify the target thumbnail size, select Target Thumbnail Size and enter a dimension in pixels.

To allow GeoExpress to automatically calculate and use the maximum number of zoom levels possible for an
image, select Use Maximum Zoom Levels for Image.

Resample an image to reduce the number of zoom levels in an MG3 or MG4 image. You might resample an image
for placement in an online catalog where you know it will only be displayed at a certain maximum size.

The resampling operation copies zoom levels from an existing image to make a new image. As aresult, you can
only resample images that meet the following criteria:

« Theimage must be in the MG3 or MG4 format.

« The output format for the image must be the same as the input format. For example, for an MG3 input
image, you can only create a resampled MG3 output image.

« Theimage must have been created as an optimizable image. By default, MG3 and MG4 images are
optimizable.

« The resampling operation cannot be combined with other image manipulation operations that require
decoding the image data. For example, you cannot perform reprojection or color balancing operations in the
same job as a resampling operation. Instead, resample the image, run the job, and then perform additional
operations on the new image.

To resample an image, complete the following steps:
1. Click Advanced in the Properties tab.
2. Click the Zoom tab.
3. Select the Resample image option and select the factor by which you want to reduce the level of detail.

Resampling by a factor of two removes one zoom level and halves the image’s width and height so that the result
has a fourth of the area of the original. Resampling by a factor of four removes two zoom levels and quarters the
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image’s width and height so that the result has one sixteenth of the area of the original. The number of resampling
factors available in the drop-down menu is determined by the size of the original image.

When you select MG4 as the image output format, you can use the Alpha tab to create or regenerate alpha bands.
In MG4 images, the alpha band records which portions of your image do not contain image data.

For MG2, MG3, and JPEG 2000 files you can specify no-data values in the Transparency tab.

ER Advanced Job Options %

Input  Output Bands Zoom

{ Quantization Format-Specific
Alpha Source when input image has no Alpha

(® Opaque [] Despeckde Output
(O Transparency Value (metadatz) Despeckling Options...
(O Specify Value

Band Value

Red ]

Green o

Blue o

Apply to selected Apply to all

Color Picker...

OK Cancel

All images encoded to MrSID Generation 4 (MG4) have an alpha channel or alpha band. If one is present,
GeoExpress uses the alpha band in the input image. If no alpha band is present in the input image, then
GeoExpress creates one.

The alpha band is always encoded losslessly, even if the rest of the image undergoes lossy compression.

MG2 and MG3 do not support alpha channels, but the transparency information in the alpha band of your source
image is still preserved when encoding to MG2 and MG3. The alpha band will first be applied to the source image
and then discarded from the output file.

1:5@0,6:8@255
REMAINDER@O
1:255@0

1@127, REMAINDER@1

NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does not additionally
decrement your data cartridge. Your encode job will be metered the same with or without alpha bands.
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All'images encoded to MrSID Generation 4 have an alpha band.

1. Click Advanced in the Properties tab.
2. Click the Alphatab.
3. Select the method that you want to use to create an alpha band.
= Opaque. The Opaque method specifies that all pixels should be treated as valid image data.
= Transparency Value (metadata). Using this method, GeoExpress queries the image metadata for
the transparency values and treats all pixels with matching band color values as transparent. This is
the default.
m Specify Value. You may specify transparency values for each band. GeoExpress treats as
transparent all pixels whose band color values match the specified values. If you decide to specify a
value for each band, you can use the color picker.

If your source image already has an alpha band, you can select Regenerate Alpha Band to discard the existing
alpha band. By default, GeoExpress uses and preserves a source image’s alpha band. This option might be used
if your alpha band is corrupted or incorrect, in which case GeoExpress creates a new one.

Skip to on page 28.

Speckling is an artifact of lossy compression that causes pixels which should be transparent to display in the
output.

For example, you may specify 0,0,0 as the alpha band values for an RGB image so that all of the black pixels are
made transparent. But in compression, the values of some pixels undergo slight changes in value. The difference
is not be visible to the eye, but a pixel whose RGB values are 0,1,0 or 0,0,1, while it may still look black, no longer
matches the specified transparency profile and so it will not be rendered transparent. Where this happens,
speckling can appear in the collar regions of an image such as a DOQQ. In this case, select Despeckle Output to
ensure that all of the pixels that should be transparent are treated correctly.

For more information and to manually set despeckling options, see on page 46.
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When you select MG2, MG3, or JPEG 2000 as the image output format, you can use the options on the
Transparency tab to define the color of transparency and background areas. One color must serve for both the
transparency and background values.

You can specify colors based on the color space (RGB/grayscale) and color depth (8-bit/16-bit) of the source
image.

Bf Advanced Job Options X
Input  Output Bands Zoom Transparency Securty Format-Specific

Transparency and Background

Set transparency {no-data) and background values

Band Value
Red 0

Green o
Blue 0
Apply to selected Apply to all

Color Picker...

oK Cancel

The transparency and background color setting must be within the range of pixel values that the image’s data type
supports (e.g. 0—255 for 8-bit images and 0—65,535 for 16-bit images). These values are derived from the native
metadata for an input image.
To select an alternate transparency and background color do one of the following:
« Enter RGB values for each band using the Edit Value field. Values can be assigned to single or multiple
bands.
« Select a color using the Color Picker.

The effects of the transparency options can be simulated in the Preview tab.

NOTE: The MG4 format stores transparency in an alpha band whereas MG3, MG2, and JPEG 2000
images map transparency to a specific color. If your input image is in the MG4 format, and if the output
format is MG3, MG2, or JPEG 2000, transparency is mapped to the transparency color that you specify.

You can select an 8-bit RGB color value from the color palette or Color Picker if the source image is an 8-bit
RGB.
1. Click Color Picker. The Color dialog displays 48 color options, including black and white. You can add
custom colors to the existing basic colors palette.
2. Select the proper color from the displayed palette.
3. Click OK.

GeoExpress uses the standard Windows color picker interface, which allows you to add custom colors. See your
Microsoft Windows or Microsoft Office documentation for more information about picking colors.
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Specifying a Transparency Value in Indexed Color Images

All'images in the MrSID format are in either grayscale or RGB mode. Colorimages are RGB; black-and-white
images are grayscale. Any black-and-white image encoded by GeoExpress, if not already in grayscale mode, is
converted to grayscale; any color image, if not already RGB (for instance, an indexed colorimage), is converted to
RGB.

To specify a transparency pixel value, determine the RGB value of the transparency area in the source image.
Most commonly, this will be black (0-0-0) or white (255-255-255). If desired, use a color-finder program to read the
transparency RGB values. Once the RGB values for the transparency area have been determined, they must be
entered manually.

The RGB color scale for an 8-bit image, with values of 0-255 for the colors red, green, and blue, is capable of
accurately displaying 16,777,216 colors. An indexed color image selects colors from a scale containing 256
colors. Each colorin an indexed color image is specified using a value from 0 to 255.

Due to the wide variety of indexed-color valuing systems available, a specific color in one indexed color image can
be given one value, while the same color in another image is given a different value. For example, a color with a
single RGB value may be given an indexed color value of 120 by one imaging application and 142 by another.

For this reason, any time the input or output transparency options are used with indexed color images, the indexed
color values must be read in as RGB and entered manually.

If desired, use a color-finder program to read the transparency RGB values.

Quantization Options

When you select MG4 as the output format for a floating point image, you can use the options on the Quantization
tab to define a quantization precision value and other quantization options.

NOTE: The No-Data value will be rounded to six decimal digits for display purposes, but calculations are
performed using the full precision value.

For more information on quantization, see Using Quantization for Floating Point on page 35.

B3 Advanced Job Options X
Input  Output Bands Zoom Apha Quantization  Format-Specific
Quantization when input image is floating point type

Band Precigion  Mo-Data  Min Max

Band 1 Auto Mot Set Auto Auto

Band 2 Auto Mot Set Auto Auto

Band 3 Auto Mot Set Auto Auto

Band 4 Auto Mot Set Auto Auto

Precision No-Data Min Manc

[Auto | [Mot Set | [Auto | [Auto

Apply to selected Apply to all Reset all bands
OK Cancel
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When you compress a floating point image, GeoExpress automatically calculates the optimized precision value to
use for quantization. Alteratively, you can manually specify a precision value.

The pixel values of the compressed output image are accurate to within half of the precision value. For example,
there is a pixel in your floating point image that has a value of 3000. If you specify a precision value of 0.5, then the
same pixel after quantization will have a value between 2999.75 and 3000.25.

As a rule of thumb, you can calculate the optimized precision value used by GeoExpress with the following
formula:
Precision = (Maximum value - Minimum value) / 216

Whether you manually specify a precision value or allow GeoExpress to automatically calculate a precision value,
GeoExpress records the precision value used during quantization in the image metadata. The precision value for
each image band is stored in the IMAGE : : QUANTIZATION_SCALE metadata tag. The tag lists the precision
value used for each band of the image, including the alpha band. The last value in the metadata tag is for the alpha
band precision value.

TIP: Open the output image in GeoExpress to view the image metadata. For more information, see
on page 38.

To set a precision value, enter a value in the Precision field of the Quantization tab. The precision value that you
enter depends on the range of values in the input image.

You can specify one quantization precision value for all the bands in an image, or you can specify individual
precision values for each band.

In addition to the quantization precision value, you can specify the range of values that you want GeoExpress to
keep during quantization.

If the input image contains minimum or maximum values that are far removed from the rest of the pixel values,
then you may want to manually specify minimum and maximum values. For example, if the input image contains a
maximum value of 32,000, but does not contain any pixel values between 20,000 and 32,000, then you may want
to specify a maximum value of 20,000. In this example, GeoExpress changes all pixel values greater than 20,000
to 20,000. If you manually constrain the quantization range, you can improve the appearance of images that have
very little data near the minimum and maximum values.

To specify a range of values for quantization, enter minimum and maximum values on the Quantization tab. You
can specify one minimum and one maximum value for all the bands in an image, or you can specify individual
values for each band.

Many floating point images denote no-data values as an arbitrary minimum value. For example, an image may use
-9999 as the no-data value even though there aren’t any pixel values between -9999 and 0.

Such large gaps in pixel values create an artificially wide dynamic range that may cause output images to appear
dark. For more information on dynamic range, see on page 87. To ensure
that output images display correctly, ensure that the no-data value is specified in the metadata before you
compress the image. If the no-data value is not in the metadata, you can manually specify the no-data value in the
No-Data field of the Quantization tab.
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GeoExpress enables you to lock your encoded MG2 and MG3 files with a password. MG4 does not support
security options.

BR Advanced Job Options X
Input  Output Bands Zoom Transparency Securty  Fommat-Specific

Password Protection

Protect encoded image with password Hide typing

Confim Password: l:l

oK Cancel

The Security tab provides the Protect encoded image with a password option. If you enable password
protection, you can then choose whether or not to show the password with the Hide typing option.

There is no way to access a password-protected file if you forget the password.

The password file is kept in the project file and stays with the project. Although a useful data protection feature,
this is not a fully robust file security solution.

GeoExpress does not allow password-protected files to be used as input.

Only image data is encrypted; geocoordinates and other metadata are still accessible in password-protected files.
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Format-Specific Options Overview
To perform tasks specific to the MrSID and JPEG 2000 file formats, configure options on the Format-Specific tab
of the Advanced Job Options dialog.
Use these advanced format-specific options to perform the following tasks:
« Configure performance by changing the block size or strip height.
« Configure the display of an image by changing the weight values and sharpness.
« Generate dynamic range metadata for MrSID Generation 4 output images.
« Select and edit JPEG 2000 profiles.

For MrSID images, you can select different options for MrSID Generation 4, MrSID Generation 3, and
MrSID Generation 2 files.

NOTE: The options that you can see depend on the output format that you select.

Advanced MG4 Options

You can use the options for the MG4 output format to configure the display of an image, configure performance,
and generate dynamic range metadata.

The following figure displays the options that you can select for the MG4 output format:

Bfl Advanced Job Options X
Imput  Output Bands Zoom  Alpha Quartization ]

MrSID Generation 4

Weight: Shampness: D

Block Size:
Frequency Balance: Strip Height:
Optimizable
Estimated Memory Usage: 4465 MB
[Chynamic Range Metadata Generation
None
oK Cancel

NOTE: Since MrSID Generation 4 does not support CMYK content, the K-Weight option will not be
enabled for MG4 output.
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The Weight setting is treated the same for MG2, MG3, and MG4 outputs.

Weight affects the grayscale portion of a colorimage, which is the part of the image with no color information. A
higher weight setting increases the emphasis on this grayscale aspect of a colorimage, while decreasing
emphasis on color quality. A lower setting increases the consistency of color between the MrSID image and the
original data.

Images with high color contrast will benefit from a lower weight setting. Images with greater detail benefit from a
higher weight setting.

Acceptable values: 0.0-10.0
Default: 2

The Frequency Balance setting is the same for MG3 and MG4 output.

Determines the emphasis given to edges and flat areas in color and grayscale images. Images requiring precise
edge definition will benefit from a lower setting. If precise edges are not as important as consistency in flat color
areas, increase this setting. The practical range of values is 0.1 to 10 where 0.1 represents maximum edge
definition with less emphasis on flat areas, and 10 represents minimum edge definition with smoother areas of
relatively consistent color.

Acceptable values: 0.0-10.0

Default: 2

Sharpness is the same for MG3 and MG4 outputs.

Determines the sharpness of boundaries between different areas of an image. Images with large amounts of
textured area (where color or intensity changes are occurring throughout a region, rather than just at a boundary)
will benefit from a lower setting. Use a higher setting for images with little textured areas. The range of values is
0.0to 1.0 where 0.0 represents minimum sharpness and 1.0 represents maximum sharpness.

Acceptable values: 0.0-1.0
Default: 0.0

Block Size is the same for MG3 and MG4 outputs.

GeoExpress accesses image data in “blocks” of pixels.
IMPORTANT: Blocks in MG3 and MG4 encoding are different from blocks in MG2 encoding. The block
size parameter in MG3 controls how large the bitplane-encoded regions are. Lowering this parameter may
lower the memory usage of the encoder but may also decrease the lossless compression ratio. Raising

this parameter may increase memory usage, but may improve the lossless compression ratio. This
parameter has little effect on overall encode time. Typical values range from 32 to 64.

Acceptable values: 5-64
Default: 64
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Strip Height is the same for MG3 and MG4 outputs.

Strip height affects performance and memory usage. The strip height parameter controls how many rows of the
input image are processed at one time. Lowering this parameter may reduce memory usage, but may increase the
encoding time. Raising this parameter may increase memory usage, but may also decrease encoding time. Unlike
the block size, changing this parameter will not have any effect on the compression ratio of the output image.

Typical values range from 2 to 128. The encoder may perform more efficiently if the block size is a multiple of the
strip height.

Acceptable values: even integers between 2 and source image height
Default: 64

The Optimizable option performs the same for MG3 and MG4 outputs.

Determines whether the output MrSID file contains optimization data. By default the Optimizable option is
enabled.
The option for optimizing images is specific to MG3 and MG4 files. When you optimize an image, you make it
possible to perform some image manipulation operations on the image without re-encoding or recompressing the
image. Image manipulation operations that benefit from optimization include the following:

« Resampling

« Cropping

« Demosaicking

« Area of interest encoding

Creating an optimized image does not affect encoding time. However, saving optimization data for an image
modestly increases the size of an image by approximately one to five percent. If image size is critical and you do
not plan to perform further image manipulation operations, deselect the Optimizable option.

To improve the appearance of MrSID images in other GIS programs, use GeoExpress to write dynamic range
metadata for images.

You can generate dynamic range metadata for all images with the exception of eight bit images. For an image
where the dynamic range is less than the full range of possible values for the image, you can use your

GIS program to stretch the pixel values across the full range. For example, if you have a 16-bit image and the
dynamic range is 11 bits, then you may want to use dynamic range stretching to improve the appearance of the
image.
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To calculate the dynamic range of an image, select a dynamic range generation method.

RGB: Calculate the minimum and maximum dynamic range values for an image with red, green, and blue bands.
Select the RGB method to minimize color shifting for RGB images. When you select the rgb method,
GeoExpress calculates the combined dynamic range of the red, green, and blue bands.

Merged: Calculate the minimum and maximum dynamic range values for an image with multiple bands. Select the
Merged method to preserve the proportions of pixel values across bands. For example, if you want to compare
multiple bands in a multispectral image, you may want to select the Merged method. When you select the merge
method, GeoExpress calculates the combined dynamic range of all bands.

Per-Band: Calculate the minimum and maximum dynamic range values for an image with one or more bands.
Select the Per-Band method to calculate the dynamic range of each band individually. For example, if you have a
multispectral image and you only want to view one band at a time, select the Per-Band method. When you select
the per-band method, GeoExpress calculates the dynamic range of each band separately.

None: Do not calculate the dynamic range of the image.

NOTE: To enter the minimum and maximum dynamic range values manually, select None as the dynamic
range generation method and edit the image metadata. For more information on entering dynamic range
metadata manually, see on page 38.

For 16-bit images with unsigned integer data, you can select either Automatic Range or Strict Range. 16-bit
images with signed integer data and all 32-bit images use the Strict Range option. The following list describes the
two ranges that you can select:

« Automatic Range: Set the maximum value to the estimated bit-depth and set the minimum value to zero.
The estimated bit-depth is the next whole number of bits that contains the calculated maximum value in the
image. For example, if the maximum value in the image is 3950, GeoExpress estimates that the image was
taken with a 12-bit camera and sets the maximum value to 4095. Because GeoExpress sets a wider
dynamic range for the image, you can minimize color shifting when you display the image.

« Strict Range: Set the maximum and minimum values to the exact dynamic range values calculated by
GeoExpress.
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Advanced MG3 Options

You can use the options for the MG3 output format to configure the display of an image, configure performance,
and set optimization options.

The following figure displays the options that you can select for the MG3 output format:

Bi Advanced Job Options X
Input  Output Bands Zoom Transparency Security ;i
MrSID Generation 3
Block Size:
Strip Height:
1-Pass Optimizer Optimizable
2-Pass Optimizer
Estimated Memory Usage: 4465 MB
oK Cancel
Weight
For details, see Advanced MG4 Options:\Weight on page 86.
K-Weight

Determines the emphasis for the K band of a CMYK color image. CMYK imagery with high color contrast will
benefit from a lower setting. A CMYK image with a high density of detail will benefit from a higher setting. The
practical range of values is 0.0 to 10 where 0.0 represents minimum intensity (and maximum color consistency
between the MrSID image and the original CMYK data) and 10 represents maximum intensity.

Acceptable values: 0.0-10.0
Default: 0.25

Frequency Balance
For details, see Advanced MG4 Options:Frequency Balance on page 86.

Sharpness
For details, see Advanced MG4 Options:Sharpness on page 86.

Block Size

For details, see Advanced MG4 Options:Block Size on page 86.

Strip Height

For details, see Advanced MG4 Options:Strip Height on page 87.
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This option is only available for MrSID Generation 3 (MG3) images. The 1-pass and 2-pass optimizer parameters
affect encoding performance and memory usage. Although not as fast as the 1-pass optimizer, the 2-pass
optimizer requires much less memory because it splits the encoding operation into two passes. This is required for
very large files.

Note that the Estimated Memory Usage value is only displayed when the 2-pass optimizer is used.
By default the 2-Pass Optimizer is used for Area of Interest encoding even if this option has not been selected.

NOTE: Encoding with the 1-Pass Optimizer is faster but requires that the entire image be loaded into
memory. If the computer does not have enough memory, the job does not succeed.

For details, see on page 87.

You can use the options for the MG2 output format to configure the display of an image, configure performance,
and generate image statistics.

BR Advanced Job Options *
Input  Output Bands Zoom Transparency Securty | Format-Specific |
Mr5ID Generation 2

Weight: l:l Image Enhancement
G-Weight [ Image Statistics
[] Block Size:

Estimated Memory Usage 275.8 MB

0K Cancel

The settings for Weight and G-weight affect the color quality and line definition of encoded MrSID files. These two
settings can be adjusted independently of one another. The Weight setting does not affect grayscale images
whereas the G-weight setting affects both color and grayscale images.

For details, see on page 86.

The G-weight parameter increases or decreases the definition of edges in an MG2 image. A lower setting for G-
weight creates more defined edges with less emphasis on flat areas. A higher setting creates softer edges while
smoothing the image in flatter areas with relatively consistent color.

In applications requiring precise edge definition, decrease the setting for G-Weight. If precise edges are not as
important as consistency in flat color areas, increase the setting for G-Weight.

Acceptable values: 0.0-10.0
Default: 2
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MrSID accesses image data in “blocks” of pixels. Blocks in MG2 encoding are different from blocks in MG3 and
MG4 encoding.

Different block sizes affect system resources. While a smaller block size in MG2 encoding uses less RAM, the
opening and closing of multiple image blocks may impact a system in other ways, sometimes resulting in an
encoding failure. If sufficient RAM is available, a larger block size is recommended for encoding projects
approaching or exceeding a gigabyte in size.

By default, GeoExpress automatically selects a block size for MG2 encoding based on a calculated memory
usage curve that is dependent on the input image. The default block size corresponds to the lowest point in the
memory curve.

Block size may be set manually by selecting the Block Size option and entering a value in the field. When
compressing imagery in excess of a gigabyte in size, use a block size of 1024. For imagery equal to or greater
than three gigabytes, a block size of 2048 is recommended.

Changing the block size setting will not affect the rate of compression or the quality of the output image.

Minimum value: 32.

The Image Enhancement option improves the appearance of some images by adding information to the images.
This means that pixels of different colors are added to the areas of flat color to make the artifacts less visible to the
eye. The appearance of the resulting images may appear softer. This option is particularly useful forimages that
have large areas of similar color or continuous tone, such as a large blue sky, or a single background color where
artifacts may become perceptible.

By default, image enhancement is enabled. LizardTech recommends that you experiment with a variety of images
to determine which images benefit from this option.

The Image Statistics option collects basic numeric statistics about the image’s samples. Data collected includes
the minimum, maximum, mean, and standard deviation of the samples for each band. The metadata tags that are
added to the output file are:

IMAGE: :STATISTICS:MAX

IMAGE: :STATISTICS:MEAN

IMAGE: : STATISTICS:MIN

IMAGE: : STATISTICS:STANDARD DEVIATION

By default, image statistics is disabled.
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For JPEG 2000 images, you can select JPEG 2000 profiles and other options.

ER Advanced Job Options X

Input  Output Bands Zoom Transparency F

Profiles
Selected Profile:  None Select A Profile Save Profile

JPEG 2000

Tl Sizz Tie Farts Progression COrder: | RPCL e
Use Tile Size Group By

s Resolution Fush Period: 4036
wi 4096 Leyer Tile Length Markers
Height: 4096 [] Componert Use Packet Length Markers
7\

Codeblock Sizs Qusity Layers: [] Use 37 Wavelet (ossy)
Width: Stip Height: Precincts..
Height:

Bits Of Precision: |8 GMLIP2 Metadata...

oK Cancel

IMPORTANT: The information included below is provided with the assumption that the user is familiar
with the JPEG 2000 standard. Parameter choices accommodated by the JPEG 2000 specification are of
such a broad and varied range that it is possible for users to select settings that prove counterproductive to
their goals. In particular, some optimal settings can result in degraded decode performance. Considerable
trial and error may be required to achieve desired results when diverging from defaults and recommended
settings.

IMPORTANT: A JPEG 2000 image consists of one or more tiles, which are regions of the image that are
compressed independently. The order of the resulting “packets” is governed by two settings: Tile Parts
and Progression Order. These settings are especially useful to those who need to target specific JP2
workflows.

This panel enables you to invoke a list of supported profiles comprised of preset encoding options for particular
workflows, and to save your own custom profiles. For more information see on
page 95.

If enabled, the tile size must be no larger than the dimensions of the source image. Smaller tiles reduce the
amount of memory required to encode the image, however the use of tiles may introduce edge artifacts.

Default: 4096 x 4096.

Tiles may be written to the JPEG 2000 file sequentially or interleaved. When tiles are interleaved, Tile Parts
defines the group of packets that are written together. Tile parts can be grouped by Resolution, Layer, or
Component, depending on which Progression Order you use. If you don’t specify a grouping option, the file will
be written sequentially.

If an image consists of many tiles, then grouping first by Resolution allows a decoder to display a course
resolution of each tile first, and then finer resolutions as more of the file is received.
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Some Progression Order options preclude grouping by one or more of the Tile Parts options. For example, the
factory default progression order of RPCL sets the Tile Parts option to Resolution, while making the Layout
option unavailable and the Component option available.

Progression Order lets you specify the order in which packets will appear in a given file. This facilitates certain
workflows. Progression Order may have a significant impact on the time and memory usage required to encode
and/or decode the image.

Default: RPCL

When codestream flushing is enabled, less memory may be required to encode the image. The flush period should
be on the order of the strip height being used. Using the flush period should not significantly affect output image
quality.

Default: 4096

Determines whether or not Tile Length Markers (TLMs) are to be put into the JPEG 2000 codestream. Use of
TLMs may provide better decode performance.

Default: 255

Enables or disables the use of packet length markers. Use of packet length markers may improve decoding
performance.

Default: Enabled

Specifies that the floating point 9-7 wavelet be used for encoding, instead of the default integer 5-3 wavelet. The 9-
7 wavelet will not encode an image losslessly, however, it may result in a better looking image at higher
compression ratios. This option is disabled by default and is only available when the Encode Losslessly option is
not selected. By default, the NPJE and EPJE profiles use the 9-7 wavelet.

JPEG 2000 codeblock size is subject to the following restrictions:
« width and height must be powers of two
« width and height must be greater than 4
« width x height must be less than 4096
« width and height must be less than width and height of tile size
« width and height must be less than width and height of the image if tile size is not specified

The default codeblock value is 64 x 64.

This value indicates the number of quality layers with which to encode the image. Among other things, quality
layers enable better “streaming” (progressive transmission and display) in some applications.

Default: 30
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Strip Height (JP2)

Affects memory usage. Increasing this value may improve runtime performance, but at a cost of requiring more
physical memory. This value should be decreased when encoding very large images. Changing the strip height
does not affect the quality of the output image.

Default: 12

Bits of Precision
Enables you to choose how many significant bits are to be used from the samples of the source imagery. For
example, an image may consist of 16-bit data values, but only eleven of those bits may be meaningful.

Default: Enabled
Default JP2 Settings

The table below lists GeoExpress’s default JP2 settings.
To change these settings, see Preferences on page 109.

OPTION SETTING
Use Tile Size Enabled
Tile Size Width: 4096
Height: 4096
Tile Parts Group by resolution (R)
Code Block Size Width: 64
Height: 64
Use Precincts Enabled
Precinct Size Width: 256
Height: 256
Strip Height 12
Quality Layers 30
Flush Period Enabled; value: 4096

Tile Length Markers Enabled; count: 255

Use Packet Length Markers |Enabled
Use 9-7 Wavelet (lossy) Disabled
Progression Order RPCL

Use GMLJP2 Metadata Enabled

Precincts
Using precincts may improve the performance of decode operations for certain image encodings such as those in
which tiles are not used. The Precinct Editor enables the user to enter precinct sizes for all of the zoom levels of
the image.
Default: GeoExpress uses precincts in which width and height values are both 256.
To access the Precincts Editor:

1. Select JPEG 2000 as the output format.

2. Click Precincts on the Format-Specific tab of the Advanced Job Options dialog.

This opens the Precincts Editor dialog.

To disable use of precincts, deselect the Use Precincts option.
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To edit a precinct value:
1. Open the Precinct Editor as described above.
2. Select a precinct number in the precinct list and click Edit Precinct. A new editing dialog appears.
3. Change width and height values and click OK.

Precinct sizes must be powers of two, except for the last one in the list, which has the lowest resolution.

Click the GMLJP2 Metadata button to write GML metadata to the JPEG 2000 image or to specify a GML data file.

When you enable the GMLJP2 option, GML metadata is added to the output file according to the GMLJP2
Application Schema version 3.1.1., which can be found at http://schemas.opengis.net/gml/.

If you would rather use an external file that contains all the coverage and other GML data, you may specify that file
by deselecting the Write GMLJP2 metadata box option.

By default this option is enabled.

If an external world file is present, its information trumps any metadata. Absent a world file, metadata are
evaluated in the following order of priority:

1. GMLJP2

2. GEOJP2/GEOTIFF

3. MrSID metadata

4. World file metadata

NOTE: If a world file is present, then no coordinate reference system is associated with the output file (a
NULL WKT is applied).

GeoExpress includes a selection of industry accepted profiles—groups of preset JPEG 2000 encoding options for
particular workflows—and an interface for managing them. The Profile Manager enables you to select and edit
profiles and create and save new ones.

Make sure you select JPEG 2000 as the output file format.
Click the Advanced button on the Properties tab.

Click the Format-Specific tab.

Click the Select A Profile button in the Profiles panel.
The Profile Manager appears.

Hp o=

In the Profile Manager, select a profile from the drop-down menu and click OK. The selected profile is listed on
the Format-Specifc tab and the options are set to match the profile.

GeoExpress provides profiles composed of preset encoding options for particular workflows. These are EPJE,
NPJE, Large Image, Large Image without TLMs, and Default. In the current implementation of GeoExpress, the
EPJE profile is identical to the NPJE profile except for progression order. The profile named Default is not the
same as the default GeoExpress encode settings.
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When you select a profile from the drop-down list, it may display a user-defined description in the Description
field to help identify it. Click OK to apply the selected profile.

You can also choose to load a custom profile stored anywhere on your network.

NOTE: Selecting (None) from the profile list sets the JPEG 2000 options to the defaults set in the
GeoExpress preferences.

EPJE

Stands for Exploitation Preferred JPEG 2000 Encoding. The EPJE profile sets the values to the encoding
parameters preferred by the National Geospatial-Information Agency (NGA) for image exploitation.

NPJE

Stands for NGA Preferred JPEG 2000 Encoding. The NPJE profile sets the values to the encoding parameters
preferred by the National Geospatial-Intelligence Agency (NGA) for archiving.

Large Image

This profile is optimized for encoding very large images.

Large Image w/o TLMs

This profile disables tile length markers for better rendering in viewers that don’t support them.
Default

This profile represents LizardTech'’s general purpose JP2 encode settings, determined at the SDK level. These
are NOT the same as the GeoExpress factory default encode settings, which are recommended for large images.
See on page 94.

NOTE: The NPJE and EPJE standardization process is not yet complete. These profiles use settings that
are compliant with the NPJE and EPJE standards as the NGA currently defines them; however, if the
specifications for the standards change, files encoded using the current NPJE and EPJE profiles may not
be compliant with the finalized standards. As the standards evolve, LizardTech will make available
updated profiles (XML files) to reflect any changes to the standards. Contact your LizardTech sales
representative to learn more.

After you select and apply a profile, the profile name appears in the Selected Profile field on the Advanced tab. If
any encode settings are modified after applying a profile, the Selected Profile field indicates that the current
settings differ from the original profile settings, unless no profile was selected. For example, if you apply the EPJE
profile and change one or more options, the profile is now listed as EPJE (modified).

You can save the current encode settings as a custom profile.

1. Onthe Format-Specific tab of the Advanced Job Options dialog, click Save Profile.
2. Enter an output file name and a name for the profile if desired.

3. Optionally, add a description.

4. Click OK.

You can only save a profile if all of the encode parameters are discrete and unambiguous values. The default
location for user profiles on Windows is C: \Documents and Settings\<user name>\My
Documents\LizardTech\GeoExpress\9.5.5\profiles. Any profiles in this directory will automatically
be available in the profile selector’s drop-down list. To save a profile, you must enter a unique profile name.
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1. Access the Profile Manager as described above.
2. Click Load Custom Profile and browse for the desired custom profile, then click Open.
3. Optionally, add a description and click OK.

A profile is a collection of settings, not a singular entity. After a profile is applied to a job, only the particular
settings—not the profile—are saved in the job. The profile itself is stored on disk. If a profile is edited or deleted
after it is applied to a job, those changes are not retroactively applied toward any existing encode jobs.

Not all of the settings in the dialog are preserved in a profile—only the ones that affect how the output file is
encoded. Most notably, thumbnail size and strip height are not included in the profile system. Profiles are used to
store information about what JPEG 2000 options were used in choosing the organization of the file format
(algorithmic codec settings), not encoder implementation choices. Changing the strip height or thumbnail size
does not affect the layout of the file, since they are really encoding performance parameters.
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A mosaic is a group of images or point clouds that you want to view together. Each of the images or point clouds
that make up a mosaic is called a tile.

You can manage the tiles in a mosaic to add tiles, remove tiles, or change the order of tiles. For rasterimages, you
can also crop tiles.

For raster mosaics, you can perform the same manipulation operations that you perform for single images. For
example, you can crop or despeckle a raster mosaic.

Use the Create New Mosaic button in the toolbar to create a mosaic. The mosaic options that you can select
depend on the mosaic format that you select.

1. Click the Create New Mosaic |:| button in the toolbar.

This opens the Create New Mosaic dialog.

2. Select the mosaic type. You can select either Raster or LiDAR.

3. Click Browse to select the directory where you want to save the mosaic, and enter a file name for the
mosaic.
If the mosaic is a LIDAR mosaic, click OK.

4. Forraster mosaics, select the mosaic output format that you want to use in the Format drop-down.
For more information on mosaic formats, see below.

5. Optionally for raster mosaics, select Enable multiresolution mosaicking to create a mosaic from input
files with different image resolutions.
For more information, see on the next page.

6. Optionally for raster mosaics, select Allow multiple projection systems to create a mosaic from input
files with different projection systems.
For more information, see on page 100.

7. Forraster MrSID mosaics, select the flat or composite mosaic option. For NITF mosaics, select the
mosaic option for single or multiple image segments.
For more information, see below.

8. Click OK.
This opens the Select tiles dialog.

9. Select one or more images that you want to add to the mosaic and click Open.

NOTE: Because images with different compression types and color lookup tables can be combined when
multiple images are joined together, color lookup table information may not be reported forimage mosaics.

GeoExpress can create raster mosaics in the MrSID format, the JPEG 2000 format, and the NITF format.
GeoExpress can create LIDAR mosaics in the MrSID Generation 4 and LAZ formats.

If you create a mosaic from existing MrSID images or JPEG 2000 images, GeoExpress does not deduct data from
the data cartridge. Additionally, if you create a mosaic from NITF files that contain JPEG 2000 images,
GeoExpress does not deduct data from the data cartridge. For more information on output formats, see

on page 27.
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Use the MrSID file format to create flat mosaics and composite mosaics. A flat mosaic is a single image that you
create from multiple input images. A composite mosaic is a group of images that display as a single image.

When you create a flat mosaic, GeoExpress creates a single image from the input tiles. Because a flat mosaic is a
single image, it displays more quickly than a composite mosaic. You can perform any image manipulation
operation on a flat mosaic that you can perform on a single image.

When you create a composite mosaic, GeoExpress creates a MrSID file that contains multiple input tiles. You can
only create composite mosaics out of input tiles in the MrSID format. To create a composite mosaic out of images
in other formats, first convert the input images to the MrSID format, then create a mosaic out of the MrSID files.

Because a composite mosaic is a container for existing files, you can create a composite mosaic without running
an encoding operation. Use composite mosaics when you want to create mosaics quickly, for example, when you
want to create mosaics from large input tiles.

A composite mosaic in the MrSID Generation 4 (MG4) format can only contain MG4 input tiles. A composite
mosaic in the MrSID Generation 3 (MG3) format can contain MG3 and MG2 input tiles.

An MG4 composite mosaic contains an overview image for viewing at low resolutions. As a result, MG4
composite mosaics display more quickly than MG3 composite mosaics. However, MG4 composite mosaics may
take slightly longer to create.

When you create mosaics in the JPEG 2000 format, GeoExpress runs an encoding operation that creates a single
image from the input tiles. JPEG 2000 mosaics are equivalent to flat MrSID mosaics.

Use the NITF file format to create mosaics with single or multiple image segments. Animage segment is an
image in a NITF file. When you create a mosaic in the NITF file format, you can combine the input tiles into a
single image or you can add each image to the NITF file separately. If you add images to the NITF file separately,
the mosaic is called a multiple image segment mosaic. If you combine the input images into a single image, the
mosaic is called a single image segment mosaic. A mosaic made up of a single image segment is equivalent to a
flat MrSID mosaic. A mosaic with multiple image segments is similar to a composite mosaic in that it preserves
the information from each input tile. However, multiple image segment mosaics require an encoding operation
unlike composite mosaics, therefore they take longer to create.

A multiresolution mosaic is a raster mosaic made up of input images with different resolutions. When you create a
multiresolution mosaic in any format, the resulting mosaic is a single image, in other words, it is a flat mosaic. The
exception to this is the MrSID Generation 4 (MG4) format. You can create an MG4 composite mosaic out of
multiresolution images if all of the input tiles are also in the MG4 format.
To add images with multiple resolutions to a mosaic, select the Enable multiresolution mosaicking option
when you create the mosaic. To select this option after you create a mosaic:

1. Select amosaic in the Job List.

2. Click Advanced in the Properties tab.

This opens the Advanced Job Options dialog.
3. Inthe Output tab, select Enable multiresolution mosaicking.
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GeoExpress can create raster mosaics out of images with multiple projection systems. However, because
images with different projection systems display discrepancies in their positioning, GeoExpress reprojects all of
the images to the same coordinate reference system (CRS). By default, GeoExpress reprojects images to the
WGS 84 projection system. To use a different projection system, see on page 63.

To add images with multiple projection systems to a mosaic, select the Allow multiple projection systems
option when you create the mosaic. To select this option after you create a mosaic, complete the following steps:
1. Select a mosaic in the Job List.
2. Click Advanced in the Properties tab.
This opens the Advanced Job Options dialog.
3. Inthe Output tab, select Allow multiple projection systems.

NOTE: When you select Allow multiple projection systems, GeoExpress also selects the Enable
multiresolution mosaicking option. Because reprojecting an image changes the geographic area
covered by the image, reprojection often changes the resolution of an image. As a result, GeoExpress
automatically selects the Enable multiresolution mosaicking option to correct discrepancies in image
resolution.

If one or more of the tiles in the mosaic does not have a valid CRS, or if you are using world files, you can
manually assign a CRS to each tile in the Tile Manager. For more information, see on
page 102.

Manage the tiles in a mosaic job to complete the following tasks:
« Addtiles to the mosaic job.

« Remove tiles from the mosaic job.

« Change the order of tiles. If tiles in a mosaic overlap, the mosaic displays whichever tile you place lower in
the tile list.

o Crop the tiles in araster mosaic.
« Assign a coordinate reference system (CRS) to individual tiles of a raster mosaic. This option is only

available if you have enabled multiple projections for the mosaic. For more information, see
above.
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You can manage tiles in the Tile Manager. To access the Tile Manager, right-click a mosaic in the Job List and

click Tile Options. You can also choose Options > Tile options.

Ba Tile Manager
Tiles:

X \Samplelmageny 1 tet 444707 sid
X \Samplelmagery' 10tet 444737 sid
¥ \Samplelmageny 1 tet 455707 sid
X \Samplelmageny’ 10tet 474707 =id
¥ Samplelmageny 1 0tet 474737 sid
“\Samplelmagery’ 10tet 489707 =id
“Samplelmageny’ 10tet 485722 sid
“Samplelmageny™ 10tet 485737 sid
“\Samplelmagery" 10tet 504707 sid
“Samplelmageny’ 10tet 504722 sid

oo oM ox

Tile Coordinate Reference System:
NADE3 / UTM zone 10N (26910)

Move Up Move Down

Add Tiles...

Remove Tiles

Remove Al Tiles

Crop Tile...

Coordinate System
Assign...

Remove. ..

OK Cancel

X

NOTE: The Tile Manager is for raster mosaics only. However, you can manage raster and LIDAR
mosaics quickly from the Job List:

« Dragtiles into the Job List to add them to a mosaic.

« Right-click a mosaic tile in the Job List and click Remove to remove it from the mosaic.

« Click and drag tiles in the Job List to change their order.

1. Right-click the mosaic in the Job List that you want to add tiles to, then click Tile Options.
This opens the Tile Manager.

2. Click Add Tiles.
3. Select one or more images that you want to add to the mosaic and click Open.

4. Click OK.

TIP: For raster and LIDAR mosaics, you can also drag images into a mosaic in the Job List from your

system’s file manager.

1. Right-click the mosaic in the Job List that you want to add tiles to, then click Tile Options.
This opens the Tile Manager.
2. Select one or more tiles that you want to remove from the mosaic job and click Remove Tiles.

To clear the tile list, click Remove All Tiles.

3. Click OK.

TIP: To remove raster and LiDAR tiles quickly, select tiles in the Job List and press Delete.
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1. Right-click the mosaic in the Job List that you want to add tiles to, then click Tile Options.
This opens the Tile Manager.

2. Select one or more tiles and click Move Up or Move Down.
You can also drag the selected tiles to another place in the tile list.

3. Click OK.

NOTE: If tiles in a mosaic overlap, the mosaic displays whichever tile you place lower in the tile list.

TIP: To move raster and LIDAR tiles quickly, select tiles in the Job List and drag them to another position.

1. Right-click the mosaic in the Job List that you want to add tiles to, then click Tile Options.
This opens the Tile Manager.
2. Select atileinthetilelist and click Crop Tile.
This opens the Image Crop dialog.
3. Select a cropping format and enter a crop region.
You can also click Show Image to select a cropping region using the graphical cropping tool.
4. Click OK.

For more information on cropping images, see on page 48.

NOTE: You can only crop the tiles of a raster mosaic.

You can only assign a CRS tottiles if you have enabled multiple projection systems for the mosaic. For more
information, see on page 100.
1. Right-click the mosaic in the Job List that you want to add tiles to, then click Tile Options.
This opens the Tile Manager.
2. Select one or more tiles in the tile list and click Assign.
The Coordinate Reference System Selector opens.
3. Select a CRS from the System drop-down or select Use Custom WKT to select a well known text
(WKT) string.

NOTE: You can only assign a CRS to raster tiles.
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Mosaic Manipulation
Most raster image manipulation operations that you can perform are the same for mosaics and for single images.

However, when you perform color balancing for a raster mosaic you can also perform additional color corrections
to match the appearance of tiles to each other. You can perform color balancing for mosaics with the following
output formats:

« MrSID Generation 4

o MrSID Generation 3

. JPEG 2000

o NITF

For the MrSID output formats, you can only perform color balancing for flat mosaics.
When you preview a mosaic, you can preview individual tiles or selected tiles.

Performing Color Balancing for a Mosaic

When you perform color balancing for mosaics, you can perform uniform corrections, non-uniform corrections, and
automatic corrections.You can apply corrections to the RGB bands or the Grayscale band, and you can apply
multiple corrections to the same mosaic.

For more information on the types of corrections that you can apply, see The Color Balance Tool on page 58.

1. Select a mosaic in the Job List.
2. Click the Color Balance button W on the toolbar.

B3 Color Balance Manager - O X

Uniform Corections  Mon-uniform Comections
Band: Intensity v ﬁ & Q Q ‘ Iz‘ IE‘ Scale: 1:16

Min: Gamma: Mae:

|

[ 5]
Brightness:
' o
Contrast:

@
Enable Live Updating

X Y:
Reset All Comections Tile Selector Options

Tile Name Outline Color: | NN

Automatic Comections 1 Tile8_rgbn sid N
Comection Method: | Matchtiles to each other 2 Tile11_rgbr.sid anig or: | =
3 Tile 12_rgbn.sid Show Tile Outiines
Apply comection: to each band ~ = -
4 Tile7_rgbn sid Select Al Tiles
Apply Comections Deselect All Tiles

0K Cancel
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3. Select the color balancing corrections that you want to perform and select the tiles to which you want to

apply the corrections. Select tiles in the tile list or click the Tile Select button ™ | to select tiles in the

preview image.

m To perform uniform corrections, click the Uniform Corrections tab. Select one or more tiles that you
want to correct. If you do not select a tile, the corrections that you perform are applied to all the tiles.

m To perform non-uniform corrections, click the Non-Uniform Corrections tab and select one or more
options.

m To perform automatic corrections, select a Correction Method in the Automatic Corrections
panel. You can choose to apply the correction to each band (the default) or to the intensity pseudo-
band. Click Apply Correctionswhen you have specified your desired settings.

NOTE: The option to choose which bands to apply automatic corrections to is new in GeoExpress
v9.5.3. In older versions, the behavior was to apply the corrections to the intensity pseudo-band. By
applying the corrections to each color band, the colors of the resulting image are more uniform. This
new functionality is now the default behavior, but if you need to utilize corrections similar to earlier
versions of GeoExpress, choose intensity band from the Apply correction menu.

4. Click OK.

NOTE: Uniform corrections will be more effective among image tiles composed of similar ground cover
types than, for example, an array of tiles showing dense urban development and vegetation or bodies of
water, and may require additional manual manipulation to make the tiles match their neighbors. Automatic
corrections work on a tile by tile basis, so any boundaries, seams, or lens effects that occur inside of a tile
will still be visible regardless of uniform corrections.

Select araster or LIDAR mosaic in the Job List and click the Preview tab to preview all the tiles in the mosaic, or
select one or more tiles in the Job List that you want to preview.

For raster mosaics, when you select bands using the Band Selector button @ your selections apply to all of the
tiles in the mosaic, even if only one tile in the mosaic is selected.

When you crop a raster mosaic, the preview image only displays the cropped area of the image. If you select a tile
in the Job List that is not included in the cropped area of the image, the preview image is blank.

For more information on the preview tab, see on page 20.

For raster mosaics, you can create a composite mosaic to update one part of an image with new imagery. This is
useful when, for instance, a particular region of an aerial photo mosaic needs to be updated because of building
development or other geographic changes but an entire new image set is not needed. By updating just the affected
image tiles geospatial image users can keep pace with geographic changes without constantly acquiring new
image data for every region.

To update an image, create a new raster mosaic and select the composite mosaic option.

NOTE: Updating an image or set of images results in a flattened mosaic if flattening is specified by the
user or if tiles of differing resolutions are used.
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Mosaics with Overlapping Input

If two or more tiles in a raster mosaic overlap, the resulting mosaic displays whichever tile you place lower in the
Job List.

If you create a mosaic out of overlapping tiles and the tiles are compressed images, despeckle the tiles to
minimize compression artifacts between image tiles. For more information, see The Despeckle Tool on page 46.

If the transparency borders of individual tiles obscure image data in neighboring tiles, set transparency values for
the mosaic. For example, when images are geographically rectified to align accurately with a fixed point such as
magnetic North, the images appear tilted and contain borders of transparency along the edges. For more
information on setting transparency values, see Transparency Options on page 81. The following figure shows an
example of a mosaic with overlapping transparency borders:

Mosaics with GeoTIFF Images

If you create a mosaic that contains GeoTIFF images, you can select the georeferencing information that you
want to use. A GeoTIFF image can store georeferencing information in a TIFF world file and in embedded
metadata. If the GeoTIFF image has georeferencing information stored both in a world file and in its metadata,
GeoExpress uses the embedded metadata by default. To use the georeferencing information in the world files,
select the Allow World Files to Override Native Georeferencing preference. For more information on setting
preferences, see Preferences on page 109.

If you encode a GeoTIFF image using georeferencing information from a TIFF world file, other spatial referencing
information such as the coordinate reference system (CRS) found in the GeoTIFF metadata tags is saved in the
MrSID metadata. In a mosaic composed of both TIFF and GeoTIFF images, GeoExpress saves metadata in the
mosaic if the first input tile is a GeoTIFF image with metadata.
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Rather than use GeoExpress to select images or point clouds that you want to mosaic, you can create a text file

which lists the images and point clouds that you want to mosaic. For raster mosaics, the text file must have a
.mos extension. For LIDAR images, the file must have a . 1ist extension.

For raster mosaics, you can create mosaic lists forimages that do or do not have gereferencing information. For

LiDAR mosaics, the images must have georeferencing information.

By default, the output image from a mosaic list is written to the directory where the mosaic list file is located. The

file is given the same name as the mosaic list file, but with a . sid extension.

To add a mosaic list file, complete the following steps:
1. Click the Create New Mosaic button |i| on the toolbar.

This opens the Create New Mosaic dialog.

Select a mosaic type and mosaic options.

Click OK.

Select All Files from the Files of type drop-down menu.
Select the mosaic file and click Open.

a s~ wbd

For georeferenced images and point clouds, the text in the mosaic list file contains the file paths of the images that
you want to mosaic. In the following example, a mosaic is created from four TIFF files: image_nw.tif, image_
ne.tif, image sw.tif,andimage_se.tif.

Ensure that each image has an associated * . tfw file (the names of the corresponding files must match exactly,
differing only in the . tfw file extension). This * . tfw file must be in the same directory as the file to which it
refers. A sample file for this project is:

C:\maps\image nw.tif

C:\maps\image_ne.tif

C:\maps\image_sw.tif

C:\maps\image_se.tif

When presented with a list of images, GeoExpress immediately looks for corresponding georeferencing
information. The “Input File Size” and “Target File Size” reflect both the on-disk size of the source data and the
estimated output file size of the full mosaic. When encoded, the images are combined in a seamless mosaic
based on the information given in the georeferencing files.

NOTE: GeoExpress does not recognize mosaic list files with spaces in either the listed file names or in the
listed paths. In addition, the first line in the file cannot be blank and the last line in the file must be followed
by a carriage retumn.

When creating a raster mosaic using images with no georeferencing information, the text file must list the file
names and the upper left corner pixel location for each image. Each image must be listed based on the following
format:

image_name x-pixel_location y-pixel location
Only a single space is required between each of the three items in the list. Each image listed must be on a
separate text line.
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Base the upper left corner pixel location of each image on the location of the image relative to an x=0, y=0 pixel
location of the upper left comner of the entire set of images.

Consider an example where a single image is being created from four separate scanned Sun Raster images, each
640 by 480 pixels in size.
The file requires the following four lines:

image nw.ras 0 ©

image_ne.ras 640 ©

image sw.ras 0 480

image_se.ras 640 480

The first line in the file must not be left blank.

The sample auxiliary file above joins the specified images as follows:

N o\

(e, o) (640, @)

image_nw.ras image_ne.ras

o\ =

(@, 4s0) (640, 480)

image_sw.ras image_se.ras
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As you add more tiles to a mosaic, performance becomes increasingly important. The following list provides some
advice on encoding performance for mosaics:
« Change the encoding options for strip height and block size for faster encoding on systems with more
memory. As a rule of thumb, you can create mosaics up to 500,000 pixels in width if you set the strip height
to 12 and the block size to 64 on a computer with 2 GB of RAM. For more information see

on page 132.
m Strip height. Set a higher strip height for faster encoding but more memory usage. For more
information, see on page 87.

= Block size. Set alower block size to use less memory. However, selecting a lower block size will
result in a lower quality compression. By default, the block size is set to the maximum of 64. Do not
change the block size unless you need to restrict memory usage. For more information, see
on page 86.

« Create mosaics in a single job even when there are many input tiles. It takes longer to encode many small
mosaics and then encode the small mosaics into one large mosaics. If you need to create both small
mosaics and large mosaics, create one large mosaic first, and then create tiles in the Job Options.

« Work from uncompressed images when possible. If you want to perform multiple image manipulation
operations on a mosaic, perform the image manipulation operation on the uncompressed input tiles. Many
image manipulation operations that you perform on a compressed mosaic decode the mosaic first, perform
the image manipulation operations, and then compress the mosaic again. Exceptions to this rule are crop
operations, resampling operations, and composite mosaic operations for the MrSID Generation 3 and
Generation 4 formats.
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Preferences

Every time that you create a job by adding an image or mosaic to GeoExpress, the job uses a set of default
options from the preferences. Set your preferences to change these default options. To access the preferences for
your jobs, choose Options > Preferences in the menu bar.

Setting Preferences
1. Choose Options > Preferences.
2. Click atab to set preferences for that category.
Preferences pertaining to most job types are in the General and Appearance tabs.
Preferences for raster jobs can be accessed through the MrSID and JPEG 2000 tabs.
Set preferences for LIDAR jobs in the LiDAR tab.
3. When you are finished, click OK.

NOTE: To restore the default preferences for GeoExpress, click Restore Program Defaults.

Raster Preferences

Set default job options and other global settings for raster files in the Preferences dialog.

The dialog is divided into six tabs:
« General
« MrSID Generation 4
o MrSID Generation 3
o MrSID Generation 2
« JPEG 2000
« Appearance
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Preferences b

MrSID Generation 3 MrSID Generation 2 JPEG 2000 Appearance

General MrSID Generation 4 LiDAR
Default Directories
Temp: | | Browse...
Qutput: | | Browse ..

Log Files: |C MlUsersh EUser"-.Documerlts"-.UzardTecl'| Browse...

Histograms: |C:"'-.Users"-.lEUser"-.Documents"-.lJzardTecl’| Browse...

Qutput File Generation Default Output File Format

(® Create unique file name Mr51D Generation 4 ~
Prompt if output file exists

@] pt p Same as Input

() Aways overwrte (MrSID and JP2 Only)

Georeferencing:
World Files: [ Use [ Generate
Ao XML Files: [ Use [ Generate

Emor Checking
[] Suppress pop-up emor messages during enceding

Apply Metadata to Image Seamlines

NITF RPC [] Generate shapefile
Rotation

Concurrency Control

2 3| Concurert Jobs 2 3| Total Threads

Restore Program Defaults

Carcel

You can define default Temp, Output, Log File and Histogram directories by browsing or by entering a filepath.

When GeoExpress encodes a MrSID Generation 2 image, it creates a series of temporary files that are used in
constructing the final MrSID image. Collectively, the temp files are roughly equivalent in size to the created MrSID
image. These files are deleted immediately upon completion of an encoding project.

Encoding requires enough disk space to accommodate both the output image and the equivalent size of the output
image in temporary files. (For more information, on page 11.)

By default, GeoExpress uses the default Windows temp directory, typically C:\Temp, to store these temporary
files. You can specify an alternate directory by entering the full path name in the Temp Directory field. If you are
unsure of the entire path, click Browse to navigate to the preferred directory.

If an output or temp directory has been specified and afterwards deleted or moved, GeoExpress will prompt you to
specify a new directory.

By default, the output directory is the same location in which the input image resides. In the case of image
mosaics, the output directory is the location in which the first image listed within the mosaic resides.

To have all MrSID images written to a single directory, enter the desired directory path in the Output field.
Specifying a default output directory does not affect filenames already in the Job list. Only images and mosaics
added to the Job list after the default directory is specified adopt the new output directory.
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This option allows you to set the Log File output directory. If the user does not manually change the directory
location the default location will be displayed.

By default, histogram files are created in the same place as their source images, but if they cannot be created
there (for example if the source images are in a non-writable directory), then they are created in an auxiliary
directory specified in the Histogram field. If the histograms cannot be created in the image source directory and
this field is blank, the histogram files are savedto C: \Documents and Settings\username\My
Documents\LizardTech\GeoExpress\9.5.5\histograms.

If you select the Create unique file name option when a new MrSID file is created in a directory where a file of
the same name exists, the new file name is appended with an underscore and a number. For instance, if two files
named image . sid are created in the same directory, GeoExpress names the second file image - copy
1.sid. Additional files created are appended with incremental numbers (such as image - copy 2.sid).

If you select the Prompt if output file exists option, you will receive a prompt when GeoExpress finds an

existing file with the same name as the output file. A Save As dialog appears, prompting you to enter a new file
name.

If you select the Always overwrite option, GeoExpress overwrites existing files.

WARNING: Many USGS DOAQ files have the same file name with a different extension. If you select
Always overwrite, MrSID files created from multiple USGS DOQ files overwrite one another. LizardTech
recommends that you not use the Always overwrite feature when working with USGS DOQ images.

A drop-down list enables you to select the default file format to use for output files. Regular options are MrSI1D
Generation 4 (MG4), MrSID Generation 3 (MG3), MrSID Generation 2 (MG2) and JPEG 2000. Unless this default
is changed manually, it is MrSID Generation 4.

NOTE: Support for encoding NITF images is available for GeoExpress. Contact your LizardTech
representative (https://www.lizardtech.com/sales) to purchase the NITF Extension for GeoExpress.

You can override this behavior for MrSID and JPEG 2000 files; if you select Same as input, then the output file
format will be the same as the input file format if the input file is MG2, MG3, MG4, or JPEG 2000. For input files of
any other format, the default output format will be specified by the drop-down menu option.

Select the Use option (next to World Files) to have GeoExpress use the georeferencing information in a world file
for an image or mosaic tile, rather than native georeferencing.

IMPORTANT: This option will override any coordinate reference system (CRS) metadata—including well-
known text strings (WKTs)}—that may have been embedded in the file. You can manually edit the CRS in
the image metadata with the Edit Metadata tool. For more information on selecting a CRS in the metadata,
see on page 37.

Select Generate to automatically generate world files upon encoding.

For more information, see on page 123.
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Aux XML Files

Select the Use option next to Aux XML Files to have GeoExpress use georeferencing information in an Esri Aux
file, rather than embedded CRS metadata. Selecting this option overrides the Use World Files option if it is also
selected.

Select Generate to automatically generate Esri Aux files upon encoding. This enables you to make sure the
georeferencing metadata in your MrSID and JPEG 2000 imagery will be readable in Esri applications.

Error Checking

When several jobs are being encoded as a batch, errors may occur that could interrupt the encoding project. These
errors may be internal (for example, GeoExpress may encounter a corrupt orincompatible image or mosaic), or
they may be external (for example, a Windows or network error). To force GeoExpress to ignore any such error
messages and attempt to continue with the encoding project, select the Suppress Pop-Up Error Windows
During Encoding option. The error messages will be written to the log file.

Apply Metadata to Image

If your images contain metadata for image rotation or rapid positioning capability (RPC), you can manipulate the
output image so that it reflects the information in the metadata. You can select the following preferences for image
metadata:

NITF RPC

NITF RPC metadata maps pixel data to location data for orthorectification. Select this option to apply the
orthorectification described in the NITF RPC to the image.

NOTE: To apply orthorectification, the NITF RPC metadata must use the WGS 84 datum.

Rotation

Image rotation metadata describes the direction that an image should point. For example, an image might contain
metadata that rotates an image so that it points north. Select this option to create rotated images with empty
space in the corners. The empty space is compressed so that it does not add to the size of the image. This is the
default setting so that your images are displayed with the correct orientation even in viewers that do not support
metadata for image rotation.

The following figure shows a rotated image:

The black areas represent the parts of the image that do not contain data values. In MrSID Generation 4 images,
the no-data values are stored in the alpha band. For more information on alpha bands, see Alpha Bands and MrSID
on page 79.
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For raster mosaics, you can choose to generate a shapefile representing the tiles that make up the image. When
viewed in an appropriate application (such as GeoViewer), you can overlay the shapefile on the output image to
identify the original tile positions.

Select this option to have the default for raster mosaics include a seamlines shapefile in the output.

If you run GeoExpress on a system with multiple processor cores, GeoExpress creates multiple threads to
process jobs more quickly. You can set the following preferences for concurrency:

« Concurrent jobs. The maximum number of jobs that GeoExpress can run at the same time. Each job uses
one or more threads. If the number of concurrent jobs exceeds the number of total threads, GeoExpress
does not run the full number of concurrent jobs.

« Total threads. The number of threads that GeoExpress uses. GeoExpress always uses the total number
of threads available regardless of the number of jobs.

The maximum number of concurrent jobs and total threads that you can set equals the number of processor cores
in your system. For example, if your system has six cores, you can run a maximum of six concurrent jobs and six
threads. By default, the number of concurrent jobs and total threads equals the maximum.

If you reduce the number of total threads, GeoExpress uses fewer cores. Reduce the number of total threads
when you want to perform other processor-intensive tasks on the system that runs GeoExpress.

NOTE: Prior to GeoExpress 9.5.5, the maximum number of threads and concurrent jobs that could be run
was 8. In version 9.5.5 and later, these are only limited by the number of processor cores on your system.

You have 12 jobs that you want to run on a system with six cores. The following list describes how GeoExpress
runs the jobs for various preference combinations:

« If you set the number of concurrent jobs to six and the number of threads to six, GeoExpress runs six jobs
at a time and allocates one thread to each job. Use this combination for optimal performance.

« If you set the number of concurrent jobs to three and the number of threads to six, GeoExpress runs three
jobs at atime and allocates two threads to each job.

« If you set the number of concurrent jobs to six and the number of threads to three, GeoExpress runs three
jobs at a time and allocates one thread to each job. Because GeoExpress uses one thread for each job,
GeoExpress cannot run the full number of concurrent jobs.

GeoExpress continues running as many concurrent jobs as possible until it finishes all 12 jobs.
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Appearance Preferences

The Appearance tab of the Preferences dialog allows you to change the color and width of lines and highlights

that are applied in the Image Crop, Area of Interest, and Color Balance Tile Selector dialogs. Colored
rectangles display the color currently selected.

Preferences x
General Mr51D Generation 4 LDAR
MrSID Generation 3 MrS1D Generation 2 JPEG 2000

Cropping Editor
Qutline Color: | Highlight Color: | IS Line Width:

Area Of Interest Editar
Qutline Color: | Highlight Color: | I Line Width:

Color Balance Tile Selector

Outline Color: | IR Highlight Color: | I Line Width:
Restore Program Defaults

oK Cancel

Changing Colors

1. Click on the rectangle whose color you wish to change. A color picker appears.
2. Selectacolorand click OK.

To change a line width, enter the desired value in the appropriate Line Width field.
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MrSID Preferences

This page describes the preference options for MrSID Generation 4 (MG4), MrSID Generation 3 (MG3) and MrSI1D

Generation 2 (MG2).

You can set the following preferences for MG2, MG3, and MG4 files:
« Compression ratio preferences. For more information on compression ratios, see Compression Overview

on page 32.

« Zoom levels preferences. For more information on zoom levels, see Zoom Options on page 77.
« Advanced preferences. For more information on advanced options such as weight and block size, see
Format-Specific Options Overview on page 85.

The MrSID Generation 3 (MG3) and MrSID Generation 4 (MG4) preferences mirror the settings found in the MG3
and MG4 format-specific options on the Advanced Job Options dialog, with the exception that a default
compression ratio can be specified for both color and grayscale images. When you add a new MG3 or MG4
encode job, the compression settings are initially set to the values declared on this tab. The effects of these

options can be simulated on the Preview tab.

Preferences

General Mr5ID Generation 4 LDAR

Compression Ratio

(® Compression Ratio

Color: -1 [ Lossless
Grayscale: Al [ Lossless

Multispectral: 10 Lossless
(O) Target Fils Size 1
Zoom Levels
(O Number Of Zoom Levels b

(® Target Thumbnail Size pixels
() Use Maximum Zoom Levels

Advanced

Weight: Sharpness: D
K-Weight: 025 Block Size:

Frequency Balance: Strip Height:
Optimizable Alpha Source: () Cpaque

(® Transparency Value
[ Apply RGB Color Transform to First Three Bands

Despeckling Dynamic Range Metadata Generation
(] Despeckle Output RGE Automatic Range w

Restore Program Defaults

oK Cancel

MrSID Generation 3 Mr5ID Generation 2 JPEG 2000 Appearance

x
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The preference options for MG3 and MG4 are the same with the following exceptions:

« Compression ratio preferences for MG4 include a setting for Multispectral, which by default is set to
Lossless, and a Lossless option can be selected individually for RGB and Grayscale.

« Advanced MG4 preference options include the Apply RGB Color Transform to First Three Bands
setting that allows you to specify that multispectral files whose first three bands are R, G, and B (in that
order) should have this transform run on them. (This option is enabled by default.)

« Advanced MG4 preference options include two Alpha Source options, one to specify that all pixels are
opaque and one to specify that the transparency or nodata value should be automatically detected from the

image metadata.

« Advanced MG4 preference options include Dynamic Range Metadata Generation options. For more

information on generating dynamic range metadata, see

on page 87.

« Advanced MG3 preference options include selecting either the 1-pass or 2-pass optimizer.

The MrSID Generation 2 preferences mirror the settings found in the MG2 format-specific options on the
Advanced Job Options dialog, with the exception that a default encode ratio can be specified for both color and
grayscale images. When you add a new MrSID Generation 2 encode job, the encode settings will initially be set to
the values declared in this tab.

Preferences

General
MrSID Generation 3

Compression Ratio

Color Images: al

Zoom Levels
(O) Number Of Zoom Levels

(® Target Thumbnail Size
() Use Maximum Zoom Levels

Advanced

Weight: I:I
G-Weight:
[] Block Size:

Restore Program Defaults

Mr51D Generation

LiDAR
i JPEG 2000

Grayscale Images: R

=

pixcs

Image Enhancement

[] Image Statistics

OK Cancel

Appearance

*
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JPEG 2000 Preference Options

If you want to use JPEG 2000 as your default file output, select either JPEG 2000 (GMLJP2) or JPEG 2000 (Part
1) from the Default Output File Format drop-down list on the General tab of the Preferences dialog.

The JPEG 2000 tab of the Preferences dialog has a number of basic JPEG 2000 options, as shown below. These
are the same options as those available for MrSID encoding. For more information on compression, see
Compression Overview on page 32. For more information on zoom levels, see Zoom Options on page 77.

Preferences *

General MrS1D Generation 4 LiDAR
MrSID Generation 3 MrSID Generation 2 ;

 Appearance

Compression Ratio

(® Compression Ratio  Color: 1 Grayscals: 1

(O) Encode Losslessly

Zoom Levels
() Number Of Zoom Levels

5
() Tanget Thumbnail Size 32
(® Use Maximum Zoom Levels

Despeckling
[] Despeckls Output

Advanced Settings...

Restore Program Defautts

oK Cancel
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Click the Advanced Settings button for further options.

Advanced JPEG 2000 Preferences >
Tie Size Flush Period:  |4096
Use Tile Size
Width:  [4ng6 Tile Length Markers:
Height:  |4096 Use Packet Length Markers
Tile Parts [] Use 5-7 Wavelet {lossy)
R Oc
P ion Order: RPCL ~
Codeblock Size LSRN
Width: Use GMLIP2 Metadata
Height:
Precincts
Use Precincts
Width:
Height:
Strip Height:
Qualty Layers: 0K Cancel

The parameters set on the tab and dialog shown above determine the default options that appear in the Advanced
Job Options dialog, which includes all of these. Changes made on the Advanced Job Options dialog only affect
the current job. To change the default settings, the parameters must be changed here.

For details about the advanced options see Advanced JPEG 2000 Options on page 92.
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LiDAR Preferences

Set default preferences for LIDAR data in the LiDAR tab of the Preferences dialog.
The LiDAR tab is divided into three panes:

o Compression

« Text Parsing

« Viewing

Preferences x

Mr5ID Generation 3 Mr5ID Generation 2 JPEG 2'[H]'D
General Mr51D Generation 4

Compression
Compression ratio: | 1.00 -1 Lossless
Block size: |4036
Omit custom LAS VLR metadata from output

Text Parsing

When a text file is added:
Prompt me to map columns

O Read the whole file to determine properties and enable previewin

| Manage custom fields...

Viewing
Mumber of points to render: | 500,000

Restore Program Defaults

oK Cancel

Compression
Set general compression preferences for LIDAR data.

Compression Ratio

How much you want to compress the data. Depending on the compression ratio, the resulting file may have fewer
points than the original point cloud. You can also select Lossless to create a compressed point cloud identical to
the input point cloud.

Block Size

The number of points to process and store at one time. Enter a large block size to increase the compression
speed. Enter a small block size to decrease memory usage. Valid values are from 2048 through 16384. The
default value is 4096.

Omit Custom VLR Metadata
Omit custom variable length record (VLR) metadata from LAS files. VLR metadata can include vendor-specific
data, user-specified data, and more.
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Set options for LIDAR point clouds stored as text files.

If you select this option, GeoExpress displays a dialog that you can use to select columns from the input text file
and map their values to standard fields like X, Y, Z, intensity, and more.

Select this option to have GeoExpress read all of the data in the input text file to determine properties like the point
cloud extents and to enable previewing the file.

Click the Manage Custom Fields button to see the default fields available for LIDAR point clouds and to create
custom fields. For example, you may want to create a custom field for a non-standard time format, for sensor
information, and more.

Set preferences for previewing LIDAR files.

Enter the number of points to display when you preview the point cloud. Enter a large value to display more detail.
Enter a low value to display point clouds faster. The minimum value is 50,000 and the default value is 500,000.

NOTE: While previewing a LiDAR file, you can change many settings temporarily; see on
page 20.

You can access log information for GeoExpress encoding and publishing operations in the log folder or directly
from the GeoExpress graphical user interface (GUI).

By default, text files containing log records are located in My
Documents\LizardTech\GeoExpress\9.5.5\1ogs. You can change the location of the log files in the
Preferences dialog.

The log folder contains separate logs for completed encoding and completed publishing jobs. If there are no log
files in the folder, it means no encoding or publishing jobs have been performed.

Encoding jobs are recorded in the GeoExpress_log.txt and session_log.txt files. GeoExpress_

log. txt is a persistent log that is appended with each encoding operation the user runs, whereas session_
log.txt is atemporary log that lists only the images that were encoded in the current job. It is overwritten upon
each new encoding operation.

Publishing jobs are recorded in the GeoExpressPublish_log.txt and publish_session_log.txt files.
As with their encoding counterparts, GeoExpressPublish_log. txt is a persistent record of publishing
operations that grows over time, while publish_session_log. txt records only the last completed publishing
job.
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Accessing and Using Session Records in the GUI

Viewing Encoding Results
A description of recently completed encoding projects can be viewed on the Output tab for a selected job.
1. Click the Output tab.
The session log appears.
2. Use the scroll bar to locate information about a specific image.

TIP: If you select a job in the Job List while you view the Output tab, the session log only shows
information about the selected job.

Exporting the Session Log
Click the Export Log button to save the session log for a selected job. You can export the sessionlogtoa . csv
or . txt file.

Viewing Results for a Publishing Operation

Upon completion of a publishing operation, the text window of the Publish Images dialog reports the results of the
publishing operation. This is the same information logged in the GeoExpressPublish_log.txt and
publish_session_log. txt files.

Copying Text from Log Entry
You may wish to copy information from the log entry and paste it elsewhere. Use the standard Windows copy
(Ctrl+C) and paste (Ctrl+V) shortcuts on any text in the Session Log text box of the Output tab.

Printing the Session Log
You can print out the entire session log. This is the same information that is displayed on the Output tab.
To print the session log, do one of the following:

o Press Ctrl+P when the Output tab is active.

« Choose File > Print Session Log.
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Following is an example of an output log entry. Details will be different depending on whether the output is to a file
system or to an Express Server. This example is for an image encoded to a file system.

0 6/27/2013 2:30:01 PM GeoExpress Session Log

GUI Version: 9.5.5.4567

Engine Version: 9.5.5.4567

Thursday, June 27, 2013 2:30 PM

Job ID Time Message Status
9 6/27/2013 6:07:37 PM Job name: 48120g5g.tif (4 threads)

9 6/27/2013 6:07:37 PM Operation: Encode image

9 6/27/2013 6:07:37 PM Start time: Thursday, November 2, 2017 6:07:37 PM

9 6/27/2013 6:07:37 PM 1Input properties:

9 6/27/2013 6:07:37 PM Input file name: \\Testimages\4bittiff\48120g5g.tif
9 6/27/2013 6:07:37 PM Input file type: TIFF

9 6/27/2013 6:07:37 PM Input image size: 17.9 MB (18750000 bytes)

9 6/27/2013 6:07:43 PM

9 6/27/2013 6:07:43 PM Output properties:

9 6/27/2013 6:07:43 PM Output file name: \\Testimages\4bittiff\48120g5g.sid
9 6/27/2013 6:07:43 PM Output file size: 917.4 KB (939415 bytes)

9 6/27/2013 6:07:43 PM Output file type: MrSID Generation 4

9 6/27/2013 6:07:43 PM Encoder version: 9.5.5.4567

9 6/27/2013 6:07:43 PM Target compression ratio: 20.00:1

9 6/27/2013 6:07:43 PM Actual compression ratio: 19.96:1

9 6/27/2013 6:07:43 PM

9 6/27/2013 6:07:43 PM Start time: Thursday, November 2, 2017 6:07:37 PM

9 6/27/2013 6:07:43 PM Finish time: Thursday, November 2, 2017 6:07:43 PM

9 6/27/2013 6:07:43 PM Total time: 5 seconds Succeeded
9 6/27/2013 6:07:43 PM
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In addition to image compression and manipulation operations you can perform the following operations:
« Publishimages to an Express Server.

« Use world files to specify georeferencing information forimages or generate world files for your images.
« Generate Esri AUX files for your images.

You can use GeoExpress to publish images directly to Express Server. Express Server supports MG4, MG3,
MG2, and JPEG 2000 images. Publishing is a one-time operation that does not use project files and does not alter
or delete the source images.
To publish existing images:

1. Inthe Tools menu, click Publish Images.

2. Addimages to the Source Images list: click Add Images To Publish, select images, and click Open, or
drag files into the Publish Images window.

3. When you finish adding images, click Publish to Express Server.
This opens the Express Server browser. For more information, see on
page 67.

4. Click OK to begin the publishing process.
The Publish Image dialog changes to display two progress bars. The bottom bar monitors the publishing
progress of an individual image and the top bar monitors the aggregate progress of all the images in a job.

To cancel the operation, click either Cancel All or Cancel Current Image.

The results of a publishing operation are displayed in the Publishing dialog. You can also view the results by
opening the log files stored in the following directory:

<User directory>\Documents\LizardTech\GeoExpress\9.5.5\1ogs
There are two log files related to publishing:

o GeoExpressPublish_log.txt is arunning log of all publishing operations.

o publish_session_log.txt is atemporary log that only lists the images published in the most recent
publishing operation.

For more information see on page 120.

A “worldfile” is a simple text file containing auxilliary georeferencing information for an image. It can be used to
georeference an image that has no georeferencing information within it, or to override existing georeferencing
information.

By convention, the filename for a world file is the same as the image it pertains to, with a different extension. The
three-letter extension is made up of the first and last characters of the image filename extension, followed by a w.
For example, the world file for a TIFF image named bainbridge.tif would be bainbridge.tfw; the world
file for a MrSID image named madison. sid would be named madison. sdw.
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Select World Files: Generate on the General tab of the Preferences dialog to automatically generate world files
upon encoding.

The world file format is six lines, each line containing a double precision value (represented in text). No additional
lines may be present. Leading and trailing whitespace are allowed.

The meanings of the six values are:

dimension of a pixel in map units in x direction

first rotation term

second rotation term

dimension of a pixel in map units in y direction

x-coordinate of the center of the upper-left pixel

y-coordinate of the center of the upper-left pixel

o ahrwd =

The y-dimension is, by convention, a negative value.

GeoExpress ignores the rotation term in most cases.

This is an example of a world file:
0.20000000
0.00000000
0.00000000

-0.20000000
780.10000000
219.90000000

This world file indicates the image resolution is (0.2, -0.2) and the upper-left is at (780.1, 219.9). The rotation terms
are zero, meaning no rotation is required.

Once you have added imagery to the Job List, you should check its extents on the Properties tab to make sure it
has the proper positioning. If it does not, check for the presence of world files in the source directory. If there are
world files, you can instruct GeoExpress to use them.
To specify that world files should be used:

1. Select animage in the Job List and click the Advanced button on the Properties tab.

This opens the Advanced Job Options dialog.

2. Select the Input tab.

3. Select Use World Files.

4. Click OK.

IMPORTANT: Use of world files removes the CRS or other georeferencing information from the image.

TIP: If no world file exists or if using world files does not result in correct positioning, you can change the
image extents by editing the image metadata. For more information see on
page 37.
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AUX files are used in older Esri products in the ArcGIS suite to specify coordinate reference system information.
They have the extension . aux. You may want to generate Esri AUX files if your imagery will be used in Esri
ArcGIS 9.1 or earlier.

To generate Esri AUX files:
1. Choose Options > Preferences.
2. Select Generate next to Aux XML Files in the Georeferencing group of options.
3. Click OK.

AUX files will now be generated upon encode and output to the same folder as the output images.
To stop generating Esri AUX files, deselect the Generate option.
By default Esri AUX files are not generated.
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GeoExpress enables your applications to use JPEG 2000 compression on geospatial images with the same level
of efficiency, metadata, and large-image support already available with MrSID. JPEG 2000 image compression
offers many of the advantages implemented in the MrSID format, plus the added benefits of being an international
standard (ISO/IEC 15444).

All of the basic options and some of the advanced options that are available for MrSID encoding are also available
for the JPEG 2000 format. Certain advanced operations such as creating and updating composites and optimizing
images are not available for JPEG 2000 encoding.

GeoExpress supports encoding JPEG 2000 files in two different modes, GMLJP2 and Part |. By default
GeoExpress uses GMLJP2, which is the best option for most workflows. For applications that do not support
GMLJP2, the Part | mode generates files that do not use any Part Il extensions. GMLJP2 metadata is not
available in this mode. Other encoding features, such as the use of NPJE profiles and other metadata forms, are
still available. Use the Part | mode only when you are sure that the image user's workflow entails applications that
cannot read GMLJP2 files.

The two modes are included as options in the Output Format drop-down list. For convenience when creating
mosaics, this drop-down list also appears on the Create New Mosaic dialog.

JPEG 2000 encoding utilizes the same data cartridge deduction mechanism that MrSID encoding does (see
on page 149 and on page 143). Operations involving only MrSID
and/or JPEG 2000 input files do not decrement the cartridge.

GeoExpress allows Geography Markup Language (GML) metadata to be added to JPEG 2000 (JP2) imagery to
comply with the Open Geospatial Consortium (OGC) GMLJP2 standard.

GML (Geography Markup Language) is an open, XML-based specification for representing geographic information
including geographic features, coverages, observations, topology, geometry, coordinate reference systems, units
of measure, time and other values. Because it is an XML grammair, it is both extensible and adaptable to any
application within the broad geospatial field.

As a wavelet-based image compression format, JPEG 2000 (JP2) is capable of handling images into the gigabyte
range and beyond. But until recently, JP2 was not particularly suited to the needs of the geospatial community
because it didn’t have a designated geospatial metadata standard. However, because the JPEG 2000 format
allows for the inclusion of XML data, GML has emerged as the ideal partner for JPEG 2000 imagery, bridging the
gap between JP2 and GIS.

GMLJP2 is the specification that standardizes that partnership and opens the door for greater interoperability
between your imagery and the thousands of current and future geospatial applications that might use it. Containing
its own geographic metadata, your JP2 imagery becomes “spatially aware” and is thus of increased value in
geospatial applications. Prior to the adoption of GMLJP2, the lack of a geospatial metadata standard meant that
applications and viewers may or may not have been able to read geospatial metadata in a JPEG 2000 file.

The GMLJP2 specification was officially adopted in February 2006 by the Open Geospatial Consortium (OGC) as
an open standard for representing geographic information in JPEG 2000 imagery. LizardTech supports open
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standards and is committed to the success of the GMLJP2 specification.

Jointly proposed and developed by LizardTech, Galdos Systems and a consortium of forward-looking aerospace
and technology companies, GMLJP2 represents the most advanced means of including geographic metadata
within compressed geospatial imagery and making that information useful in downstream applications now and in
the future.

GeoExpress already offers the most complete and easy-to-use implementation of the open JPEG 2000 standard.
Now, your JP2 imagery encoded with GMLJP2 metadata is secure for the future because, like JPEG 2000, the
GMLJP2 specification is an open, non-proprietary standard.

NOTE: Some applications that support JPEG 2000 do not support all of the features that are required to
implement the GMLJP2 standard. For more information, see on the previous

page.

The GML option is available among the metadata control settings of the advanced JPEG 2000 options (see
on page 95).

Learn more about the GML and GMLJP2 specifications at http://www.opengeospatial.org/specs/?page=specs.

The GMLJP2 Application Schema version 3.1.1. can be found at http://schemas.opengis.net/gml/.

JPEG 2000 images can be created with an essentially unlimited number of bands, so multispectral output can be
created from multispectral input without having to go through an output color space. For JPEG 2000 encoding, the
color compositor allows multibanded images to be created from files representing individual bands.

For more information see on the next page.

JPEG 2000 supports the use of an alpha band or channel for masking out portions of an image. GeoExpress
supports creating alpha bands in JPEG 2000 files where the TIFF or JPEG 2000 source image has an alpha band.

When an image that has an alpha band is encoded to the JPEG 2000 format, GeoExpress encodes the alpha band
losslessly to preserve its integrity.

NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does not additionally
decrement your data cartridge. Your encode job will be metered the same with or without alpha bands.
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GeoExpress allows the creation of multiband JPEG 2000 files from a collection of single-band grayscale image
files. The input files must all have the same dimensions, resolution, bit depth, and geographic positioning. Empty
bands are allowed, and treated as zero data.

1. Select Add color composite image to encode from the File menu.
This opens the Add Color Composite Image dialog.

2. Select a color space for the image from the drop-down menu, either RGB or Multispectral. RGB populates
the list box with editable red, green, and blue bands. Multispectral populates the list box with bands that
range from 1 to n. You can change the number of bands in a multispectral image by clicking Edit number
of bands and typing in a new value.

3. Toadd animage file to a band, select the desired band and then click Edit file name. This opens the Edit
File Name dialog.

4. Typeinafile name or click Browse to bring up a file browser. If you want to remove a file from a given
band, simply clear the text from the file name field. A color composite image must have at least one band
specified.

For information on NITF image segments in color composite images, see
on page 130.
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Creating NITF images requires a NITF license. This chapter offers information about how to create National
Imagery Transmission Format (NITF) images with GeoExpress.

The acronym NITFS sometimes seen refers to the NITF standard, which was created by the Department of
Defense as a means of formatting digital imagery and imagery-related products and exchanging them among
members of the intelligence community, the Department of Defense (DOD), and other government departments
and agencies. NITF was created partly because government agencies needed a single common image
representation that supported certain metadata features and workflows. While it is called an image format, NITF is
perhaps more precisely described as a file format that wraps image files and metadata about those files.

The NITF format requires information is entered on numerous metadata fields on several forms. For NITF JPEG
2000 encoding, you can edit the metadata fields—as well as the LizardTech metadata tags—in the Metadata
Manager.

For details about how GeoExpress saves NITF metadata, see on page 43.

NOTE: When you use a NITF file as an input image, sometimes the band order of the image does not
match the band order in the metadata. If this is the case, GeoExpress changes the order of bands in output
images to match the metadata band order.

GeoExpress supports the following NITF standards:
« version 2.1 of the NITF file format (MIL-STD-2500C, May 2006, plus change outlined in RFC NTB-038) for
writing
« versions 2.1 and 2.0 of the NITF file format for reading
« version 01.10 of the BIIF Profile for JPEG 2000 (BPJ2K01.10, April 2009) including the J2KLRA TRE
« version 2.1 of the Commercial Dataset Requrements Document (NCDRD STDI-0006, February 2010)
« version 1.0 of the Implementation Practices of NITF (STDI-0005 IPON v1.0, August 2007)
« version 00.20 of the JPEG 2000 Test Plan (BPJ2K01.00 Test Plan Draft Version 00.20, March 2010)

NOTE: These NITF standards may change and future releases will track the evolution of these standards
to ensure interoperability.

NOTE: Support for encoding NITF images is available for GeoExpress. Contact your LizardTech
representative (https://www.lizardtech.com/sales) to purchase the NITF Extension for GeoExpress.

You may select NITF 2.1 as an output format from the Output Format drop-down list, which appears in two
places:

« onthe Properties tab for a selected job, and

« inthe Create New Mosaic dialog.

Two different types of NITF encoding are available: raw (uncompressed) and JPEG 2000.
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Because raw files are uncompressed, when you select NITF 2.1 (Raw) as the output format encode ratio, target
file size and other options are not available, and there is no Format-Specific tab in the Advanced Job Options
dialog. Metadata editing is not supported for raw NITF encoding.

When you select NITF 2.1 (JPEG 2000) as the output format, the source imagery is encoded to JPEG 2000 and all
of the JPEG 2000 encoding options become available. The options common to MrSID formats are displayed on
the Properties tab. These and all of the options specific to JPEG 2000 are available on the Format-Specific tab
of the Advanced Job Options dialog. For more information about these options, see

on page 92.

You may specify NITF 2.1 as your default output format by selecting it from a drop-down list on the General tab of
the Preferences dialog. For more information, see on page 109.

To be valid, the image segments comprising an incoming NITF file must be mosaickable. They must have
compatible resolutions, color spaces, and datatypes, and must all fall on the same coordinate space.

To view the image segments in a multisegment NITF image, right-click on the job in the Job List and select
NITF Image Segments. You can remove segments from the output image by deselecting each image segment.

If no segments are selected, the input image is considered invalid.
When the image is encoded, the selected segments are mosaicked into a single flat image.

NITF mosaic tiles behave the same way as other image tiles in the encoding process; the selected segments of
each tile are mosaicked together first, and then the tiles are mosaicked together for the final output.

To use a multisegment NITF file as a component band in a color composite image:
1. Choose File > Add color composite image to encode.
This opens the Add Color Composite Image dialog.
2. Select RGB or Multispectral from the Color Space drop-down list at upper right.
Select a band and click Edit File Name.
4. Enter afile name or click Browse to locate the file, then click OK.
If the file you selected is a multiple image segment NITF file, the Image Segment Selector dialog opens.
5. Select which 1-banded image segment of the selected NITF file you wish to use as the “active segment” for
the selected band, then click OK.

w

You can change the active segment in a color composite image at any time.
To change the active segment:
1. Choose File > Add color composite image to encode.
2. Click Select Image Segment.
3. Select a different 1-banded image segment from the drop-down list and click OK.
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To create a NITF file with multiple image segments, the individual segments must be mosaickable. This is

because they must be placed on a common grid. All of the mosaicking rules for other kinds of images apply to
multisegment NITF images. For more information on mosaics, on page 98.

To create a multisegment NITF file:
1. Click the Create New Mosaic button |:| on the toolbar.

This opens the Create New Mosaic dialog.
2. Select NITF as the output format.
3. Select Create multiple image segments.

NOTE: Multisegment NITF encoding supports up to 999 image segments. If you attempt to encode more
than 999 tiles as a multisegment NITF file, an error message informs you that you have exceeded the
maximum number of image segments and asks whether or not you would like to flatten the input tiles first.
Clicking Yes will result in a single image segment NITF file. This is equivalent to deselecting the Create
multiple image segments option. Clicking No cancels the addition of that tile.
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Calculating Memory Usage

The amount of memory that GeoExpress uses to perform operations depends on the following factors:
« The image manipulation operations that you perform.
« The operating system.
« Theimage input format.
« The number of bands in the output image.
« The number of threads and concurrent jobs.
« The strip height and block size.

Of these factors, you can control the strip height and the block size that GeoExpress uses.
Memory usage is constant over the length of the encode operation.

Estimated Memory Usage Display
The Estimated Memory Usage value is displayed on the Properties tab except when the output format is other
than MrSID or the 1-pass optimizer is used. GeoExpress uses the 2-pass optimizer by default.

MG3 and MG4 Memory Usage

The following formula describes the approximate amount of memory used by GeoExpress to compress a single
image to the MrSID Generation 4 (MG4) or MrSID Generation 3 (MG3) format:

Memory = ((8 + 4 x BlockSize + MIN(StripHeight, BlockSize)) x 4 +
StripHeight) x NumBands x Width
The following list describes the variables used by the formula:

« Memory is the estimated memory usage in bytes.

e You set BlockSize onthe Format-Specific tab of the Advanced Job Options dialog. For more
information on block size, see Advanced MG4 Options:Block Size on page 86.

o MIN(StripHeight, BlockSize) evaluates the values for the strip height and block size and equals
whichever value is smaller.

e You set StripHeight onthe Format-Specific tab of the Advanced Job Options dialog. For more
information on strip height, see Advanced M G4 Options:Strip Height on page 87.

« NumBands is the number of bands in the image to be encoded—typically 1 or 3. (This value is noted in the
Properties tab.)

o Width is the width of the input image in pixels. (This value is noted in the Properties tab.)

-132-



Appendix A - Technical Information

The following formula describes the approximate amount of memory used by GeoExpress to compress a single
image to the MrSID Generation 2 (MG2) format:

Memory = ((8 + 4 x BlockSize + 64) x NumBands x Width x 4) +
(0.005 x ExpectedOutputFileSize)
o Memory is the estimated memory usage in bytes.

o BlockSize is set by the user on Format-Specific tab of the Advanced Job Options dialog. For more
information on block size, see on page 91.

« NumBands is the number of bands in the image to be encoded—typically 1 or 3. (This value is noted in the
Properties tab.)

o Width is the width of the input image in pixels. (This value is noted in the Properties tab.)

o ExpectedOutputFileSize is the target file size. (This value is noted in the Properties tab.)

The size of a mosaic is calculated from the nominal size of the output mosaic. For rasterimages, the nominal size
is the product of the image width, the image height, the number of bands, and the number of bytes per band. Also
for raster images, the nominal size assumes that all portions of the image include valid data, whether or not this is
the case. For LIDAR point clouds, the nominal size is a measure of the number of points in the point cloud and the
number of fields for each point.

As aresult, the size is not adjusted for the presence of transparency regions in the mosaic, such as when:
« amosaic of non-contiguous images is created

« the output image for a contiguous mosaic does not conform to a rectangular shape

In these cases, the transparency regions in the output image are included in the mosaic size. Also in these cases,
the estimated output file size may be considerably larger than the actual output file size.

NOTE: The cost charged to the data cartridge is not always equal to the mosaic size. It is calculated from
the sum of the nominal sizes of the input tiles rather than from the nominal size of the resulting mosaic.
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GeoExpress calculates the resultant image filesize as part of the encoding process, taking into account the user-
defined compression ratios for inside and outside the area of interest. Selecting the Weight option allows you to
specify Lossless compression or to set a target Compression Ratio for the area of interest. (The outside area
will be encoded at the compression ratio specified in the job options.)

As an example, consider a 1-band (grayscale), 8-bit input image measuring 1000 x 1000 pixels. The user specifies
compression for this image at 100:1. An area of interest measuring 100 x 100 pixels is then defined within the
image, and the compression ratio inside the area of interest is set at 10:1.

100 3 100 A2 ta be
compressed at 10:1

&

&

1000 x 1000 image to be
compressed st 100:1

Based on these dimensions and specifications, GeoExpress makes the following calculations:
AOI compression ratio (CRpg) = 10
Base compression ratio for the image (CRger) = 100
Area of the entire image (Areaq,) is 1000 x 1000 pixels = 1,000,000 pixels
Area of the AOI (Areapg,) is 100 x 100 pixels = 10,000 pixels
Area of the portion of the image surrounding the AQI (Areagne,) is 1,000,000 pixels - 10,000 pixels
= 990,000 pixels

GeoExpress then makes the following filesize calculations:
Filesize of the AOI (FSpp)) = Areann/ CRpp; = 10,000/ 10 = 1000 bytes
Filesize of the “outside” (FSqtner) = Areagther / CRother = 990,000/ 100 = 9900 bytes
Total filesize (FStotal) = FSpg) + FSgther = 1000 + 9900 = 10,900 bytes

GeoExpress then calculates the overall compression ratio:
Compression ratio = Areayq, / FSigtg = 1,000,000/ 10,900 = 91.73

In order to calculate the overall target filesize for the encode process the compression ratio for the overall image is
set t0 91.73. The target filesize thus becomes:
1,000,000/ 91.73 = 10,901 bytes

NOTE: This calculated filesize appears on the Properties panel for the image once you close the Area of
Interest dialog. The actual output is reported in the GeoExpress log file on the Output tab of the
Properties panel (see on page 120).

—134—



Appendix A - Technical Information

Header Files for BIP, BIL and BSQ Images

A BBB image consists of two files, a binary file containing only the raw sample values of the image and a text file
describing the image properties. The raw data may be organized in one of three layouts: “band-interleaved by pixel”
(BIP), “band-interleaved by line” (BIL), and “band sequential” (BSQ). The three formats are collectively referred to
as the BBB file format.

Because BBB files only contain raw data with an easily editable header format, they are often used as a “least
common denominator” interchange format. However, there is no set standard for the keywords that may be
contained in the header. This document describes the header format that GeoExpress supports.

GeoExpress recognizes four file extensions: . bip, .bil, .bsq, and . bbb. The first three imply the layout is
BIP, BIL, or BSQ respectively; the . bbb extension implies the default layout, which is BIP. The header file for a
BBB image has the same name as the image, but with a . hdr extension.

Header Syntax

The header file is a simple text file containing keywords and their associated value, one keyword/value(s) set per
line. All keywords and values are case-insensitive. Blank lines are ignored. Leading and trailing whitespace is
ignored. A line that begins with a # character, possibly preceded by whitespace, indicates a comment line.
Comment lines are ignored.

Supported Keywords
The following table lists supported keywords and their allowed values.
KEYWORD DESCRIPTION NOTES

BANDGAPBYTES Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

BANDROWBYTES Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

BANDS The number of bands in the
image (sames as NBANDS)

BYTE_ORDER Endianness interpretation of Allowed values: MOTOROLA, M, BIG, BIGENDIAN, NA
data The value NA may only be used if the number of bands
is 1

Default: host byte order

BYTEORDER same as BYTE_ORDER

COLORSPACE The color space of the image Allowed values: GREY, GREYA, GRAY, GRAYA, GREYSCALE,
GREYSCALEA, GRAYSCALE, GRAYSCALEA, RGB, RGBA,
CMYK, CMYKA, MULTISPECTRAL, MULTISPECTRALA
Default: GRAY for 1-banded images, RGB for 3-banded
images, otherwise MULTISPECTRAL

CoLS Width of the image, in pixels

(same as NCOLS)
DATATYPE The data type of the samples Allowed values: U8, U16, S8, S16, F32

Default: U8
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KEYWORD DESCRIPTION NOTES
DYNAMICRANGELEVEL |The midpointof the range of Allowed values: a single floating-point value (applies to
the data all bands)
Default: (none)
DYNAMICRANGEMAX The maximum of the range of Allowed values: a single floating-point value (applies to
data all bands)
Default: (none)
DYNAMICRANGEMIN The minimum of the range of Allowed values: a single floating-point value (applies to
data all bands)
Default: (none)
DYNAMICRANGEWINDOW |The size of the range of the Allowed values: a single floating-point value (applies to
data all bands)
Default: (none)
E_SQUARED Sphere eccentricity squared, Corresponding metadata tags are created, but the actual
for georeferencing values are not used in setting the geocoordinates of the
inputimage
INTERLEAVING Same as LAYOUT
LAYOUT The data layout; use of this Allowed values: BIP,BIL,BSQ, or NA
keyword overrides the layout The value NA may only be used if the number of bands
implied by the filename is 1
extension Default: BIP
MAP_UNITS Measurement unit for Corresponding metadata tags are created, but the actual
georeferencing values are not used in setting the geocoordinates of the
inputimage
NBANDS The number of bands in the Allowed values: 1-65535
image (same as BANDS) Default: (none; this keyword is required)
NBITS The number of bits used per Allowed values: 1 to (total number of bits per sample)
sample Default: the total number of bits per sample
NCOLS Width of the image, in pixels Allowed values: 1 to 237 (2,147,483,648)
(same as COLS) Default: (none; this keyword is required)
NROWS Height of the image, in pixels Allowed values: 1 to 231 (2,147,483,648)
(same as ROWS) Default: (none; this keyword is required)
PIXEL_HEIGHT Size of a pixel in the y- Allowed values: (any floating point value)
direction, for georeferencing Default: (none)
(same as YDIM)
PIXEL_WIDTH Size of a pixel in the x- Allowed values: (any floating point value)
direction, for georeferencing Default: (none)
(same as XDIM)
PROJECTION_NAME Name of the projection system, |Corresponding metadata tags are created, but the actual
for georeferencing values are not used in setting the geocoordinates of the
inputimage
PROJECTION_ Numeric projection Corresponding metadata tags are created, but the actual
PARAMTERES parameters, for georeferencing |values are not used in setting the geocoordinates of the
inputimage
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KEYWORD

DESCRIPTION

NOTES

PROJECTION_ZONE

Projection zone number, for
georeferencing

Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

RADIUS Sphere radius, for Corresponding metadata tags are created, but the actual
georeferencing values are not used in setting the geocoordinates of the
inputimage
ROWS Height of the image, in pixels

(same as NROWS)

SEMI_MAJOR_AXIS

Semi-major axis, for
georeferencing

Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

SEMI_MINOR_AXIS

Semi-minor axis, for
georeferencing

Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

SKIPBYTES

Number of bytes to skip at the
start of an image file

Allowed values: 0 to the size of the image (in bytes)
Default: 0

This is especially useful for raw formats that contain a
fixed number of header bytes at the start of the data file.

SPHEROID_NAME

Name of the projection system,
for georeferencing

Corresponding metadata tags are created, but the actual
values are not used in setting the geocoordinates of the
inputimage

TOTALROWBYTES

Not currently supported; this entry is ignored.

UL_X_COORDINATE

Upper left x-position, for
georeferencing (same as
ULXMAP)

Allowed values: (any floating point value)
Default: (none)

UL_Y_COORDINATE

Upper left y-position, for
georeferencing (same as
ULYMAP)

Allowed values: (any floating point value)
Default: (none)

ULXMAP Upper left x-position, for Allowed values: (any floating point value)
georeferencing (same as UL _ Default: (none)
X_COORDINATE)
ULYMAP Upper left y-position, for Allowed values: (any floating point value)
georeferencing (same as UL _ Default: (none)
Y_COORDINATE)
WORDLENGTH Number of bytes per sample Allowed values: 1 or 2
Default: 1, unless overridden by DATATYPE
XDIM Size of a pixel in the x- Allowed values: (any floating point value)
direction, for georeferencing Default: (none)
(same as PIXEL_WIDTH)
YDIM Size of a pixel in the y- Allowed values: (any floating point value)

direction, for georeferencing
(same as PIXEL_HEIGHT)

Default: (none)
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These keywords are required: NBANDS (or BANDS), NCOLS (or COLS), and NROWS (or ROWS). All other keywords
have default values.

If dynamic range is used, either both DYNAMICRANGEMIN and DYNAMICRANGEMAX must be set or both
DYNAMICRANGEWINDOW and DYNAMICRANGELEVEL must be set.

This BBB header file describes a 640 x 480 RGB colorimage, using an unsigned 16-bit data sample.
NROWS 4860
NCOLS 640
NBANDS 3
DATATYPE U16

Note that some of the header syntax supported by GeoExpress may not be supported by other vendors’
BIP/BIL/BSQ implementations. In particular, the following features and keywords may be somewhat specific to
LizardTech:

« interpretation of . bbb extension as meaning layout of BIP

« support for comment lines

o the COLORSPACE keyword

e the DYNAMICRANGEMIN, DYNAMICRANGEMAX, DYNAMICRANGEWINDOW, and DYNAMICRANGELEVEL

keywords

GeoExpress reads and maintains accurate georeferencing forimages in USGS DOQ format. DOQ files contain
metadata information in an ASCII header file contained within the file.

GeoExpress can read images in both old and new DOQ header formats. The less common “exponential” DOQ
header format is not supported.

An example of the current standard USGS DOQ header format can be found in this U.S. Geological Survey
standards document (https://nationalmap.gov/standards/pdf/2DOQ1296.PDF).

For more Digital Orthophoto Standards documents from the USGS, visit
https://nationalmap.gov/standards/dogstds.html.
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Supported TIFF Compression Types

The Properties tab in the GeoExpress main window provides information about the input images used in a project.

Information about any TIFF compression technique used in the input images is also provided, even if the

technique is not supported by GeoExpress.
The following table lists TIFF compression types displayed by GeoExpress and whether the compression type is

supported by GeoExpress.

COMPRESSION SUPPORT

CCITT Group 3 fax No
CCITT Group 4 fax No !
LZW (Limpel-Ziv-Welsh) Yes
Old JPEG No
Standard JPEG (including 12-bit) |Yes
NeXT run-length encoding No
CCITT run-length encoding Yes 2
Pixar image format No
Desktop color separation No
Standard JBIG No
Pack-bits encoding Yes
ThunderScan No
Deflate method (PNG) No

1 GeoExpress is able to process single-page Group 4 TIFF files, but encoding this format is not recommended.

2 There are many different types of run-length encoding. Some methods are supported; others are not.
GeoExpress works best with uncompressed images.
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Following is the header metadata from a sample MrSID image.

Record @:

Tag: GEOTIFF_CHAR::GTModelTypeGeoKey

Type: ASCII[1]

Data:

[0]: ModelTypeProjected

Record 1:

Tag: GEOTIFF_CHAR: :GTRasterTypeGeoKey
Type: ASCII[1]

Data:

[0]: RasterPixelIsArea

Record 2:

Tag: GEOTIFF_CHAR::GeogEllipsoidGeoKey
Type: ASCII[1]

Data:

[0]: Ellipse_GRS_1980

Record 3:

Tag: GEOTIFF_CHAR: :GeogGeodeticDatumGeoKey
Type: ASCII[1]

Data:

[0]: Datum_North_American_Datum_1983
Record 4:

Tag: GEOTIFF_CHAR::ProjLinearUnitsGeoKey
Type: ASCII[1]

Data:

[0]: Linear_Meter

Record 5:

Tag: GEOTIFF_CHAR::ProjectedCSTypeGeoKey
Type: ASCII[1]

Data:

[06]: PCS_NAD83_UTM_zone_10N

Record 6:

Tag: GEOTIFF_NUM::1024::GTModelTypeGeoKey
Type: UINT16[1]

Data:

[6]: 1

Record 7:

Tag: GEOTIFF_NUM::1025::GTRasterTypeGeoKey
Type: UINT16[1]

Data:

[0]: 1

Record 8:

Tag: GEOTIFF_NUM::2050: :GeogGeodeticDatumGeoKey
Type: UINT16[1]

Data:

[0]: 6269

Record 9:

Tag: GEOTIFF_NUM::2056: :GeogEllipsoidGeoKey
Type: UINT16[1]

Data:

[@]: 7019

Record 10:

Tag: GEOTIFF_NUM::3072::ProjectedCSTypeGeoKey
Type: UINT16[1]

Data:

[0]: 26910

Record 11:

Tag: GEOTIFF_NUM::3073::PCSCitationGeoKey
Type: ASCII[1]

Data:

[@]: Universal Transverse Mercator; North American 1983; GRS80; Zone Number 1©N
Record 12:

Tag: GEOTIFF_NUM::3076::ProjLinearUnitsGeoKey
Type: UINT16[1]

Data:

[0]: 901

Record 13:

Tag: GEOTIFF_NUM::3080::ProjNatOriginLongGeoKey
Type: FLOAT64[1]

Data:
[0]: -123.000000
Record 14:

Tag: GEOTIFF_NUM::3081::ProjNatOriginLatGeoKey
Type: FLOAT64[1]
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Data:

[0]: ©.000000

Record 15:

Tag: GEOTIFF_NUM::3082::ProjFalseEastingGeoKey
Type: FLOAT64[1]

Data:

[0]: 500000.000000
Record 16:

Tag: GEOTIFF_NUM::3083::ProjFalseNorthingGeoKey
Type: FLOAT64[1]

Data:

[0]: ©.000000

Record 17:

Tag: GEOTIFF_NUM::3092::ProjScaleAtNatOriginGeoKey
Type: FLOAT64[1]

Data:

[0]: ©.999600

Record 18:

Tag: IMAGE::INPUT_FILE_SIZE
Type: FLOAT64[1]

Data:

[0]: 75121662.000000
Record 19:

Tag: IMAGE::INPUT_FORMAT
Type: ASCII[1]

Data:

[0]: GeoTIFF

Record 20:

Tag: IMAGE::INPUT_NAME
Type: ASCII[1]

Data:

[0]: H:\Seattle\lotet279287.tif
Record 21:

Tag: IMAGE::WIDTH

Type: UINT32[1]

Data:

[0]: 5ee00

Record 22:

Tag: IMAGE::HEIGHT

Type: UINT32[1]

Data:

[0]: 5ee00

Record 23:

Tag: IMAGE::COLOR_SCHEME
Type: UINT32[1]

Data:

[0]: o

Record 24:

Tag: IMAGE::DATA_TYPE
Type: UINT32[1]

Data:

[0]: o

Record 25:

Tag: IMAGE::NO_DATA_VALUE
Type: UINT8[3]

Data:

[0]: o

[1]: e

[2]: o

Record 26:

Tag: IMAGE::TRANSPARENT_DATA_VALUE
Type: UINT8[3]

Data:

[0]: o

[1]: o

[2]: o

Record 27:

Tag: IMAGE::XY_ORIGIN
Type: FLOAT64[2]

Data:

[0]: 527900.150000

[1]: 5230199.850000
Record 28:

Tag: IMAGE::X_RESOLUTION
Type: FLOAT64[1]

Data:

[0]: ©.300000

Record 29:
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Tag: IMAGE::Y_RESOLUTION

Type: FLOAT64[1]

Data:

[0]: ©.300000

Record 30:

Tag: IMAGE: :WKT

Type: ASCII[1]

Data:

[06]: PROJICS["NAD83 / UTM zone 1ON",GEOGCS["NAD83",DATUM[ "North_American_Datum_1983",
SPHEROID["GRS 1980",6378137,298.2572221010002, AUTHORITY["EPSG","7019"]],
AUTHORITY["EPSG","6269"]],PRIMEM[ "Greenwich",0],UNIT["degree
(supplier to define representation)",0.01745329251994328]
,AUTHORITY["EPSG","4269"]],PROJECTION[ "Transverse_Mercator"],

PARAMETER[ "latitude_of_origin",@],PARAMETER["central_meridian",-123],
PARAMETER["scale_factor",0.9996],PARAMETER[ "false_easting",
500000],PARAMETER[ "false_northing",0],UNIT[ "metre",1,

AUTHORITY[ "EPSG","9001"]],AUTHORITY[ "EPSG","26910"]]
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Data Cartridges

If you have a copy of GeoExpress Standard Edition, you may need to install a data cartridge before being able to
encode images.

To order a data cartridge, contact your LizardTech sales representative at https://www.lizardtech.com/sales/.

The information below tells you how to access cartridge information and add a cartridge.
For more information see Installing Data Cartridges on page 14 and Data Cartridge Gauge on page 17.

Data Cartridge information

The License and Cartridge Management dialog displays cartridge information and lets you add a cartridge or
connect to an Express Cartridge Manager Server as shown below.

To access License and Cartridge Management choose Options > Licensing.

B License and Cartridge Management - [m| X
Serial Number
@ Valid serial number for GeoExpress Standard/Tools Edition 7]
Licensing
Locking Code
License Code .
License Server [ NiTF
@ Local license [7]
Cartridges
o
Add Cartridge
Server
& 10.485,760 KB on local cartridge remaining [7]
View Logs...| [Send Activation Request % oK
Cartridges

The Cartridges panel shows the Cartridge ID or, if a Data Cartridge Server is being used to share a data cartridge,
it shows the address of the Server. You can only use either a local cartridge or a cartridge server, not both.

The bottom of the panel shows how much data remains on your cartridge.

To add a local data cartridge that you have received from LizardTech, click Importin the Cartridges panel, select
the . 1tc file and click Open.
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The number of megabytes deducted for a job is approximately equal to the nominal size of the image or point
cloud. For raster images, you can calculate the nominal size with the following equation:

width x height x number of bands x bytes per band
For LIDAR point clouds, the nominal size is a measure of the number of points in the point cloud and the number of
fields for each point.
For mosaics, the cost is calculated from the sum of the nominal sizes of the input tiles rather than from the

nominal size of the resulting mosaic. This means that in cases where a mosaic of non-contiguous images is
created you are not charged for the areas without tiles.

NOTE: Because the charge is based on the nominal size of the image rather than the physical input file
size, the encoding of compressed images such as JPEG deducts the cartridge by the same amount as the
encoding of input images that are not compressed.

Floating licenses enable a user on a networked computer to lease or “check out” a GeoExpress license for the
period of time they are working. When the user exits the program, the license is returned to the License Server and
available for another user.

The LizardTech License Server runs as a service named LizardTech License Server.

The License Server is installed from the GeoExpress installation DVD. You must have administrator rights to
install the License Server.

Toinstall the LizardTech License Server:
1. Insert the GeoExpress DVD inthe DVD drive. The DVD browser screen appears. (Note: If the DVD
browser does not appear, double-click the AUTORUN . HTA file found on the DVD).
2. Select License Server w/Tools and Documentation, then follow instructions until finished. By default,
the product is installedinC: \Program Files\LizardTech\License Server.
The installation creates the LizardTech License Server service.

On Windows, the License Server Utility will start, allowing you to request and add floating licenses.

For additional information on the setup and usage of LizardTech License Server, see the SentinelLM System
Administrator's Online Guide installed with your License Server.

To add a floating license on Windows, use the License Server Utility. This utility is launched upon installation of
the License Server. You can also choose Start > LizardTech > Add Floating License.
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To request a floating license:

1.

Start the License Server Utility.

Choose Start > LizardTech > Add Floating License.

Click Request a License.

This will open your web browser to the LizardTech Product Activation page.
Enter the requested information and click Submit.

m For LizardTech Product, select GeoExpress.

m Select New License.

m Paste yourlocking code.

m Use the Additional Information field to give any additional information about your license usage.
For example, if you have purchased 10 floating licenses but need to deploy them among multiple
locations, let us know how you will distribute these (“2 licenses for our Portland office, 3 for Seattle,
and 5 for London.”) This way we can send you the license files you need for each location.

You will receive an email with a license file from LizardTech, usually within one business day. Save the license file
on the system where the License Server is running, then follow the steps below to add your license to the License
Server.

To add a license file to the License Server:

1.
2.
3.

Start the License Server Utility.

Click Import.

Navigate to and select the downloaded license file (* . 1ic), then click Open.

The License Server Utility will validate the license and display what type of license you imported.
Click Add License to add the new license to your License Server’s pool of available licenses.
Click Done to exit the License Server Utility.

Once you have installed the License Server you must acquire a license code from LizardTech. A license code is
required for each License Server you add to your network.

To add a license for a License Server on Linux:

1.

Run the echoid. exe file to display your locking code. On Linux this file is located by default in
/usr/local/LizardTech/LicenseServer/. Record this value.
Copy your locking code, then visit https://www.lizardtech.com/support/product-activation/.
Enter the requested information and click Submit.
m For LizardTech Product, select GeoExpress.
m Select New License.
m Paste yourlocking code.
= Use the Additional Information field to give any additional information about your license usage.
For example, if you have purchased 10 floating licenses but need to deploy them among multiple
locations, let us know how you will distribute these (“2 licenses for our Portland office, 3 for Seattle,
and 5 for London.”) This way we can send you the license files you need for each location.
You will receive a response from LizardTech within one business day..
When you receive your license code, run the 1s1ic. exe file in the same Tools directory:
Open acommand line interface and enter 1slic.exe -A "license code" (where license codeis
the code given to you by LizardTech; note that the quotes are required).
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You can manually add the locking code to the file
/usr/local/LizardTech/LicenseServer/licenseserver/lservrc.

To manually start the License Server, runthe . /1serv utility.

While using LizardTech License Server on a UNIX platform, you must be logged in as root to:
« Start the License Server
« Change distribution criteria (for redundant servers)
« Shut down the License Server
« Turnlicense server logging on and off
« Turn token borrowing on and off
« Add or delete license servers from the redundant license server pool

Only the user who started the license server can stop the license server. It is strongly recommended that only the
root user administer the license server.

In most cases, you will not be aware of the floating license leasing process because it will occur invisibly and
automatically. In these cases, the user need only install the LizardTech License Server. However, there are
situations where the end-user will have to adjust their settings to ensure that they are using the correct license, as
for example when a client system has access to both a standalone and a NITF-enabled network version of the
same license, or if there are two different versions of a license on the license server and the user would prefer one
over the other (i.e. NITF-enabled versus non-NITF-enabled). In these cases, GeoExpress by default prefers the
non-NITF version if one is available. To change this you must set your licensing options so that preference is
given to the NITF-enabled license.
To specify a preferred License Server:

1. Choose Options > Licensing.

This opens the License and Cartridge Management dialog.

2. Enterthe IP address or network name of the license server.
To specify a preference for a NITF-enabled license, select NITF.
4. Click OK.

w
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As the license server administrator, you may control the percentage of available floating license seats that can be
used as commuter licenses. That is, the number that can be checked out and used without a connection to the
network.

To configure licenses, set your LSERVOPTS system environment variable with the following:
-com <percentage>

where <percentage> is an integer between 0 and 100. Do not include a percent sign. This percentage value
determines the number of licenses that can be checked out as commuter licenses.

For example, specifying -com © ensures that no floating licenses can be checked out as commuter licenses,
while specifying -com 1080 ensures that all floating licenses may be checked out as commuter licenses.

NOTE: The percentage value rounds down so that, for example, specifying -com 50 on a server that has
3licenses allows only 1 license to be checked out as a commuter license.

WARNING: This environment variable affects all application licenses your license server is serving out,
whether for GeoExpress or other applications. This means users of other software applications whose
licenses you are administrating through your license server can be affected. For example, suppose you
have 4 licenses for GeoExpress and you want to make 2 of them available for commuting. Suppose also
that you have 1 license for Acme Supersoft. Specifying -com 50 will make half of your GeoExpress
licenses available as you planned but will have the additional side effect of restricting your Acme Supersoft
license from being checked out (50% rounded down of one license is 0).

Several utilities are available to help server administrators manage the LizardTech License Server on their
network. By default these tools and their documentation are installed from the GeoExpress DVD when you install
the License Server.

IMPORTANT: The License Server should be installed on the same subnet as any clients who wish to
access it. If your License Server is not installed on your local subnet, you will be prompted to specify the
name of the computer you wish to connect to for a floating license in the GeoExpress Licensing dialog.

Following are descriptions of other utilities included in GeoExpress that administrators are likely to need to access
and use. For more information on these utilities and on others not listed below, see the SentinelLM System
Administrator's Online Guide installed with your License Server.

UTILITY PLATFORM DESCRIPTION
echoid All Generates a locking code.
Iserv Linux Starts the server (requires administrator rights).
Iservnt Windows NT | Starts or stops the server (see the SentinelLM System Administrator’'s Online Guide

for parameters).

loadls Windows NT |Loads the License Service into NT Services.
WinAdmin.exe |Windows Displays a list of servers and licenses.
Isrvdown All Stops the server (requires administration rights).
Islic All Adds a license to your license file.
Ismon All Monitors license server transactions.
Iswhere All Displays a list of license servers.
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In most cases, you will not be aware of the license check-out process because it will occur invisibly and
automatically (see on page 146).

IMPORTANT: When using floating licenses a constant connection to the license server is required to
perform encodes. If network connectivity is lost, encodes will fail.

A commuter license is a floating license that has been disconnected from the network. If you are using a portable
(laptop) computer, as for traveling purposes, you can check out a license from a license server on your network
and then disconnect from the network. You can then use GeoExpress to encode images, no matter where you go,
even out of the country.

NOTE: You must have purchased the Floating License option for GeoExpress in order to use commuter
licenses. For more information, contact your LizardTech representative
(https://www.lizardtech.com/sales#retail-sales).

To check out a commuter license, run the appropriate commuter utility as shown in the table below. These utilities
ship with GeoExpress. Instructions for using them are given below.

IMPORTANT: You must check in a commuter license when you are through using it (see instructions for
each utility below). If you leave a license checked out after you are finished using it, it remains unavailable
for other users.

ON THIS PLATFORM USE THIS UTILITY
Windows LizardTech’s Commuter Licensing utility or 1tcommute.exe
Linux lcommute

Use the Commuter Licensing utility for win32 and w64 platforms as an alternative to 1lcommute or 1tcommute.
The Commuter Licensing utility uses the executable wcommute. exe.
To check out a license using LizardTech’s Commuter Licensing utility:
1. Choose Start > Programs > LizardTech > GeoExpress > Commuter Licensing.
You can also run the executable wcommute. exe.
2. Click Single Server and specify a server name, then click OK.
You can also click Search Subnet to display available licenses.
3. Select alicense and click Check Out. The license is now marked with a red check.

To check in a license using the Commuter Licensing utility:
1. Choose Start > Programs > LizardTech > GeoExpress > Commuter Licensing, ortype
wcommute.exe at acommand prompt.
2. Click Single Server and specify a server name, then click OK.
You can also click Search Subnet to display available licenses.
3. Select the license (it will be marked with a red check when it is checked out) and click Check In. The
license becomes unmarked and is now available for another user.
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On Windows, use the 1tcommute utility.

To check out a license using 1t commute use the following command:
-co -s <server> -fn <feature name> -fv <feature version>

To check alicense back in using 1t commute use the following command:
-ci -s <server> -fn <feature name> -fv <feature version>

Use the 1commute utility for Linux platforms.

The 1commute utility can be used either with parameters or interactively. To operate interactively, specify no
arguments at the command line (for more information see the System Administrator’s Online Help, distributed on
your GeoExpress DVD-ROM).

To check out a license using 1commute use the following command:
-C 0 -0 n -s <server> -f <feature> -v <version> -d ©

IMPORTANT: Zero (0) must be used with the -d argument.

To check a license back in using 1commute use the following command:
-c i -0 n -s <server> -f <feature> -v <version>

If you wish to use GeoExpress in a Terminal Services environment, you must use a floating license.

For more information see on page 143, on page 13 and
on page 14.

Data cartridges are small, binary encrypted files that enable you to encode images with GeoExpress. Cartridges
are a software-based replacement for the traditional physical dongle or hardware lock. They are generated by
LizardTech, based upon your system ID, and then emailed to you as an attached file.

Data cartridges are installed through the GeoExpress user interface. The user interface displays the amount of
datain the installed cartridge and the amount of ‘encoding’ capacity remaining on the cartridge. The data cartridge
is decremented based on the amount of input data calculated by multiplying the number of pixels to be encoded
times the pixel depth.

For raster jobs, only the initial creation of MrSID and JPEG 2000 images charges the cartridge. Working with
images that are already in the MrSID or JPEG 2000 format does not decrement the data cartridge. For instance,
you can create a lossless MrSID or JPEG 2000 file, which decrements the cartridge, and then use that file to
create visually lossless compressed MrSID or JPEG 2000 files that do not charge against the cartridge.
Additionally, updating mosaics and creating mosaics of existing MrSID or JPEG 2000 files do not charge against
the cartridge.
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Q: What LIiDAR operations get charged against the cartridge?
For LIDAR jobs, the following operations charge the data cartridge:
« Creating a MrSID image from any other file format. However, creating a MrSID image from another
MrSID image does not charge the data cartridge.
o Creating a LAZ image from a LAS image or a LIDAR text file. However, creating a LAZ image from another
LAZ image does not charge the data cartridge.
« Creating a LAS image from a LiDAR text file.

If you have an input MrSID image, you can decode the image to LAS or LAZ without charging the data cartridge.

Q: Can | share my data cartridge with other users in my organization?

Yes. GeoExpress has a server-based shared capacity cartridge. This is NOT a floating license (for floating license
information see below) but rather a “big bucket” of capacity that can be accessed by multiple licensed users on the
network.

Questions about Floating Licenses
For more information see Licensing GeoExpress on page 13 and Floating Licenses on page 144.

Q: How do | specify a License Server?
Enter the License Server IP address or network name in the Licensing section of the License and Cartridge
Management window. To access this window, choose Options > Licensing.

Q: Which license takes precedence when there are more than one available?

When you run GeoExpress after the temporary license has expired, the program first looks for a valid standalone
(local) license on your computer. If there is none, it looks for a valid floating license by trying to connect to a
license server on your local subnet. If it cannot find one you are prompted to either activate a permanent
standalone license or specify a license server on your local subnet or a broader network.

You may also specify whether or not GeoExpress should prefer a NITF-enabled license if it has to go to the
network to get a license. By default, GeoExpress gives preference to a non-NITF-enabled license. You can
change this in the License Management dialog (see Setting License Server Options on page 146).
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File Menu

The File menu includes commands for adding images and tiles to the Job List and for working with GeoExpress
project (. prj)files. A project consists of the current contents of the Job List and global settings.

MENU ITEM

FUNCTION

Add image(s)

Add image files to the Job List. File types are determined by file extension; if you attempt
to add a file with an unrecognized extension, you will be prompted to identify the file type.
For a list of supported file types, see Supported Input Formats on page 24.

Create new mosaic of
images

Adds an empty mosaic to the Job List. You'll be prompted to identify the mosaic type
(raster or LIDAR), output file and file type, and other details about the mosaic.

Add color composite
image to encode

Add an image job consisting of separate files representing the Red, Green, and Blue
bands of an image.

New project

Clears the Job List, ready to add images to a new project. (If the current project has not
been saved or has been changed since last saved, you’ll be prompted to save it.)

Open project

Opens a saved project file. Note: GeoExpress can not open project files saved by versions
earlier than version 9.5.3.

Save project

Saves changes to the current project. If it has not been saved, you’ll be prompted for a
filename.

Save project as

Prompts to save the project with a new filename.

Print session log

Prints the log of all encoding jobs run since you launched GeoExpress. This is the same
information displayed in the Output tab of the main window.

Recent projects

Lists the last four project files that you accessed; select one to re-open it.

Recent files Lists the last four non-project files; select one to add it to the current project.

Exit Exit GeoExpress. You’ll be prompted to save an unsaved or modified project or cancel any
running jobs.

Jobs Menu

The Jobs menu provides another means of executing jobs.

MENU ITEM

FUNCTION

Run selected jobs

Run the jobs that are selected in the Job List.

Run all jobs

Runs all jobs in the Job List.
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Options Menu

The Options menu provides access to basic encode parameters, preferences and licensing.

MENU ITEM

FUNCTION

Job options

Set format, compression, dimensions, resolution, and tiling options for the selected job.

Advanced options

Set advanced input, output, and other options for the selected job.

Tile options

Add, remove, crop, change order, and set a coordinate reference system for tiles. This
option is only available if the selection consists of a mosaic job or files in a mosaic job.

NITF image segments

Displays the image segments in the selected file and allows you to select the segments
that you want to include in the output file.

Preferences Set or restore default preferences for output files, including output directory, compression
ratio, and more.
Licensing Enter or import license information or a data cartridge license, connect to a License

Server, or utilize an NITF-enabled license if one is available.

Tools Menu

The Tools menu offers options related to more complex encoding functions.

MENU ITEM FUNCTION
Metadata You can enter or modify User or Image metadata, including company name, copyright
information, geographic location, and CRS, among others.
Despeckling Enable despeckling for an image or tile, and set despeckling options.
Image crop Specify cropping for the image, using either a simple rectangle or polygons defined in a

shapefile.

Area of interest

Specify a region of the image to use increased or decreased visual quality compared to
the rest of the image. This can be used to emphasize an important areas, or to “blur out’ a
sensitive region.

Color Balance

Apply brightness, contrast, and color corrections to mosaic tiles.

Reproject

Allows you to reprojectimages from one coordinate reference system (CRS) to another.

Publish images

Publish existing images directly to an Express Server.

Help Menu

The Help menu provides information about GeoExpress and access to additional resources.

MENU ITEM

FUNCTION

Contents

Opens online help

Anonymous Application
Usage

Provides a description of data that can be shared anonymously with LizardTech, with the
option to enable or disable data collection.

LizardTech online tech
support

Opens a browser window to LizardTech’s support website

Open log files folder

Opens the folder containing session and job log files.

About GeoExpress

Displays product and version information.
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GeoExpress Feature History

The following features and improvements to existing functionality were added in past versions of GeoExpress.

GeoExpress 9.5
o LIiDAR Point Cloud Compression
« Multipolygon shapefile cropping
« Batch Color Balancing

GeoExpress 9.1
« Floating Point Support for MrSID Generation 4
« Dynamic Range Metadata Generation
« Improved Metadata for Auxiliary Files
« Improved Multi-Core Processing
o Command Line Image Statistics

GeoExpress 9.0
o Simple Job List
« Intelligent Encoding
« Graphical User Interface Enhancements
« Concurrent Processing
« Image Rotation
o Custom Watermarks
« Mosaic Enhancements for the Command Line
o PNG Support
o NITF RPC Support

GeoExpress 8.5
« Per-Band Compression
« Improved License Administration

GeoExpress 8.0
o Support for MrSID Generation 4 (MG4)
« Alpha Channel Support
o Multispectral and Hyperspectral Support
« Improved Mosaicking Options
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« Support for Publishing to Express Server

« Administer Express Server from GeoExpress GUI
« Support for 64-Bit Systems

« Commuter Licenses

o Support for Generating Esri AUX Files

« Support for Cropping by Shape File or GML Coverage
« Despeckling

« “Recently Used” Projections Feature

« Updated Library

« Improved Status and Error Messages

« Improved Metadata Tools

« Expert Level Tools

o GML Metadata for JPEG 2000 Imagery
« Nonuniform Color Balancing
« Publishing MrSID or JPEG 2000 Images to Oracle

« ColorBalancing

« Vector Overlays for Area of Interest Encoding

« Floating Licenses

o 12-bit JPEG-encoded variants of input formats such as TIFF and NITF
« Edit jobs while other jobs are encoding

« Option for converting incoming 16-bit data to 8-bit data during encoding
« Encode 16-bit DTED images to JPEG 2000

« Improved support for custom well-known text strings (WKTs).

« Reprojection

« JPEG 2000 Support

« Profile Manager

« Multiband Color Compositor
o NITF Support

« Area of Interest Encoding

« Color Space and Transparency Encoding Options
o Multispectral Image Support

« Improved World File Handling

« Enhanced Optimizing Options

« Internationalization
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Other LizardTech Products

Thank you for using LizardTech® GeoExpress® software. Try the rest of our product line.

GeoViewer
Efficient Viewing and Exporting of MrSID and JPEG 2000 Layers

GeoViewer is LizardTech’s free, standalone application for viewing geospatial imagery, vector overlays and
LiDAR data. GeoViewer enables you to combine, view and export visual layers from varied sources, such as local
repositories, Express Server catalogs, and WMS and JPIP servers. GeoViewer supports a wide range of input
formats and exports to GeoTIFF, PNG and JPEG. It’s the most efficient means of viewing MrSID and JPEG 2000
images.

For more information about GeoViewer, visit https://www.lizardtech.com/geoviewer-pro/overview.

Express Server

Image Delivery Software for Geospatial Workflows

LizardTech Express Server software is the best solution for distributing imagery in MrSID or JPEG 2000 format.
With Express Server, users on any device access imagery faster, even over low-bandwidth connections. Express
Server is faster, more stable and easier to use than any other solution for delivering high-resolution raster imagery.

For more information about Express Server, visit https://www.lizardtech.com/express-server/overview.

MrSID Decode SDK

Integration of MrSID Support into Third-Party Applications

The MrSID Decode SDK provides a framework for extracting raster or LIDAR data from MrSID files, including
MrSID Generation 4 (MG4™). Used as the foundation for LizardTech’s Express Suite® line of geospatial
products—GeoExpress, Express Server and Spatial Express software—the MrSID Decode SDK is a robust
toolkit suitable for complex application development needs.

MrSID Decode SDK is available for free download: https://www.lizardtech.com/developer/overview.

About LizardTech

Since 1992, LizardTech has delivered state-of-the-art software products for managing and distributing massive,
high-resolution geospatial data such as aerial and satellite imagery and LiDAR data. LizardTech pioneered the
MrSID® technology, a powerful wavelet-based image encoder, viewer, and file format. LizardTech has offices in
Seattle, Portland, and Tokyo and is a division of Celartem, Inc. For more information, visit
https://www.lizardtech.com.
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Following are descriptions of several problems that could be encountered installing GeoExpress.

The license code was entered incorrectly. Try re-entering it; choose Options > Licensing to open the License
and Cartridge Management dialog.

The most reliable way to add the license is to import the license file. You should have received this file (with the
extension . 1ic)in an email from LizardTech. In the License and Cartridge Management dialog, click Import
next to the License field and select the . 1ic file.

If you still receive this error, you can edit the license file manually. The license code is stored in the
GeoExpress95\bin directory in afile called 1servrc. Open this file with a text editor and compare the 51-
character license code with the one you received from LizardTech. The code in the 1servrc file can be corrected
manually, if necessary. The number sign (#) character at the end of the license code indicates the end of the code.
Although this character is not required for the license to be considered valid, it is useful for making sure that you
have copied the string completely, and we recommend that you leave it in.

The permanent license that you received from LizardTech is keyed for a unique network card identification
number. If the network connection becomes unavailable or your network hardware configuration has changed, the
program may not accept the license code. Restore the network connection or the original network hardware
configuration, or fill out the form at https://www.lizardtech.com/support/product-activation/ for a new permanent
license.

If you have a temporary version of GeoExpress and the clock in your operating system has been altered—for
instance, if you have recently upgraded your system software—security features in the licensing software may
not allow the program to run. Please contact technical support at https://www.lizardtech.com/support.
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Encoding Problems

If you set a low weight value for an image with low color contrast, you may notice the following pattern of light and
dark spots across your image:

The following factors contribute to the creation of this pattern:
« Low weight value
« High compression ratio
« Low color contrast
o MrSID Generation 2 output format
« Image enhancement

To reduce the appearance of this pattern, complete the following steps:
1. Select the image in the Job List.
Click Advanced in the Properties tab.
Click the Format-Specific tab.
Increase the value in the Weight field. For example, you might change the value from 2 to 3.
Optionally, deselect the Image Enhancement option.
Click OK.
Click the Run Selected Jobs button to run the job.

Finding Your GeoExpress Version and Build Numbers

You may need to know your the version and build number of your GeoExpress software in order to communicate
with LizardTech Support. To find these numbers, select About GeoExpress from the Help menu.

NOo oD

The version and build numbers are listed on a single line at lower left, in the following format:
Version: 9.5.5.4567.default

In this case, the version number is 9.5.5 and the build number is 4567.
Below that, a parenthetical note tells you whether the installation is a 32-bit or 64-bit version of GeoExpress.

Technical Support

Most technical issues can be resolved using the various resources you have available. In addition to the product
documentation and the “Read Me” file, LizardTech offers a knowledge base and product updates on the
LizardTech website.

Knowledge Base

The LizardTech Knowledge Base contains articles about known technical and usage issues and is frequently
updated.

https://www.lizardtech.com/support/geocexpress/knowledge-base
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Updated versions of LizardTech viewer tools are available for download at no cost.

https://www.lizardtech.com/support/gecexpress/installers

Protect your investment in LizardTech software by participating in a LizardTech support plan. For more details,
please contact your regional LizardTech office.

https://www.lizardtech.com/sales#retail-sales

To contact LizardTech Technical Support, visit http://www.lizardtech.com/support.

The support page includes links to the LizardTech Knowledge Base and the Product Activation page. A Contact
Form is also provided for issues that require further assistance.
In an emergency, call 206-902-2845 between the hours of 8 AM and 5 PM Pacific Time.
Please have the following information available to assist in resolving your problem:

« Thetask you were working on when the problem occurred

« The command you typed prior to the problem, if applicable

« The exact error message, if applicable

« The type of file you are encoding and the file size

« Whether you have restarted the computer and attempted to reproduce the problem

« Which version of GeoExpress you are running (see

on the previous page).

o Other LizardTech products you have installed

« The operating system

« The amount of hard drive space available

« The amount of memory installed in your system

« Any other information you feel is relevant
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alpha band
An image band that tracks the portions of an image that you do not want to display. Alpha bands are included
in MrSID Generation 4 and are especially useful for aligning images seamlessly.

band

A band, orimage band, is one set of samples corresponding to one spectral component of an image. For
example, a typical image has three bands, a red band, a green band, and a blue band.

BBB

The name of a file format for raw images, short for BIL, BIP, and BSQ.

BIL

A band-interleaved by line image. This format stores all bands of pixel values for each consecutive lline or row
of the image.

BIP
A band-interleaved by pixel image. This format stores all bands of pixel values for each consecutive pixel the
image.

BSQ

A band sequential image. This format stores all pixel values for each band consecutively.

byte order

The order in which bytes are stored in computer memory. There are two types, little-endian and big-endian.
Also known as “endianness”.

composite mosaic

A MrSID image that contains other MrSID images. Composite mosaics can be created quickly because they
do not need to be compressed again, but they may load more slowly than flat mosaics.

compression
The process of transforming information so that it can be stored or conveyed in less space than the original
information. See also lossless, lossy and visually lossless.

compression ratio

A ratio of an image’s nominal size and an image’s compressed size, where the nominal size is calculated from
the length, width, number of bands, and number of bits in the image. For example, a raw image compressed
from 10 GB to 1 GB has a compression ratio of 10:1.
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dynamic range
The ratio between the largest and smallest values in an image. Image viewers use dynamic range values to
improve the appearance of images. For an image where the dynamic range is less than the full range of
possible values for the image, you may want to use your image viewer to stretch the pixel values across the
full range.

endianness
See byte order.

flat mosaic

A MrSID image created from multiple input images. Flat mosaics do not preserve information about each input
image and require compressing all the input images again. However, they load more quickly than composite
mosaics.

frequency balance

A parameter used in MrSID to determine the emphasis given to edges and flat color areas when performing
compression. See also weight and sharpness.

gamma

A parameter used in MrSID to determine the emphasis given to edges and flat color areas when performing
compression. In MG3 and MG4 encoding, this parameter is called frequency balance. A lower value creates
more defined edges, while a higher value creates softer edges.

GML

Geography Markup Language. An open, XML-based specification for representing geographic information
including geographic features, coverages, observations, topology, geometry, coordinate reference systems,
units of measure, time and other values. Because it is an XML grammar, it is both extensible and adaptable to
any application within the broad geospatial field.

K-weight
A parameter used in MrSID to determine the emphasis given to the K (black) band of a CMYK image when
performing compression.
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level
See zoom level.

lossless

A compressed image that is identical to the input image across all pixel values. See also lossy and visually
lossless.

lossy

A compressed image that approximates the pixel values of the input image. Lossy images are generally
significantly smaller than lossless images. Depending on the compression ratio, a lossy image may display
compression artifacts or it may appear to the human eye to be identical to the input image. See also lossless
and visually lossless.

magnification
The scale at which animage is represented. Magnification is expressed as a positive floating point value. For
example, 1.0 represents the full image, 0.5 represents a half-scale version, and 2.0 represents a double-scale
version. The magnification value must be a power of two. See also scale and zoom level.

metadata

The information stored in an image that is not pixel value information. For example, typical metadata includes
image properties like the width, height, and colorspace of the image. Alternatively, some images contain
additional metadata such as the name of the image creator, the organization name, the creation date, and
more.

MG2

MrSID Generation 2. A previous version of the MrSID image format. MG2 is limited to lossy encoding and
does not support optimization nor some of the advanced features available in MG4. See also MrSID and MG4.

MG3

MrSID Generation 3. A previous version of the MrSID image format. MG3 supports lossless encoding, image
optimization, composite images, and more. See also MrSID and MG4.

MG4

MrSID Generation 4. The current version of the MrSID image format. MG4 supports all the features of MG3
and adds support for alpha bands and multispectral images.

mosaic

An image created from multiple input images, also called image tiles, to form another larger image. There are
two types of mosaics, flat mosaics and composite mosaics.

MrSID

Multiresolution Seamless Image Database - A wavelet-based image format designed for large, high-quality
geospatial imagery. The current version of the MrSID file format is MrSID Generation 4. See also MG4.
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nominal image size

The size of an image calculated from the width, height, number of bands, and number of bits in the image. The
nominal size is iindependent of the file format or of the compression used on the image. You can use the
nominal size of an image to compare the relative sizes of images in different formats and to calculate the
compression ratio for an image. See compression ratio.

optimization
The process of creating an MG3 image from a source MG3 image without decoding the image and
compressing it again. Common optimization operations include cropping and removal of resolution levels.

pixel
A pixel represents a value or set of values for a particular point in a raster image. For images with more than
one band, a pixel includes the values of all the bands at the given pixel position.

resolution
A measure of the detail in an image. Typically, this is measured in ground units per pixel.

scale

The magnification at which an image is represented. Scale is represented as a signed integer, corresponding
to the negative of the log of the magnification. That is, magnifications of 1.0, 0.5 and 2.0 are equivalent to
scales of 0, 1 and -1 respectively. See also magnification and zoom level.

sharpness

A parameter used in MrSID to determine the sharpness of boundaries between different areas of an image
when performing compression. See also frequency balance and weight.

strip height

The number of rows of an image to be processed in each step of an image read operation. Use of smaller strip
heights may reduce memory requirements, but at a possible performance loss.
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transparency color

Also called the no-data value. Pixels that match the transparency color are not displayed. The value can be
specificied manually or in the metadata. See also alpha bands.

visually lossless
An image that appears to the human eye to be identical to the input image. However, a visually lossless image
is actually alossy image, and as such only approximates the pixel values of the input image.

wavelet

A mathematical representation of a pixel value that varies by frequency and duration. In wavelet space, the
importance of a pixel depends on the values of its neighboring pixels. Wavelet-based image formats are able
to present images at multiple zoom levels without creating image pyramids.

weight
A parameter used in MrSID to determine the emphasis given to the grayscale portion of a color image when
performing compression. See also frequency balance and sharpness.

world file
A text file that contains geospatial positioning information to augment or replace the geospatial metadata in an
image file.

zoom level
The scale at which an image is represented. Levels are generally expressed with signed integer values. An
image at scale 1 has half the width and height of the original. See also scale and magnification.
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